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Now the latest iPhones, AirPods and Apple Watch
models have been bestowed upon the world, we're
inevitably turning our attention to what might come
next, including new Macs and iPads, powered by
the latest Apple silicon. The new machines could
well have been announced by time you read this,
but you don't need to spend a penny to get many
of their additions and enhancements - thanks to
the arrival of macOS Sequoia and iPadOS 18, both
of which we'll be looking at in-depth in this issue.

Turn to p20 and you'll discover many of the
great ways in which Sequoia can make it easier and more fun to use your
Mac; while on p62, we reveal how iPadOS 18 can do the same for your iPad
- we're particular fans of all the new customisation options. You'll also find
reviews of the new iPhone 16 Pro (p78) and AirPods 4 with ANC (p82).

Look further ahead and you may spot what could be Apple's Next Big
Thing: home robots. On p70, we reveal what the company may be up to, why
Apple could be eyeing its rivals' ambitions, what you can pay hard cash for
now and what might happen next. Plus, we also investigate something that
may be music to your ears. On p16, we take an in-depth look at the steps
Apple is taking to improve everyone's hearing health and how AirPods Pro 2
can now help those with mild to moderate hearing loss with medically
approved hearing tests and more. We'd love to know what you think!

Enjoy the issue and see you soon,
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APPLE CORE

THE LATEST NEWS AND RUMOURS >

HOT TOPIC!

his year's iPhone 16 launch
T event - dubbed ‘Glowtime’
by Apple - took place on 9

September, and it was absolutely
jam-packed with new products: the
iPhone 16 and iPhone 16 Pro ranges,
a new Apple Watch Series 10 and an
updated Apple Watch Ultra 2, fresh
AirPods models, and new software
features too. We'll cover all of the new
products in more detail over the next few
pages, but suffice it to say that all in all,
there was a lot to get excited about.

Starting with the iPhone 16 and
iPhone 16 Plus, there's good news for
fans of Apple's more affordable phones.
Instead of feeling second-best to the Pro
models, this year the base-level iPhone
16 devices come loaded with a lot of
features that were previously limited
to the more expensive iPhones.

Instead of using an old chip, the
iPhone 16 now has the same-generation
A18 chip as the iPhone 16 Pro. It also
now has the Action button, as well as
improved cameras, a new Camera

6 | MACFORMAT | NOVEMBER 2024

Apple dubbing it's most recent event ‘It's Glowtime'
was a definite nod to new Apple Intelligence powers.

Control button, a stronger front glass

panel, plus Apple Intelligence capabilities.

It's a really strong update that is sure to
tempt a lot of prospective buyers.

On the Pro side of the equation,
Apple has moved to make its flagship
phones more appealing to professional
users. They now feature frame-by-frame
colour grading for recorded video,
higher-resolution 48MP photos in the
Ultra Wide camera, 4K videos at 120fps,
and a new A18 Pro chip. On the screen,
you'll find that the bezels have been

Apple Intelligence utilises
many features in the new
products, including the

iPhone's Camera Control.

reduced and there's a tougher Ceramic
Shield, while the new Camera Control
also makes an appearance. There are
also better cameras, improved audio
and longer battery life.

Watches and AirPods

As well as that, Apple launched the Apple
Watch Series 10, which comes with a
slimmer design and larger display, faster
charging, water depth and temperature
measurements, sleep apnoea sensing,
plus new titanium and black aluminium
finishes. The Apple Watch Ultra 2,
meanwhile, saw a small update with
fresh bands and a new satin black look.
Apple also launched AirPods 4, which
now come in two models: one model with
redesigned ear tips, improved audio and
a USB-C charging case, and another with
active noise cancellation and a wireless
charging case. AirPods Pro 2 can now
be used as hearing aids, while AirPods
Max sport new colours and a USB-C
charging port. These changes make the
AirPods line a little more cohesive.

»Image credit: Apple Inc
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hone 16 and iPhone | 16 Pro

All the new features in Apple's latest phones

icking things off with Apple's
Pro phones, these now come

with larger displays - 6.3
inches and 6.9 inches across - thanks
to slimmer bezels and larger physical
dimensions. On the front is a new
Ceramic Shield glass display that Apple
says is 50% tougher than the previous
version and twice as strong as any other
smartphone screen. There are new
colours, too: a darker black, a brighter
white, a new bronze Desert Titanium
shade, plus a slightly lighter Natural
Titanium tone.

You get three camera lenses: a 48MP
Main camera, a higher-resolution 48MP
Ultra Wide lens, and a 12MP 5x Telephoto
lens. The first of these is what Apple calls
a Fusion camera, which can take either
48MP 1x shots or 48MP 2x telephoto
images. You can now record video
footage at 4K resolution and 120fps in
Dolby Vision and can take spatial photos
for the Vision Pro headset. And there are

The iPhone 16 Pro and Pro Max come with a Fusion
camera that can take both 1x and 2x photos.

professional-level tools for colour
grading, audio mix editing, and more.
There's a powerful new A18 Pro chip
with a 20% faster GPU and 15% quicker
CPU compared to the A17 Pro. There's
also the Camera Control (something that
we'll discuss in more detail below), which
is a feature that's shared with the
entry-level iPhone 16 devices. All devices
| in the iPhone 16 range get improved
| battery life and better thermal
|
|

management, too, which make for
welcome changes.

Photography features

wielal|yfv] 1 ]01P
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Turning to the iPhone 16 and iPhone

| 16 Plus, unlike previous years, the iPhone
| 16 range shares several new features with

the Pro iPhones. Aside from the Camera
Control, it also gains the Action button
and Apple Intelligence, the latter of which
is due to a new A18 chip, which is the
same generation as the iPhone 16 Pro’s
A18 Pro. Its CPU is 30% faster than the
A16 Bionic, while its GPU runs up to 40%
faster and is 35% more efficient.

iPhone 16 macro

The iPhone 16 gets the same
strengthened Ceramic Shield as the Pro
phones and new colour options, too:
Ultramarine, Teal and Pink, plus the
previous White and Black colourways. It
only has two lenses, but its main camera
is one of Apple’s new Fusion cameras that
can take images as either 48MP 1x shots
or 12MP 2x telephoto pictures. Its 12MP
Ultra Wide lens now enables macro
photography, too.

One of the most interesting additions

to the iPhone 16 range is the Camera
Control, a new touch-sensitive button
on the phone’'s side for operating its
cameras. You can press it firmly to take a
photo or press it lightly to bring up a dial to
change functions, such as zoom, exposure

»Image credit: Apple Inc

and more. You can then slide you finger

to swipe through the controls and adjust.
And it combines with Apple Intelligence:
press the Camera Control and point your
iPhone at a restaurant, for example, and
Apple Intelligence will bring up information
like ratings, menu and opening hours.
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Apple Watch Series 10

A big - but thin - 10th anniversary update

' | pple chose to mark the Apple
Watch's 10th anniversary with

a significant upgrade that saw
the timepiece get an all-over makeover.
The case is now both thinner and lighter,
and there's a new titanium option that
replaces the previous stainless steel
chassis. There's still the usual aluminium
finish, which now has a Jet Black option
too. As well as that, there's a larger display
that now comes in 46mm and 42mm sizes,
and this screen offers better viewing
angles when seen from the side.

Juicing up the Watch is quicker than
ever thanks to improved fast charging -
15 minutes of charging will get you eight
hours of usage, while you'll get up to 80%
battery life after 30 minutes on the
charging puck.

Apple has added temperature sensing
for water-based activities like surfing and

swimming, plus a depth gauge that can
help when you want to dip beneath the
waves. As well as that, there's a new Tides
app to keep you abreast of changing
conditions along the coast.

Audio can be played from the Watch's
speakers, while the microphones can
better isolate your voice to suppress
background noise and wind. Both of those
features should help when making phone
calls. Much of this is thanks to the new S10
SiP (System-in-Package) and its improved
four-core Neural Engine. Finally, the new
Apple Watch features sleep apnoea alerts,
which could be useful if you have trouble
getting a full night's sleep and suspect that
apnoea could be the cause.

The Apple Watch Ultra 2 was also
updated, although only in a small way; like
the Series 10, it now has a Black finish, as
well as new bands from Apple and Hermeés.

All-new AirPods A

Music to our ears

pple has overhauled the AirPods
range with updates across the

board. In doing so, it launched the
AirPods 4 in two variations and brought
updates to the AirPods Pro 2 and the
AirPods Max over-ear headphones.

Starting with AirPods 4, there's now an

entry-level option and a higher-end model.
The former has a new ear tip design to
improve fit and compatibility, alongside a
new acoustic architecture with richer bass
and clearer highs. You get Personalised
Spatial Audio, a USB-C charging case
and 30 hours of battery life, all for £129.
Stepping up to the other AirPods 4 model,
this includes everything in the base model,

8 | MACFORMAT | NOVEMBER 2024

With updates across the AirPods range, you're bound
to find the right option for your listening needs.
plus active noise cancellation, a wireless
charging case, and a speaker for Find My
sounds. It costs £179.

Both the AirPods Pro 2 and AirPods
Max received updates. For the former,
it can now serve as a set of hearing aids
(for more, see 'AirPods hearing aid’ on the
right). For the latter, there are new colours
(Midnight, Blue, Purple, Orange and
Starlight), plus a USB-C charging port
and Personalised Spatial Audio.

Satellite
services

Apple's Roadside Assistance
via Satellite feature, which
enables you to get help after
a car accident even if you
didn't have a mobile signal,
now works in the UK, as do
Emergency SOS via Satellite
and Find My via Satellite.
Apple has also introduced
Emergency SOS Live Video,
which lets you send a video

of your surroundings to first
responders. And with Messages
via Satellite, you can send texts
using satellite connections.
Neither of the last two features
are available in the UK yet.

(]

AirPods
[ ] [ ]

hearing aid
AirPods Pro 2 got a big new
feature - they now protect your
hearing. Apple says they can
help in three ways: prevention,
awareness and assistance. For
prevention, AirPods Pro 2
automatically reduce loud noises
to protect hearing. Regarding
awareness, the earphones offer
a hearing test to check for
problems. Finally, the assistance
aspect means that AirPods Pro 2
now work as a set of hearing aids
for mild to moderate hearing loss.

> Image credit: Apple Inc
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[MAC APP] Annecy, France

Unread: AN RSS Reader ree (offers IAPs)

Everything You Need To Know
About Renting A Car In

12 Best Things Ta Do In

EXPERT VAGABOND

AR Y

An RSS reader for the modern era

RSS (Really Simple Syndication)
readers may not be as popular
a as they once were, but this
fourth version of Unread makes
them feel as modern as can be. This sleek
RSS reader blends beautiful design with top-
notch features to give you a premium reading
experience on your Mac, iPhone and iPad.
Add a feed to the app and its articles are
perfectly rendered for easy consumption, with
perfect images, typography, colour options

5]

FridFen 1998

[iOS APP]
Watch to 5K -
Couch to 5K plan

£3.79

The Couch to 5K
plan is well known
for making fitness

accessible, and this app
puts it right on your wrist.
It helps you run a 5K in under
30 minutes after nine weeks,
with Apple Health integration
built in. Plus, you don't even
need to take your phone with
you when you run.

Why you need it: Get fit at
your own pace.

[i0S GAME]
A Fragile Mind

£1.99

“A The latest puzzler

‘:m‘i}. :reoen; Glitch Games
you wake up

in a courtyard to the sound
of a mysterious voice and
with no idea how you got
there. Chock-full of brain-
twisting puzzles, you'll need
to use the environment
around you - and a good
deal of lateral thinking -
to escape your new prison.
Why you need it: A real test
for your puzzling abilities.

Apps & games APPLE CORE

Best Things To Do In Marrakesh, Morocco

and more. You can add a feed directly from
a web page, then sync everything to your
other devices to read later. There are plenty
of themes to choose from, alongside widgets
and offline reading.

While many features are free, there's also
a paid-for subscription with features like extra
widget and sharing options, web page caching,
custom Dock icons, and more. Whether or not
you decide to pay, you'll get an excellent RSS
app that elevates your reading experience.

[MAC GAME]

Total War:

Pharaoh Dynasties

FREE Update

(Requires £29.99 base game)
The Total War
series turns its eye
¥ to the Bronze Age
collapse in this thrilling free
expansion to the Total War:
Pharoah game. Take charge
of one of four factions,
establish your dynasty and
dominate the battlefield in
your quest for glory.

Why you need it: Even more
content for Total War.

Media
Picks®)

>What you should
be playing and
reading this month

[ALBUM]
The Forest
Is The Path

Snow Patrol
£10.99

»Made at the second

time of asking after an
abortive first attempt,
Snow Patrol’s eighth
album feels like the start
of something new.

[AUDIOBOOK]
The Comfort of Crows:
A Backyard Year

Margaret Renkl
£18.99

> Renkl traces the passing
of seasons in her garden,
crafting stories on the
wonders of nature and
the effects of time.

[PODCAST]

D-Day: The

Tide Turns

> For D-Day's 80th
anniversary, this podcast
looks at the people
involved in the Normandy
landings: on the ground,
in the air, out at sea and
behind enemy lines.
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APPLE CORE Hot new kit

Crave

THE GEAR WE'RE LUSTING AFTER

SER———

Enjoy a night at the movies
without leaving your sofa
with the Loewe We. BEAM.

Loewe We. BEAM

£849 > From loewe.tv/uk

> Whether you're binge watching Slow
Horses on Apple TV+ or watching the
latest blockbuster movies at home, this
projector will soon have you beaming
from ear to ear. For not only is the We.
BEAM from German TV and speaker maker
Loewe stylish, it's also slim, portable and
can splash HD images up to 120-inches
across on your living room wall.

While it can easily be connected to an
Apple TV 4K, Blu-ray player and soundbar
via HDMI CEC and ARC, you may not need

10 | MACFORMAT | NOVEMBER 2024

to as it has support for

Apple TV+, Disney+,

Netflix, Amazon Prime

Video and YouTube

built-in. It also has

two invisible speakers

delivering up to 10W of

music power, plus Bluetooth

S0 you can play your favourite

tunes wires-free. The only thing it

lacks is a built-in battery, but you can hook
up the projector to a power bank instead.

The projector boasts HDMI CEC and ARC for
integration with Blu-ray players or soundbars.

»Image credit: Lo




Ultimate Ears
MINIROLL

> £69.99 > From ultimateears.com

> All kids love tasty mini rolls, but kids big and
small willl love the Ultimate Ears version even
more! Available in Majestic Blue, Calming Pink,
Gentle Black and Revive Grey flavours, this
Bluetooth speaker delivers a surprisingly musical
and robust sound despite its tiny 122.67x105mm
size. Plus, it's dust- and waterproof to IP67 (so you
can use it in the shower), and it'll survive drops of
up to 1.2m. Other goodies include up to 12 hours
of battery life with recharging via USB-C, and an
integrated carry strap. The Ulimate Ears MINIROLL

‘ Hot new kit APPLE CORE

is planet-friendly too, being made from up to 40%

post-consumer recycled plastic. Yum.

Nanoleaf Blocks

> From £179.99 > From nanoleaf.me

> It's hip to be square, especially when
those squares are as colourful as these.
Blocks are the latest smart lights from
Nanoleaf and will brighten up any room
(@and how many squares can you say that
about, daddio?). Blocks are available in two
different Smarter Kits: one comprising six
light squares and a controller for £179.99;
and a Combo XL pack, containing nine
squares for £229.99. The lights can be
controlled using the Nanoleaf app and
Apple Home. Plus you can add more big
squares, little squares and even textured
squares to make your space uniguely you.

»Image credits: Ultimate Ears, Nanoleaf, tado, Logitech

tado X

>From £59.99 > From uk.shop.tado.com

> Winter's here and with bills climbing,
now might be a good time to update
your home heating controls. Enter tado's
new X range of smart heating accessories,
which comprise the Smart Thermostat X,
Smart Radiator Thermostat X, Heat Pump
Optimiser X, and a Bridge X border router
that uses Matter and Thread to make the
whole thing easy to control from your
iPhone. With average energy savings of
up to 19%, these accessories will not only
make staying toasty easier and cheaper,
they'll help cut your carbon footprint too.
No, you're glowing!

The PartyUp feature allows you to sync up an unlimited
number of MINIROLL speakers with Auracast.

Logitech MX
Creative Console

»>£199.99 > From logitech.com/en-gb

> If you struggle to remember shortcuts
in creative apps like Photoshop and
Premiere Pro, Logitech’s MX Creative
Console can help. Available in Pale Grey
and Graphite, it comprises a Creative
Keypad with nine customisable buttons,
and a Creative Dialpad. Logitech’s teamed
up with Adobe to ensure the Console has
some great action options right from the
start, with more promised for other apps
in due course. It's a fantastic way to speed
up any workflow - whether you're a
go-getting creative pro or not.
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APPLE CORE Opinion

John-Anthony Disotto...

THINKS THAT WHILE APPLE
INTELLIGENCE SOUNDS PROMISING,
IT'S GOT TO BE APPLE'S MOST

Here's Francesca's email about tile
costs:

he Apple Intelligence launch is a bit of a mess, isn’t
it? Apple’s artificial intelligence (AI) tools were plastered
over all of the iPhone 16’s marketing campaigns, but read
the fine print and you’ll notice none of these features were actually
available on the smartphone’s launch day. How many people ; Francesca Spelta
purchased the iPhone 16 or iPhone 16 Pro for Apple Intelligence Loby t:leml:st comparisons
only to be disappointed that their shiny new device had none i i s
of the promised features? I bet there were a fair few.
AsTIwrite this column, Apple Intelligence is nothing more
than a mere promise, set for release at a future date. Yes, there’s
a public beta of iOS 18.1 with access to some of the first Al-fuelled
features like Writing Tools which proofreads and summarises;
Clean Up which removes objects

It ’S a Sign that from a photo, and the ability to

make a Movie Memory from a

Apple I'UShed AI prompt in Photos. Still, none of

them are as groundbreaking as

implementaﬁon the features to come, allof which ~ Sif's improved capabilities willinclude new features like

. summarising emails and messages.
don’t even have launch windows. 9 9

tO not 1ag b ehlnd You see, Apple Intelligence  theyaren’t even in beta testing yet as part of a

is probably the most confusing . Developer Beta. So, can Genmoji generate two
launch from Apple that I can remember, even some of my . emojis together as seamlessly as we saw on
colleagues still haven’t fully grasped how it’s meant to work - . stage? Does Image Playground work as well as
and if tech journalists are scratching their heads then the . other Alimage generators? No one has a clue,
average consumer is probably even more dumbfounded. © we're just putting blind faith in Apple based
The first set of Al features, headlined by the ones mentioned ¢ onthe company’s track record of delivering.
- above, are set to arrive in October. Next, Genmoji and ; This wouldn’t be the first time that Apple
m Image Playground, along with ChatGPT integration in - haslaunched a new iPhone with promises of
concel Aclcs o e Siri are expected in i0S 18.2 later this year. Siri’s glow-up ¢ future features (see Deep Fusion for low-light
. sl ol with on-screen awareness and the ability to use personal . photography), but it is the first time such a major
l e context to reply to your prompts is due at some point in . selling point is just absent from an iPhone’s
j v 2025. That’s at least a five-month roll-out for the iPhone ~ release. Ina year, if all goes well, Apple
w1t 16’s most important features and even then we’re not - Intelligence’s muddled launch will be a thing
I hhisailrpSctiponlartistn) sure if they’ll arrive by January. ~ ofthe distant past. But if Genmoji or Image
ﬂ%ﬁvy;twm' ween Imagine buying an iPhone 16 Pro Max for Apple ~ Playground turns into a replica of the AirPower
1;";3&':‘;‘22..“;;:’ J Intelligence, but needing to wait until March 2025 to charging fiasco, then the iPhone 16 launch could
Wrting Tools h - actually be able to use the much-improved Siri you saw i bean absolute nightmare for Apple.
L - advertised. It’s completely baffling and a sign that Apple
P - was playing catch up with its competitors, so rushed ABOUT JOHN-ANTHONY DISOTTO
:"'“"‘ 4 g Alimplementation to not lag behind. Without Apple > John-Anthony is the How To Editor at
W Kitateman) e Intelligence, the new iPhones are some of the most 5 iMore.com and previously worked at
. J incremental annual upgrades we’ve seen yet, so it’s no 5 Apple repairing iPhones at the Genius
» . surprise that analysts expect sales figures to dwindle. i Bar. With words in TechRadar and iPad
Writing Tools can rewrite, . . ; . . . .
proofread, and summarise The biggest concern, however, is the fact that no one 5 User Magazine, he prides himself on his
text in various apps. outside of Apple has even seen these Al tools in the flesh; i ability to make tech easy to understand.
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APPLE CORE Facts & figures

The iPhone 16 in 12868

> Amount of storage

available on the entry-level
iPhone 16 and iPhone 16
Plus. You can also opt to
256GB and 512GB

of storage. o .

The key facts and stats behind Apple’s latest super phone

48MP

> Maximum resolution of the iPhone 16's Fusion
camera, which includes a 2x Telephoto option.

00:00:01

Maximum optical
zoom range of the

iPhone 16's camera . \ 3 013 524
(2x zoom in, 2x a [ [ |

zoom out). o > Total number of pixels on the iPhone 16's Super Retina XDR display,

with a 2556x1179-pixel resolution at 460ppi (pixels per inch).

22 hours  95%

> Maximum battery life of > Amount of

the iPhone 16 during video recycled lithium > Number of
playback, that's two hours inthe iPhone 16's colours available
more than the iPhone 15. battery. It also uses for the iPhone 16:
It also charges faster, 100% recycled Black, White,
reaching up to 50% copper foilinits Pink, Teal and
charge in 30 minutes. MagSafe charger. Ultramarine.
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Nobody would ever know if
you're listening to music or using
AirPods Pro 2 as a hearing aid.
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Apple,
AirPods

& your hearing health

Can AirPods Pro really be an effective
alternative to traditional hearing aids?

WRITTEN BY DAVID CROOKES >

undreds of millions of
headphones and earphones
are sold annually and,
according to Statista,
worldwide revenues have reached
$18 billion dollars with growth for the
next five years projected to be 2.39%.
That's music to the ears of manufacturers
who know how much users love to get lost
in personalised audio.

But, just as the popularity of these
devices is also increasing because people
are using them in virtual meetings or to
cancel out external noise, they're also set
to benefit people living with hearing loss
like never before.

During Apple's ‘Glowtime' event
in September, Kate Bergeron, VP of
hardware engineering, introduced what
is being billed as the “world's first all-in-
one hearing health experience”. Firstly, in
taking advantage of AirPods Pro 2's H2
chip, Apple has developed a feature called

Hearing Protection which prevents
exposure to loud, potentially damaging
environmental noise. It uses the AirPods
Pro 2's ear tips to reduce passive noise
and utilises machine learning on the H2
chip to actively reduce louder, more
intermittent noise at 48,000 times per
seconds. In doing so, it retains the sound
signature of whatever is being listened to.
Secondly, and perhaps more
intriguing, the AirPods Pro 2 is also being
turned into a hearing aid. Take a five-
minute, clinical-grade hearing test on
an iPhone or iPad and your personalised
hearing profile will be used to dynamically
adjust your AirPods Pro 2's output.
Surrounding environmental sound will
be boosted in real time and there will
be automatic adjustments to settings
affecting phone calls, music, movies and
games so that users are able to hear the
audio with greater quality. There's every
chance that this will positively disrupt @

NOVEMBER 2024 | MACFORMAT | 17
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Hearing Aid

AirPods Pro can help with hearing loss.

If they find their hearing loss is mild to
moderate, Apple's offering will provide an
effective solution. It will rival other over-the-
counter devices aimed at people will less
severe hearing loss yet have the advantage of
connecting the sound output to a user's hearing
test. Many over-the-counter hearing aids don't
do this and run the risk of potentially causing
further hearing damage from over-amplification.
As well as offering a hearing test Apple's solution is also inexpensive. People
?t?gAaicrtri‘ézggir’glg%g?g:ﬁm' with hearing I95§ gen.erally make.use of behind
as a clinical-grade hearing aid. the ear and mini-behind the ear; in the ear; in
the canal; completely in the canal; middle ear
implants, and bone-anchored hearing aid
solutions. For these, you're looking at typical

costs ranging from between £500 and £3,500
o N ; 7 for a single hearing aid (unless you choose one
aht for you i \ ‘ on the NHS). AirPods cost just £229 for a pair

yet this comparison is not quite so simple.

Although traditional devices require a

consultation with an audiologist and come with
the hassle of ongoing maintenance, for people
with advanced hearing loss this will always be
necessary. It's why Apple’s solution is only for
people with mild to moderate hearing loss.

"Devices such as middle-ear implants and
bone conduction hearing implants are surgically
implanted and can treat certain complex forms
of hearing loss,” Alistair Moore, technology lead
at the Royal National Institute for Deaf People
(RNID) in the UK, tells MacFormat, by way of
example. “The diagnosis of these types of
hearing loss requires specialist clinical input
and cannot be replaced by AirPods Pro.”

Your AirPods Pro can be used as a
clinical-grade hearing aid. They
ﬂffl’ use the results of your hearing test
to make adjustments that help you
hear the voices and sounds
around you.

Your AirPods Pro can also make
@ adjustments that help you hear
I media like music, videos, and
phone calls.

Instructions for

@ the hearing aid industry and even, in some
circumstances, even replace traditional devices.
But will Apple's ‘hearing health experience’ be
truly effective?

Reducing costs

On the face of it, yes. In the US, for example,
the American Speech-Language-Hearing
Association says 80% of adults have not had
their hearing checked in the last five years so,
if nothing else, Apple’'s move will lead to more
adults having their hearing analysed via their
iPhone/iPad and AirPods Pro, even if it's out
of mere curiosity.

Technologically advanced
Even so, there is no doubt that Apple's decision
to roll out an end-to-end experience based on
prevention, awareness and assistance addresses
some wider issues surrounding hearing health.

Turn it down a notch

You don't necessarily need AirPods Pro iPhone also lets you monitor environmental
to take care of hearing health. With Apple sound levels and headphone audio levels over
Watch and the Noise app (for Series 4 devices a seven-day period to help prevent permanent
onwards running watchQS 6 or later), you can damage to your hearing. AirPods Pro 2 (and
receive alerts if the average environmental AirPods Max) are particularly beneficial here.
sound level reaches or exceeds a set decibel Studies show high levels of noise can increase
threshold. Adjust the level at which you'll be blood pressure and the risk of ischemic heart Past 30 Days
notified via Settings > Noise and consider disease, and cause stress, anxiety and .
using the Noise complication to view depression. Use active noise cancellation
current noise levels from your wrist. The (ANC) on these devices and you can drown

The Health app already amasses
Hearing category of the Health app on your out background noise with anti-noise. a lot of data about your hearing.
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Chief among them is a reluctance to wear
hearing aids - many potential wearers feel
self-conscious and it's perhaps why Apple's
Hearing Study found that 75% of people
diagnosed with hearing loss go untreated.

The AirPods Pro 2 are stylish and less obviously
a 'medical device’, making them a potential
game-changer - at least for those with less
challenging hearing loss.

AirPods Pro are also technologically
advanced and it's good to stretch their potential.
A study published in the journal iScience in 2022
found they met four of five electro-acoustic
technology standards for a personal sound
amplification product and they've long been
seeking to go beyond simply providing an
effective way to enjoy music. Features such as
Conversation Boost allow AirPods Pro to focus
on the person talking directly in front you when
in noisy environments, for example, while active
noise cancellation (ANC) reduces background
sound and Transparency mode allows you to
hear surrounding ambient sounds.

AirPods Pro are also clinically approved by
the Food and Drug Administration (FDA) in the
US - two years after the organisation allowed
hearing aids to be sold without a prescription to
over 18s. This followed a study with 118 people
with mild to moderate hearing loss which
showed the AirPods Pro 2 were just as good as
professionally fitted aids.

As Moore of the RNID says: “[AirPods Pro]
has great potential in helping everyone see that
using tech to help treat hearing loss is a positive
move to be embraced.”

Testing times

There are still some unknowns, though. “There
are questions about battery life and how they
will perform in real-world hearing conditions
rather than lab conditions,” Moore said. And it's
telling that AirPod battery life is measured in
hours; hearing aids in days.

As retired internal medicine physician Alan
Lidsky pointed out in a review by the National
Council on Aging (NCoA), there is also a chance
people would assume wearers are listening to
music and refrain from engaging in conversation
with them. But, at the very least, the Hearing
Test available with the AirPods Pro 2 will flag up
the extent of someone’s hearing loss and show

The move will lead
to more adults having

their hearing analysed

»Image credits: Apple Inc, Sennheiser electronic GmbH & Co KG

| Apple & hearing health APPLE CORE |

Sennheiser's SoundProtex aim
to protect your ears by filtering
or simply cutting noise.

Listening to startling statistics

The Apple Hearing Study, a

partnership with the University
of Michigan, has been looking at
sound exposure and its impact

on hearing since 2020. By letting
users contribute long-term hearing
health data from their Apple Watch
and iPhone, the study has found
more than 50% of participants have
worked in a loud environment and

a quarter have been exposed to
environmental sound such as traffic
and public transport which exceeds
the World Health Organisation’s
recommended limit.

how an aid can make a difference. It will raise
awareness of underlying issues and increase

More recently, it found 15% of
participants experience tinnitus daily
and 77.6% have experienced tinnitus
in their life - those aged 55 and over
are three times more likely to suffer
than those between 18 and 34. A
greater awareness of hearing health
is perhaps why other tech companies
have sought ways to improve lives.
Google's Project Wolverine
examined ways of isolating audio
from a specific person in a noisy
environment. Sennheiser, Jabra,
Sony and HP have also launched
over-the-counter hearing aids.

Moderate Loss
G Moderate Loss
Right Average i

All Hearing Test Results

L 54

Take the hearing test on your

iPhone or iPad and you will be
able to check for hearing loss.

the chance of people consulting an audiologist.

"“Seeing a licensed hearing care professional
can help determine unique hearing health needs,
ensure no underlying medical conditions or
presence of ear wax that could be contributing
to hearing difficulty,” Bridget Sobek Dobyan,
executive director of the Hearing Industries
Association, told MacFormat. “Professionals
can also provide guidance on effective and
personalised solutions.”

What's more, the whole “hearing health
experience” could be a solution for even wider
issues. Hearing impairment can be frustrating
but it can also lead to social isolation, reduced
confidence and an increased risk of developing
dementia, particularly if problems begin
between the age of 40 and 65.

“Anything that moves hearing health up
the national conversation is to be welcomed and
we look forward to a time when checking your
hearing reqgularly is as natural as checking your
sight or teeth,” Moore added. “Assistive
technology in all sorts of forms - including
hearing aids - is valued and celebrated.”
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Say hello to...
macOS Sequoia

What's new in macOS 15? What is Apple Intelligence,
and what can it do for you? Will my Mac be able to
run it? We tell you all this and more

Written by lan Osborne

our next free Mac
operating system
upgrade is here. To help
you make the most of it,
we walk you through its major new
features, tweaks and enhancements
and show you how to make the most
of them. We also look at some of the
features that haven't quite arrived
yet, and take a deep dive into the
more minor changes that help make
your Mac easier, more fun and more
productive to use.
macOS Sequoia was announced
at the Worldwide Developers
Conference (WWDC) in June 2024.

—

Once again, the name is taken from a
geographical feature found in Apple's
homeland, California. This time it's
the Sequoia National Park, named
after its giant trees.

The operating systemis a
similarly giant update, with Apple
Intelligence features integrated
throughout; improvements to Siri;
iPhone Mirroring, which allows you to
control your iPhone from your Mac;
improved Window Tiling to make it
easier to view multiple windows on a
single desktop; and improvements to
key Mac applications such as Safari,
Messages, Maps, Notes and more.

iMac: 2019 and later

Mac Studio: 2022 and later
Mac mini: 2018 and later
Mac Pro: 2019 and later

iMac Pro: 2017 and later
MacBook Air: 2020 and later
MacBook Pro: 2018 and later

Apple Intelligence
features, which are to be rolled
out throughout the year, require
Macs with an M1 chip or above.
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FEATURE macOS Sequoia

Apple Intelligence is integrated
system-wide into all of Apple’s
gear, including the Mac, the

iPad and the iPhone.

COGNITIVE SCIENCE COLUMN
" e Hyperphantasia:
=« o TheVivid Imagination
o Do you easily conjure up mental imagery? Y

be a hyperphant, a person who can evoke def|
visuals in their mind. This condition can infl
one’s creativity, memaory, and even career. Thy
that symptoms manifest are astonishing.

WRITTEN B XIAOWENG THONG

xinerme detail

sperphoitania i the comlition of Barving an
eredinarily vived imagsstion. Devlved from
. a7 which {eedatis o “thie s
sy It ey nchade phiantic thoughes and
e Wbl ivewbage chiocts, iritseies, and drearis In

Apple Intelligence

Exciting new features that are coming soon

Although arquably
the most important
announcement to come
out of this year's
Worldwide Developers Conference,
Apple Intelligence won't be released
in its entirety with macOS Sequoia.
The new artificial intelligence
platform that powers a series of new
features and is integrated system-wide
into the iPhone, iPad, Vision Pro and
Mac, is to be released with later OS
updates over the next year. So let's
take a look at what we can expect...

In Sequoia, Siri understands more natural language, lets you switch between
speaking and typing, and is better integrated into the current context.

22 | MACFORMAT | NOVEMBER 2024

Apple Intelligence is very focused on
the user and what they need from their
Apple devices. Drawing on your personal
context, it's customised to be relevant to
you and your wishes, and is privacy
protected at every stage.

Writing Tools can not only proofread
your writing, but can also rewrite it
to make it more formal, personal or
succinct. Available system-wide, you
can use the tools when writing an email,
updating your blog in Safari, making a
note in Notes, or indeed almost anywhere
that you write. Apple Intelligence can

_—

v

Not all heroes wear capes, but you

do!

Tell mum she’s a hero, and send a picture of her
wearing a cape, created in Messages using

Apple Intelligence and her Contacts photo.
produce useful images too, making
communications more fun. And again,
this feature integrated throughout the
system, and is also available in a
forthcoming new app; Image Playground.

Apple Intelligence in Siri

: From humble beginnings in 2011 with the
“ iPhone 4s, Siri is featured across Apple's
device range. Users make over 1.5 billion

il Siri requests per day. With the integration
of Apple Intelligence, it becomes even more powerful,
relevant and personal. You can speak to Siri more
naturally. It even copes if you hesitate, stumble over
your words or correct yourself mid-sentence.

An Apple Intelligence feature coming soon to Siri is
Screen Awareness, whereby Siri knows what's on your
screen. If, for example, someone texts you their address,
you can tell Siri to add it to Contacts, and it happens.

» Image credit: Apple Inc



HOW TO Use Writing Tools >

1 Proofreading

You can use Writing Tools to check
your writing for grammar, syntax and
spelling. Edits are suggested along the
way, and reasons for those edits given.
You can accept or reject a suggested
change, and revert where needed.

Rewrite

With the powerful Rewrite function
you can have Apple Intelligence redo
your writing, changing the tone if needed.
Make it more friendly if it sounds stuffy,
more professional if it's too chatty or
more succinct if too long.

HOW TO Use Image Playground >

Summarise

If you've written a long piece
of text, you can have Writing Tools
summarise it for you, into a short
paragraph, bullet points, a list or a table.
You can then replace or augment your
text with this summary

1 Create an image

Image Playground is an app that lets
you play with Apple Intelligence’s image-
creating capabilities. It's coming soon,
and its functionality will also be built
into apps such as Messages, Keynote,
Pages and more.

OPOe=2a
Basebad Cap. Bresarier Bever. Baowii Crower
ee®@ -
Flawer Crown Hard Hat Party Top Hat Surglasses.

Choose a theme

The app offers numerous themes
to start you off, including costumes,
accessories, places and more. Choose
a few of these themes, and Apple
Intelligence produces art based on
what you picked.

HOW TO Make Genmoji »

Be specific

When you have a more specific idea
in mind, instead of choosing from the
standard themes, type it in and have it
added to your set. You can use Image
Playground to create animations,
sketches or illustrations.

I"AF.

| ":‘1 T-rex wearing a tutu on a surfboard

LN v
1 What's a Genmo;ji?

Ever sifted through hundreds of emoji,
but still not found the right one to use?
Genmoji harnesses Apple Intelligence to
build exciting custom emoji that you can
use just like regular emoticons. You
simply need to type in a description.

»Image credit: Apple Inc

' \':1 T-rex wearing a tutu on a surfboard

2 Generating Genmoji
After typing the description -
however imaginative or crazy - your
Genmoji are quickly created. You get
several to choose from. Swipe through
them and find the one you most like,
then you can use it in the usual way.

PERSON
Vee

@ Race car driver ‘J

Uses of Genmoji

You can choose someone from
your photos, and make a customised
Genmoji that looks just like them.
Genmoiji can be added to inline messages
in the Messages app, and even used as
quick Tapback reactions.
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Presenter Backgrounds allows you
to add backdrops to your video feed,
hiding the room behind you.

iPhone Mirroring

& Window Tiling

What does Sequoia offer for getting things done?

Window Tiling

Organising your desktop can
be a pain, especially if you have
several windows open at once.
That's where Sequoia’s new,
easier Window Tiling feature
comes in. Drag a window -
whether a Finder window or

an open app - and a space is
suggested for it. Let go and it
resizes and moves to that space.
If you drag it out of its given
space, it automatically reverts
to the size it was before you
moved it to a tile space. It's a
great way to tidy your screen.

Prirme locations, prermiunm sulnes,
private Airstreams, and never
Wanting o feave.

Window Tiling makes it easier to keep
several windows open on the same desktop.
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Some very welcome new
features have been added
to Sequoia's video
conferencing facilities.
Presenter Preview shows exactly what
you're about to share before you
broadcast it, whether it's a single app
or your entire screen. Naturally, it works
with Apple's own FaceTime app, but it’s
also good for third-party video chat
software such as Zoom. During a video
call, click the green video camera icon
then, in the window, the Share Screen
button, then choose what to share.
There's also a great new
Backgrounds option, which uses Apple's

Why broadcast an untidy room during your video call,
when you can use the new Background option?

s O O =

iPhone Camera

& Studio Light

@ Reactions >
e Background I

Mic Mode

£ s MonJun 10 9:41AM

Monica Dien
] FaceTime Video >

-

£ Portrait

Standard >

The new Presenter Preview lets you see exactly
what you're broadcasting on your screen.

industry-leading segmentation to
cut out your image and place it on

a backdrop of your choice instead
of broadcasting the room from which
you're calling. You can choose from
arange of standard pictures and
gradients, and also use your own
photographs. Again, it's done from
the green video camera icon in the
menu bar. Click Backgrounds to turn
the feature on, and the thumbnail to
choose a picture to use. With a few
clicks, you could be broadcasting
from Apple's Cupertino HQ instead
of your humble attic office.

»Image credit: Apple Inc



‘ MacOS Sequoia FEATURE
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J

IPhone Mirroring

Control your iPhone, directly from your Mac!

Ever get those times when
you're on your Mac and
you really need to reach
for your iPhone but it's

in your pocket or in a bag in another
room? iPhone Mirroring lets you control
your Apple smartphone directly from
your computer - as long as they're
running iOS 18 and macOS Sequoia.

iPhone Mirroring is a Continuity
feature, which helps you use Apple
devices together. If your iPhone is in
range and connected to the same Apple
Account as your Mac, you can open the
feature and see your iPhone’s screen
on your Mac, controlling it using clicks
instead of taps. You can swipe between
pages on your Home Screen, and launch

HOW TO Use iPhone Mirroring »

your iPhone’s apps, controlling them
with your Mac's keyboard and mouse/
trackpad. You can even transfer files
between them in this way.

All the time you're using iPhone
Mirroring your phone remains locked,
S0 no one gets to see what you're doing.
It's also compatible when you're in
StandBy mode.

1 Start mirroring

If your compatible iPhone is within
range of your Sequoia Mac, you'll see
the iPhone Mirroring icon in the Dock.
Click on it and your two devices make a
connection, with your iPhone appearing
on your Mac's screen.

4 Control your iPhone
Close an open app by clicking on
the long line at the foot of the iPhone’s
screen. Alternatively, drag the pointer
to the top of the iPhone screen and
click the icons that appear for the
Home screen or App Switcher.

»Image credit: Apple Inc

2 See your iPhone screen
When your iPhone appears on

your Mac, it shows your iPhone’s Home
Screen. It's mirrored fully, showing your
chosen wallpaper, and your app icons
just as they're positioned on your iPhone.
The entire process is wireless.

m T O 8 & Mnunldsdram

Duolingo
AT Hi,it's Duo
W Got 3 minutes 1o pr.-‘nlce? Make tims for &
J heaithy habit in your day!

Get notifications

When using iPhone Mirroring, your
iPhone’s notifications appear alongside
those sent by your Mac. Click on an
iPhone notification and it opens in
your on-screen iPhone, allowing you
to interact as if on your phone.

Use your apps

While iPhone Mirroring, you can use
any of your iPhone's apps just by clicking
on them with your mouse or trackpad
(instead of tapping them with your
finger). You can swipe screens left or
right with your Mac's controller too.

6 Keep things private
When using iPhone Mirroring, your
physical iPhone stays locked so no one
else can access its contents. If your
iPhone is in StandBy mode, it remains
s0, showing a clock or other StandBy
widgets on the screen.
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& Mail File Edit View Mailbox Message

| Chair

8- B:450
FRIDAY, JUN14
| Fiag oay
SUNDAY, JUN18
| Father's Day

030 - 130

Qigong
2003400

=t: Following Up
From: Jenny Frith

Dear Ms. Herbst,

happy to meet again soon fo discuss my qualifications.
Thanks

Mail S i v

New features coming with later updates

order confirmations and so on, while
the Updates section stores newsletters,
social media alerts and Promotions is for
marketing and sales circulars. A new
digest section lets you collate all the
messages you've got from a business,
which is great if your information is
spread over several mails. Naturally,
there’s also an All Mail section whereby
you can see all your emails in one place.
Collation is done for you by Apple
Intelligence, and if you want to move
a specific correspondent to a different
category, you can. We're told On Device
Categorisation will be available ‘later this
year', but of course, this could slip to
early 2025. Given the amount of emails
we receive these days, we can hardly
wait to try it out.

Apple Intelligence is set
to work its magic over

= Apple Mail, making it

: ' easier to organise your
emails in the much-loved client. Like
most Apple Intelligence features, it isn't
available in the first release of macOS
Sequoia, but we look forward to getting
it with a later update.

The big new feature, known as On
Device Categorisation, was demoed on
the iPhone during the June's Worldwide
Developers Conference keynote, but
it's expected on the Mac, iPad and Vision
Pro too. It organises your emails into
categories. The Primary section consists
of emails from people you know and
time-sensitive messages. The
Transactions section is for receipts,

HOW TO Use the new Messages features >

Nice to meet you for coffee yesterdsy. Super super excited about this opportunity. Food security is near and dear
to my heart and | think | am well-qualified to help your organization grow and thrive. CV and cover letter allached,

MAJOR news

QeNGi

Enliven your messages with new text effects.

Messages

The Messages app offers
new effects. In iMessage,
you can add all sorts

of fun animations to a word or
phrase, or even individual letters.
If you want to schedule a message
(write it now but have it sent some
time in the future), you can. And

in macOS Sequoia, Tapbacks are
more versatile. You can send a
Tapback using emoji and stickers.

& Photos

% Stickers

@ Send Later

ain
ast Matpla

Q #mages

Monday e it It's raining ==

© #images

nplete

Jasfjdental..
’ Message Effects + OF course. | love her!
28/DBf2024
:

Choose an effect
Choose Message Effects, then

1 Type your message

Type your message in the usual way,

Send it later

To schedule the sending of a

and where applicable, highlight the text
to which you want to add an effect; the
whole message, a word or two or even

a single letter. Now click on the '+ icon

on the left of the text field.
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select an effect. Some of these effect
the text you highlighted, others apply to

the entire message. When you've chosen,

click the blue up-pointing arrow icon to
send the message.

message, instead of having it sent
immediately, first type the message
in the text field. Instead of clicking the
Send icon, click the *+"icon for an
options menu. Select Send Later.

»Image credit: Apple Inc



MacOS Sequoia FEATURE

S

Whats new in Safari

Apple Intelligence makes the browser even better

According to Apple, when
using macOS Sequoia,
Safari is the world's
fastest web browser, and
better for battery life when browsing
on a notebook Mac. It's gained some
new features with the new operating
system too. The new Highlights feature
uses machine learning to find relevant
information on the website you're
looking at, and presents it in a Highlights
window accessed by clicking on the ‘A’

in the left-hand side of the website
address. This information might include
directions, summaries, quick links, phone
numbers and more. It's much easier than

Safari Highlights detects pertinent information on
awebsite and presents it in an easy-to-find way.

The new Video Viewer feature puts videos front and
centre, making them easier to watch on the web.

searching an entire website when all
you need (for example) is an address
and phone number.

For watching videos on the web,
there's a new distraction-free Video
Viewer feature. Safari automatically
detects a video on the page, and Video
Viewer gives it priority regarding screen
space, without losing the playback
controls. Click away and it automatically
moves into Picture-in-Picture mode. This
makes watching videos embedded into
websites easier to navigate. You can
select Video Viewer mode by clicking on
the A’ to the left of the web address, and
choosing it from the menu.

Reader

A redesigned Reader is
accessed through the ‘A’ icon
on the left-hand side of the
toolbar. It now offers a contents
list and a summary next to the
article, as well as presenting
content in an easy-to-read way.
Click the ‘A" again and you can
change the background colour,
font and more, as well as turning
Reader off.

A new option found in the
same menu, Hide Distracting
Items lets you get rid of things
like adverts, illustrations,
boxouts and other bits and
pieces that might get in the way
from reading an article. You
select what you want to hide
yourself, so the choice is yours.

—
a

The Reader in Safari now offers summaries
and contents lists.

ate 00809 Z:00pm

Sep 2024 10w
Tod "_ e Th Fr ma 5, TYOUhave 8 great day!

4 Schedule your text

A date and time appears. Click on
the month, day, hour, minute or am/pm
to change that particular value. Click the
‘X" to change your mind and remove the
scheduling, or click Return to send it
according to the date and time chosen.

»Image credit: Apple Inc

She loves being pulsice

oniday

5 Respond quickly

A Tapback is an easy way to
respond to an incoming message. Just
Ctrl-click on the message you wish to
react to, and a menu appears. Select
an emoji from the menu, or choose
Tapback Details or Add a Sticker.

Try new Tapbacks

Tapbacks are now in colour, and
they can be any available emoji, or any
sticker you've previously used. The
Tapback appears next to the message,
just like before. It's a great new way to
express yourself, and great fun too.

NOVEMBER 2024 | MACFORMAT | 27



% DoorDash

a Atlas Obscura
% Kobu

L2

Security Deleted

Passkeys @ Etsy
User Name
Password
Website

@ QuickBooks
nichi, Padersendiciaud. com Group

SHARED GROURS

e Pedersen Family

m Linkedin

e Waork Passwords
F Etsy
32 LanchiPedersen@icioud.com Security

O owingo G

- -

% LA Times
@ Target

2 Apple

.-

The new Passwords app is built on Apple's 25 years of experience developing Keychain.

Strong Password

Add Verification Code...

Passwords & privacy

Keeping your data secure, the Apple way

Privacy
measures

Most Apple Intelligence
features in macOS Sequoia
are on-device, that is, the
information is processed on
your Mac and never sent to
external servers. But for the
rare occasions where this is
necessary, there's Private Cloud
Compute. This allows Apple
Intelligence to contact specially
created servers running on Apple
silicon processors. The software
they run has been created with
transparency in mind. Only data
relevant to the request is sent,
and it's never stored or made
accessible to others - including
Apple. Independent experts can
verify the server code to verify
it's operating securely, and Apple
devices refuse to talk to a server
unless the code has been logged
for inspection.
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P Sequoia brings us a great

8 new Mac app for storing

Hi passwords and login data.
Called simply ‘Passwords’,

it's built on the foundations of Apple’s

Keychain which has benefitted from

a quarter of a century's development.

A handy password and login
manager, Passwords can store
information such as Wi-Fi, app and
website passwords, verification codes,
shared passwords, ‘Sign in with Apple’
information and passkeys.

It's well organised, with an outward
appearance that closely resembles the
Reminders app. Categories of codes are

indexed in the left-hand sidebar, along
with options to view all your data and
recently deleted codes, which are kept
for 30 days before disappearing entirely.
Shared groups are accessible in this
sidebar too.

If a password has been compromised
by a data leak, you get an in-app
notification urging you to change it.
Your compromised passwords are also
collated into a Security option in the
left-hand sidebar, so you can go through
them all at once. New passwords are
added as you produce them, and you
can add them manually too. If you use
AutofFill, they automatically populate in
input fields when you want to
log on; just confirm with your
Mac's password, Touch ID or,
on mobile devices, Face ID.

Like Keychain, the
Passwords app syncs across all
your Apple devices, including
your Mac, iPhone, iPad and

Your Passwords app syncs its data through iCloud, across your Mac,

iPad, iPhone and Vision Pro.

Vision Pro. It also syncs with
Windows, using the iCloud
for Windows app.

»Image credit: Apple Inc
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New in
Photos

Apple's photo manager
and editor has had an
overhaul

automatically curated

II v . albums based on popular

themes. The idea behind this redesign
is to help you find photos quickly,
something that's increasingly essential
as your photo library grows ever larger.
The application’s left-hand sidebar
has been greatly simplified. Under
Photos, there are now just three

The new-look Photos app
is based on Collections,

Calculator

The Calculator has been
E updated. Switching
between Basic, Scientific
and Programmer calculators is
now done with an on-screen
button instead of the View menu,
and you can access the Notes
app's Maths Notes feature and
(when using Basic or Scientific
calculators) conversions through
this button too. There's also a
hideable History sidebar that
shows previous calculations,
and you can see expressions
as you type them when using
the scientific calculator. It all
makes for an easier, more
streamlined experience.

Expressions are shown when you type, and a new
button lets you switch calculators.
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The new-look Photos app is easier to navigate, collating pictures in whole new ways.

categories; Photos, Favourites and Map,
which shows your pictures according to
where they were taken. In the new
Collections section, you'll find familiar
categories such as Memories, People &
Pets and Albums, but also new sections
offering new collations. These include
Days, so you can find pictures you took
on a certain day, Trips for when you were
away from home and Featured Photos,
where you can admire the best

The new Scenes option makes it easier to
navigate your way around a Freeform board.

Freeform

Under View in the menu
bar, there's a new option:
Scenes. This lets you add a
Scene to your list, or navigate Scenes
that are already there. But what is a
‘Scene’ we hear you ask?
When a Freeform board gets
a bit packed, it might be difficult to
navigate. Making a Scene focuses
on the part of the board currently in
view, allowing you to move back to it
by selecting it from a menu in the
control bar at the foot of the window.
You can also export scenes as PDFs,
rename them and more. Other
improvements include snapping
items to grid, panning around the
board by holding the Space bar,
and improved diagramming.

photographs from your library. But these
days, taking photos isn't just for holiday
snaps and family events. If you use your
iPhone to take pictures of documents,
receipts, handwritten notes and more,
the new Utilities section makes it

easier to find them on your Mac.

Clean Up, an Apple Intelligence
feature that's coming soon, lets you
erase distracting background objects
from your pictures too.

Calendar

(FWN Calendar now integrates
'|7 with Reminders. If you
schedule a Reminder that is
set for completion on a specific day,
it appears in Calendar too. You can
view and edit reminders, and also
mark them as complete, directly
from Calendar. You don't have
to open the Reminders app.

You can even create a new
Reminder in Calendar; Ctrl-click,
and the option is there in the
contextual menu. When you create
areminder in Calendar, it's placed
in the Reminder app as a scheduled
reminder too.

Scheduled reminders now sync with the Calendar
app, making them visible for the date and time
you scheduled them.

»Image credit: Apple Inc
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The future of gaming?

Gaming announcements
. .\ atkeynotes about new
operating systems always
seem to offer more than
they deliver... But with the last two
releases, the Mac seems to be
becoming a more capable - if not more
popular - platform for video games.

We've some high-profile titles on the
way. Look out for Prince of Persia: The
Lost Crown and Assassin's Creed
Shadows, and Capcom'’s Resident Evil 7:
Biohazard and Resident Evil 2, coming
soon. Later this year, expect Warcraft:
The War Within, Frostpunk 2, Palworld,
Sniper Elite 4 and RoboCop: Rogue City.

Game Porting Toolkit 2, the second
release of the developer’s tools that
make it easier to port PC games to the
Mac and Mac games to mobile devices,
delivers some of the most-requested
features. Windows compatibility is
improved, and there are better shader
debugging tools.

Home

There's a few new
~ features for the Home
S app, mostly to do with
smart locks. You can set guest
access, allowing a visitor to enter
your home at certain times and on
certain days. If a carer or cleaner
visits every Tuesday at midday,
you can give them guest access,
allowing them entry at these times.
Going forwards, Apple is
planning to introduce support for
robot vacuum cleaners to the Home
app later this year, including for
automations, scenes and Siri
requests. The company also plans
on integrating electricity
consumption.

4

The Home app boasts new features for smart locks,
and there's more to come later in the year.

»Image credit: Apple Inc

N Apple’s AirPods offer
an even better in-game
experience on the Mac,
especially if you have
AirPods Pro 2.

AirPods

There's a few new features coming

to Apple’s recently updated
AirPods. If you've invested in the
new AirPods Pro 2, you can respond
to Siri simply with a head shake
for 'no’ or a nod for 'yes', without
actually speaking. Personalised
Spatial Audio for gaming means
you can tell from which direction
an in-game sound is coming, and
there's voice improvements for
in-game chat and streaming. The
new AirPods Pro 2 also boast
reduced audio latency, for even
better immersion into the gaming
experience of your choice.

What’s new
in Weather?

The wind chill factor is

g already featured in the

" Weather app, but in
macOS Sequoia, when there's
a significant difference between
the actual temperature and the
Feels Like temperature, the latter
appears far more prominently,
next to the actual temperature.
Also, if you've added Home and/or
Work addresses to your Contacts
card, you can add them as Weather
locations too. Click the Search field
and they're offered as suggestions,
which you can open immediately
from the menu that appears.

In Sequoia’s Weather app, you can quickly check what
the weather's like at your Home or Work address.
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Take a hike with Maps

Keeping your data secure, the Apple way!

Apple's Maps app has

long been a useful tool for
finding your way around in
towns and cities, planning
a travel route or locating local
amenities such as cafés, petrol
stations and more. With macOS
Sequoia, it gains another great feature
that helps you explore the world; but
only if you're in the United States.

To date, GPS tools such as the Maps
app have been at their weakest when
you're in open land, with few if any
nearby markers such as buildings or
roads. Not only do many GPS systems
offer no indication of elevation, that is,

Developer
tools

Apple has released some new
APIs (Application Programming
Interfaces) for developers to use,
enabling them to integrate Apple
Intelligence features into their
own apps. Developers can add
Image Playground's graphical
creation capabilities into their own
apps with just a few lines of code,
and Writing Tools automatically
becomes available in apps that

use the standard editable text
view, without any intervention

on the part of the developers.

If an app uses SiriKit, it benefits
from Siri's new capabilities too.

- B

— G@azEsE
= - -n- EIET I X
. SR PSRRI Pk [T X 2% K

Third-party apps like Craft can integrate Apple
Intelligence features such as Image Playground.
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hills and valleys, there's also I 5
patchy, if any, mobile coverage }
in the countryside or desert. e i
This changes with Sequoia, i
and also the maps apps in comshemn e

i0S 18 and iPad0S 18.
Thousands of hiking routes
across all 63 national parks in
the United States are included,
such as Bryce Canyon, the Everglades,
Yosemite and, of course, Sequoia. You
can download the routes for offline use
too, and also create and save custom
walking and hiking routes. When you
visit a national park, you can filter the
routes according to length, elevation

The light and dark versions of the standard
wallpaper. Can you spot the inspiration?

Wallpapers

These are the light and dark
versions of the standard Sequoia
wallpapers. Can you see what they
represent? The Sequoia national
park takes its name from the giant
trees that grow there, and that's
what's depicted here. Imagine being
in a forest and looking up. Another
wallpaper has classic Mac OS icons.

The Maps app now includes hiking routes for all 63 US national parks,
hopefully details of footpath routes in the UK will follow.

and route type, making it easier to find
a trek that suits.

To date, only US national parks are
included, but we hope the feature turns
out in more countries as time goes on.
We'd love to hike through the Brecon
Beacons or Dartmoor, without having
to carry a paper map with us.

ChatGPT

Apple has done a deal with
artificial intelligence research
organisation OpenAl. Apple is
incorporating the capabilities

of Open Al's chatbot and virtual
assistant ChatGPT into its operating
systems. This means you can
benefit from ChatGPT's broad

world knowledge and specialised
resources without having to

close your Apple app and open

a dedicated ChatGPT app. For
example, Siri can tap into ChatGPT's
expertise when answering a
guestion. The Apple service asks
your permission to tap into
ChatGPT before doing so.

Bedtime Story

& Badtime story about 3 six year old girl

s A as and
hetos it overcome a major obstacle 5o it
can become 3 butterily]

Ircude A1 Tt 2
rpsey

Apple Intelligence can harness the power of
artificial intelligence pioneer ChatGPT, making
it even more capable.

»Image credit: Apple Inc
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Maths Notes is a very capable calculation
tool for mathematicians, scientists and
anyone who has a sum to solve.

Maths Notes, Highlights & collapsible sections

The Notes app is getting smarter and more useful in macOS Sequoia

With macOS Sequoia, the Maths Notes allows you to work out values to see how it effects your results.
__________ Notes app is even more mathematical equations in the Notes Maths Notes can be saved just like

capable. If you find yourself app. Just type it in, and as soon as normal notes too.

writing a very long, text- you enter the ‘=" symbol, the answer Finally, there's a great Highlights
heavy note, you can divide it into appears. It's not just for the basic four feature added to the formatting tools.
sections with collapsible section functions either. The Maths Notes Highlight the text you want to mark, click
headers. Just identify a line as a feature offers the same capabilities on ‘Aa’ and click the highlighter button in
subheader in the formatting menu as a scientific calculator, which is the top-right of the window. The text you
and, when you hover your pointer over great news for those who need more chose is highlighted, just like if you'd
it, you'll see that a chevron appears. advanced mathematical capabilities. gone over a piece of printed text with
Click this to collapse and expand that You can assign variables and use them a highlighter pen. Click the coloured
section of text. in equations, and then adjust their dot to change colours.

Live Audio Transcription

A new Apple Intelligence feature to record audio, and have it

available on Macs with an M1 transcribed in real time. You

chip or better is Live Audio can then copy and paste the
Transcription. First of all, decide transcribed text, and play back
where on an existing note you the audio recording too. It's great
want your transcription to appear, for lectures, interviews, meetings
or open a new one for the and numerous other tasks.
purpose. Click the new waveform The feature is currently only
button in the Notes app's tools, available in English, but UK,

and a recording box appears. Australian, Canadian, Irish,

In a right-hand sidebar are the New Zealand, South African and
recording tools, which allow you American English are catered for.

»Image credit: Apple Inc

® & & ARCH 201 Lectura 12

ARCH 201 Lecture 12

00:41.13

In Sequoia, the Notes app has a great new
audio transcription service. Making lecture
notes has never been easier.
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>Master Apple

shortcuts

macO0S

> Cmdis the Command key.

> Alt or Optis the Option key.

> Ctrlis the Control key, also
shown as "' in shortcuts in
the menu bar.

» The thick, outlined up

arrow is the Shift key.

> The thin, left arrow or
outlined pointer with ‘X’

inside is the Delete key, which
deletes to the left. Pressing
the Function key (Fn) and the
Delete key deletes to the right.
>The thin, right arrow key with
a small vertical line at the end
is the Tab key, which shifts the
focus between some controls.

i0S

> A tapis a brief contact

of (usually) one finger

on your device's screen.

»>To dragis to move a finger
across the screen to scroll

or pan around content.

> Swipe means move one or
more fingers across an item
or the screen, then let go.

> A flickis like swiping, but it's
quicker, and is often used to
scroll content more quickly.

> Pinch means move two
fingers together or apart,
usually to zoom in or out.

> Touch and hold means lightly
rest your finger on an item
and wait for a reaction.

WHAT'S INSIDE
e

38 CUSTOMISE YOUR SLIDESHOWS

» Create a shareable slideshow in Photos

40 RECORD SOUNDS ON MAC

» Record sound sources - and transcribe audio

42 USE VERSIONS IN KEYNOTE

> Revert to previously saved presentations

44 ACCESS MAPS ONLINE
> Go places with the Apple Maps website

46 LEARN CREATIVE SKILLS

> Have fun in your spare time with a new interest

48 DISCOVER PODCAST PARADISE

> Perfect your podcast episode management

50 IMPROVE YOUR SLEEP ROUTINE

> Stay off your phone and get some restful sleep

52 USE YOUR WATCH MORE EASILY
>Make your Apple Watch more accessible

54 HOW IT WORKS: GRAPHICS

> Learn about mesh shaders and ray tracing

» Image credits: Apple Inc, George Cairns, Seekrtech Co Ltd
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NEW
IDEAS

Your in-depth guide to
getting more from
your Apple kit

Contact us

Email your queries and
your questions to
letters@macformat.com

NOVEMBER 2024 | MACFORMAT | 37



APPLE SKILLS macOS

Customise your slideshows

How to create a customisable and shareable slideshow in Photos

IT WILL TAKE
»15 minutes

YOU WILL LEARN
>How to make a great
slideshow by adding a

theme and soundtrack.
Plus how to export a
shareable slideshow

YOU'LL NEED
> Apple Photos

EXPLAINED... The Project window >

5 A slideshow is an entertaining
way to share holiday highlights
with friends and family. And the
Photos app can help present

your images in eye-catching ways using a
variety of visual themes. For example, the
'Vintage Prints’ theme places a colour image
on top of a scattered pile of monochrome
shots and uses ‘Ken Burns' style pans and
zooms to add motion and energy.

There are seven visual themes to choose
from, and each one has its own accompanying
theme song. The movement and music of each

theme helps hold the viewer's attention while
watching your images.

Simply select a slideshow from any album
you've created in Photos, choose a visual
theme and the corresponding music will be
added automatically. If you're happy, click Play
Slideshow to present it on your Mac's display.

Alternatively, if you want more control
over the content, layout and music, you
can customise it in Photos' Projects. You can
also export your project as a slick slideshow
movie to share on social media sites, such
as YouTube or Facebook. George Cairns

' Densy
&
8 Edit feature
=2 Landscape & outdoor
L andy
W Tvz
B raicard
3 IPhoneography
ﬂ Lightroom
B iPhoneography
&8 velicity
B tvia
MB Claire and Me
B Lightroom
) rum
T Art
5 13 Pro Smart Album
& RAW Smart Album
5 Raw Smart Album

Projscty

[ My Projects
& Art £ Book
] Lightroom

[ Card

=] Lightrogm
(] Book Covers
r] Densy =
51 Summer Holiday

New project

» Click here to create a new
slideshow from scratch, or to
turn an existing album into an
exportable slideshow movie.

[ Calendar

Gal Wall Decor

App Store.. 3

(2] ©

THEMES

Ken Burns
Origami
Reflections
Stiding Pariels
Wintage Prints
Classic

' Magazine

Filmstrip

»Drag the thumbnail images
in the filmstrip around to
change the running order

of your slideshow.
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Theme picker

> Click here to choose a
theme for your slideshow.
You'll find a range of layouts,
moves and transitions.

Add images

» Click '+' to add additional
photos from your Library. You
can also add editable text to
a photo in the filmstrip.

» Image credits: Apple Inc, George Cairns



Create interesting slideshows APPLE SKILLS

HOW TO Use the different project tools >

Create an album

Choose File > New Album. Label the
album. Drag shots from the Library into
the album. Click on the album to view its
contents. Open Projects in the sidebar
and click the ‘+' next to My Projects.
Choose Slideshow > Photos.

et ¥ER 23R CTHS SRRy ETR

Choose a theme

For a more visually interesting
slideshow, click the Themes icon
(overlapping rectangles). Click on a
theme option and then click Preview to
see how it presents your photos. The
corresponding theme music will also play.

Preview slideshow

If necessary, Photos will download
the album's full-size shots and add them
to your new slideshow. Click Preview to
view the slideshow. By default, Photos
uses the Classic Theme which mixes
between consecutive shots.

(I EEPEEE TR

Customise Ken Burns

Click the Ken Burns icon in the
slideshow window. Click the start icon
and drag the slider to choose a photo's
start size. Choose an end size and
position for a shot. The image will then
zoom between the two key frames.

S BMEOER SR INmERE

7 Change the music

Click on the musical note icon, then
click the down arrow. Choose Theme
Songs (or choose Music to select from
your own library). You can preview each
song using the adjacent Play button. Click
on a song to add it to your slideshow.

»Image credits: Apple Inc, George Cairns
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Choose a title

Each theme has a title page to
introduce your slideshow. The title is
taken from the name of the album used
to create the slideshow. You can edit this
copy by clicking in the text field in the
slideshow's Preview window.

Reorder your shots

Photos play according to the order
that they appear in the album. You can
rearrange the slideshow’s running order
by dragging images from one slideshow
page to another in the filmstrip at the
bottom of the Projects pane.

T MO SO TN
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Share slideshow

When you've customised the look
of your slideshow, click Export. Choose
a format. High Definition (1080p) will
look great on a widescreen TV; Standard
Definition will be easier to upload and
share via social media.

Choose duration

Click on the Duration Settings icon.
If you tick ‘Fit to Music’, the slideshow will
play (@and loop) until the music finishes
playing. If you plan to share the slideshow
online, drag the Custom slider to choose
a specific duration.

NOVEMBER 2024 | MACFORMAT | 39



Input Device

Audio Hijack Session List

Input Device

......

Input Device T
[

_4_#

Inactive

s
e Ko

= Balance
E Bass & Treble

8 Channels

| Low Pass Filter

B Magic Boost

Stopped

Mono Enhancer

Pan

Simple Compressor

Valume

Record sounds on Mac

Record different sound sources with QuickTime Player and Audio Hijack

IT WILL TAKE

»>15 minutes

YOU WILL LEARN
»How to capture any
audio on your Mac
YOU'LL NEED

» Audio Hijack,
macOS 14.4 or later

Your Mac can play all kinds of

. ‘ I | " sounds from all kinds of sources,
but how do you record and store
them for personal use? For things

plugged into your Mac, such as microphones

and audio interfaces, you can use QuickTime

Player or, if you want to adjust the sound,

GarageBand. But to record from apps, online

audio, or even from multiple sound sources

at once, Audio Hijack (§77, about £70,

rogueamoeba.com) is even better. We use

it for all kinds of things, such as recording

phone and FaceTime interviews; saving audio
from videos we need to refer to later, and for
recording from all kinds of apps.

Audio Hijack can also do something very
clever - it can transcribe audio files and turn
them into text you can edit, copy and paste. If
you want transcription but don't need Audio
Hijack's power, there's a more affordable
transcription app: MacWhisper (goodsnooze.
gumroad.com), which is free and works really
well with recorded audio from apps such as
QuickTime Player. Carrie Marshall

HOW TO Record different audio types »
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Do it QuickTime

Launch QuickTime Player from
Spotlight or your Applications folder,
then select File > New Audio Recording to
create a new recording. In this case, we'll
use our MacBook's built-in mic but any
connected audio device will work.

@ CQuickTimePlayer Flle Edit View Window Help

Autdio Recording

2 Start recording

To adjust the recording quality,
click the down arrow to the right

of QuickTime's Record button. This lets
you choose from connected inputs, for
example our laptop’s microphone, and
to choose high or maximum quality.
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@ OQuickTime Player Fde Edit View Window Help

Capture your audio

Now it's just a matter of clicking the
Record button (and again when you want
to stop). As you record, the indicator bar
at the top of the window will pulse to
show you how loud your sounds are.
It will also display a file size.

» Image credits: Apple Inc, Rogue Amoeba Software Inc
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CONTINUED... Record different audio types >

#  QuickTime Player File Edit View Window Help

B untitied

“ p »

Listen back

When you click to stop recording,
the window will change to the playback
window shown here. You'll see a central
play/pause control, forward and back
controls, sliders for volume and playback
progress, and an AirPlay button.

— e ———

7 Pick your playback

As you can see, there's a big list of
audio types, such as recording from an
internet radio station. Let's go for Input
Device, which enables you to record from
sound sources connected to your Mac
such as microphones or your built-in mic.

#  OQuickTimePlayer File Edit View Window Help

5 Save your sound

Go to File > Save, and you can decide
where you want your sound recording to
be saved and what you want it to call it.
You can add tags to your recording by
choosing from the existing ones or typing
a new tag and selecting a tag colour.

Choose your source

Audio Hijack uses flowchart-style
diagrams to show what's connecting to
what. Things can get complex, but this
one is simple. Our input device is our
Mac's mic connected to an MP3 recorder.
That'll save the sound as an MP3.

Record anything

If you need to bring in the big guns
for more options, Audio Hijack can record
literally anything that makes noise on
your Mac - from websites and apps to
internet radio and record players. Open
the app and click New Sessions.

Turn it to text

One of our favourite features is
currently in beta. Select Blocks from the
sidebar and search for Transcribe; drag
that into the window so it connects to
Input Device. You'll need to choose how
big a dictionary you want to download.

‘I Wait a while

We're downloading the bigger
High Accuracy dictionary. It'll take a
couple of minutes to download and
install. While you wait, check out the
other draggable tools - they include
de-noise tools and audio improvers.

»Image credits: Apple Inc, Rogue Amoeba Software Inc

‘I Let it listen

No matter what settings you've
used and what you're recording, all Audio
Hijack live recordings work the same way;
click Run and it'll start recording. In this
case, it'll also transcribe what it hears, so
you'll have an MP3 and a transcript too.

‘I 2 Open it up
By default, your transcript is a

text file saved to Documents > Audio
Hijack on your Mac. The example here is
an unedited transcript; the transcription
block adds punctuation and product
capitalisation automatically.
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Current Document

MY AWESOME HOLIDAY

Today, 12:04

Work with Versions in Keynote

Revert to previously saved versions of documents in iWork apps

IT WILL TAKE
»>10 minutes

YOU WILL LEARN

» To switch between
versions and copy
elements

YOU'LL NEED
>mac0S 10.7 or later

Versions has been a long-
standing, but often overlooked,
feature within the Pages,
Numbers, Preview and Keynote

apps, enabling you to easily go back to
previous versions of a document. That's
great for all kinds of reasons as it means you
can either revert back to an earlier iteration of
a doc (when you mess up) or use it to recover
items (such as images and charts) that you

accidentally lost during your creative frenzy.

Triggering the feature brings up a
Time Machine-like interface where you
can browse a stack of all the previously
saved versions of your current document.
You can bring up a preview of a selected
version and copy elements from it, whether
you then opt to restore it or not. By harnessing
the power of Versions, you can get creative
and experiment with your documents, safe
in the knowledge that you can always revert
to an earlier iteration. Phil King

HOW TO Revert to a previous version »

DEERD et weent Ghde Formst Amege Viow Py Window Hew

‘I Start reverting

If you want to revert to a previously
saved version of your presentation in
Keynote, select File > Revert To. You may
see an option for Last Saved (with a day
and time) version. Otherwise select
Browse All Versions.
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Browse versions

The view will shift to show a
thumbnail of the current version on the
left and a stack of previous ones on the
right. You can browse through the latter
by using the up and down arrow icons or
the timeline on the right-hand edge.

Restore a version

Before deciding whether to restore
it, get a large preview of a version, and
see its slides, by clicking its thumbnail.
Click the Restore button to revert to
that version. You'll then be back in the
Keynote interface where you can edit it.

»Image credit: Apple Inc
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CONTINUED... Revert to a previous version »

4 Or restore a copy
Alternatively, while on the Browse
All Versions screen, hold the Opt key and
then select ‘Restore a Copy'. This will
open a copy of the selected version in
Keynote, alongside the ‘current’ one you
were working on, which can prove useful.

Restore lost slides
If your restored copy of the older

version is missing any slides you added

later, copy them from the open ‘current’

document. Select the thumbnails in the

left sidebar, Ctrl-click and choose Copy.

Then paste them into the other version.

HOW TO Recover a lost image »

Copy between versions

Alternatively, on the Browse All
Versions screen, you can copy slides,
items or text from a selected version
from the stack and paste them into the
current document. (To view the Keynote
menu, move the pointer to the top.)

L

‘I Find the image

If you've lost the file for an image, you
may be able to retrieve it from a Keynote
presentation. If it's not in the current
version, select File > Revert To > Browse
All Versions, then preview the stacked
versions to find the image and Restore.

BEERLRUCE

1

< =

2 Copy full image

If you simply Ctrl-click and Copy the
image, you may get a cropped version of
it. To get the full picture, Ctrl-click and
select Edit Mask, then move the crop bar
all the way to the left and click Done. Now
Ctrl-click again and Copy the full image.

Save image

Open the Preview app and press
Cmd+N to create a new document from
the clipboard. This will open a window
with the lost image that you copied from
your presentation. You can then save the
image by pressing Cmd+S.

»Image credit: Apple Inc

More versions of Versions
Working with Versions in other apps »

You can also access the Versions feature in the Pages, Numbers and Preview
apps. The concept is the same; every time you save a document, a version is
stored. You can then select File > Revert To > Browse All Versions to view a
similar version browser interface to that in Keynote, with a stack of previous
versions shown on the right. Again, you can preview a version by clicking on
it and copy items from it to your current document on the left if you want.
Or just restore the older version, or a copy of it by holding the Opt key.
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Use the Apple Maps vveb5|te

Apple Maps is finally available as a website - albeit in beta form

IT WILL TAKE
>5 minutes

YOU WILL LEARN
> A Mac or iPad
running Safari or
Chrome, or a PC
running Chrome
or Edge

YOU'LL NEED

> How to familiarise
yourself with the
Apple Maps website

43

'

Genius tip
»Places you've recently
looked for can be
viewed in the sidebar
and when you search
but remember this
history will disappear
when you close the tab.

. - In amove that intensifies the
= rivalry with Google Maps, a
&0‘ public beta version of Apple

£ Maps has been made available

on the web. It lets you search for and discover
places to visit while getting driving and
walking directions. You can also find
information about businesses, perform
actions direct from the Maps Place Card -
and check out what other people think by
sharing it - all without using the Maps
app on your computer.

Go to beta.maps.apple.com on a Mac or
iPad running Safari or Chrome, or a Windows
PC running Chrome or Edge and you'll be
presented with the Maps interface. It's not as
comprehensive as the apps but it looks familiar,
letting you quickly find what you need.

We'd like to see a sign-in option so your
web activity can be synced with the apps and
it'd be great to include multi-stop directions
and options for public transport and bikes,
but we're sure they'll be added in due course.
David Crookes

HOW TO Use Maps in a browser >

D

‘I Orientate yourself

Launch the website and it'll show your
location. If it doesn't, click the navigation
pointer (top right). If Location Services is off,
go to Apple menu > System Settings > Privacy
& Security > Location Services.
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Find a location

Click and hold on the map to move
around, using your mouse scroll or trackpad
to zoom in and out. Use the Compass icon to
alter the geographic orientation and select
Search to quickly find a specific location.

»Image credit: Apple Inc
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Apple Maps website APPLE SKILLS

Look for amenities

When you click Search, you'll also see links
to amenities such as nearby stores, parking
and fuel stations. Clicking one will plot the
locations on the map while letting you select
the exact amenity you wish to visit.

s o0 Disetions.

Get directions

Choose Directions via a card or main
menu. Check the start and end points and, for
drivers, maybe input when you want to set off.
Drivers can avoid tolls and motorways. Walkers
can avoid stairs, hills and busy roads.

Alter the view

You don't need to stick to the standard
view. You may gain a better sense of a location
by selecting the Layers button (top right) and
choosing the Satellite view. You can mix
Standard and Satellite views using Hybrid.

»Image credit: Apple Inc

SN Jargon buster
e > Apple's Look Around
- feature offers a 360°
L i street level view of the
immediate environment.
e It is coming soon to the
Apple Maps website.

Check out details

Select a place or click a place label on
the map to access a card that, in many cases,
lets you find directions, call, visit the website,
view ratings and reviews, see photos, and
more. Share places via the Share menu.

EMaps O

u B London Cangestien Charge Zone

Route Detaits ;g i

) London Usra Low Emisshon Zone

Select a route

You'll often get a choice of routes. Click ‘i’
next to a route for step-by-step directions and
any advisories. You can view the route on the
map to see if there are potential delays (look
for red and orange stretches).

"

ey L Genius tip
¢ : »You can't share the
y directions to another
device but you can print
them, which could be
useful if you're travelling
in a remote area.
8 Use the guides
Need inspiration? Select Guides and o 5
use the menu to find a city. Discover places u oo \\
to eat and things to do and see the locations B - TV
mentioned plotted on the map, letting you T o

find more details and get directions.
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Video For Social Media:
Create to Engage Your

Audience

Rack up those views! In this Learning Path,

you’ll grow from beginner to comfortable social
media video creator. You'll learn how to outline, |
shoot, light, and upload your short-form video '
to tell a compelling story and increase ‘

engagement.

Curated By Skillshare N

L4 Classes (3 hours, 21 minutes)

il MATERIALS

Learn new crea

Lessons

Projects Discussions

6 Students

Easy, Fun Apple Shortcuts: Build a
Customizable Tabata Workout!

If you're curious about Apple Shortcuts and what

G

it can do, this hands-on class is the perfect place
to start. We'll use Shortcuts to build a customiza...

Read All

tive sKills

Get creative and have fun in your spare time with Skillshare

IT WILL TAKE
>1hour

YOU WILL LEARN
>How to find
interesting courses
and learn new things
YOU'LL NEED

> Skillshare (i0S/
iPadOS 15 or later,
or tvOS 10 or later)

43

'

Genius tip
> It's easy to fall out of
the learning habit but
the app's settings lets
you manage learning
reminders, creating a

time for a weekly nudge.

It's true to say that learning

is a lifelong process but, while

nurturing new skills can be a

heap of fun, you may find that
you're often pressed for time. Engage with
Skillshare, however, and you're unlikely to
feel pressured. The app provides thousands
of creative classes across art, photography
and design and breaks them down into

Instagram fi >
lllustrators

Jeas Mitlor Dvass +

Lessons Projects Discussions

7. Closing Thoughts

When you look at a course's information page, you
can scroll down the screen and see related classes.
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very manageable chunks. Importantly,
you can also learn at your own pace.
Available for iPhone, iPad and Apple
TV, the lessons are taught by creative
professionals and industry icons, and you're
sure to find something of interest whether
you're looking for success on YouTube,
wanting to create your own unique sound,
seeking to create animation, write fiction, and
more. You can receive certificates, engage
with teachers and other classmates and share
end projects for all to see. You're also able to
access as many or as few classes as you wish.

Keep learning

To gain access, you'll need a subscription

which can be paid monthly (£24.99) or, to save

money, annually (£79). The good news is that

you don't need to pay straight away. There's

a free one-month trial available when you

first use the app and it's easily cancellable

via Settings > Apple Account > Subscriptions.
It's certainly worth checking out given the

sheer breadth of content available so let’s take

a look at how you can get the most out of it.

David Crookes

» Image credits: Apple Inc, Skillshare Inc



Learn new skills APPLE SKILLS

HOW TO Find and follow the perfect Skillshare course »

recommendations for you.

Photography Animation
&

Productivity Procreate

‘] Pick subjects

After signing up to Skillshare, you're
asked to pick some subjects of interest
so that the app can make course
recommendations. Select ‘Let’'s get
Started’ when you're done and a relevant
dashboard will be created for your tastes.

cuassType (3)
U Criginal 1
M stofi pick 1

D Top Teacher 3

CLASS LEVEL

Discover courses

The search filter also lets you look
for classes produced by Skillshare or
those produced by its community.
Narrow down by class level (Beginner,
Intermediate or Advanced), ratings,
length and those with resources.

Lessons Project Di

Watch the videos

Ready? Tap a lesson to start a video.
You can toggle Download All to work
offline and select the "..." button on videos
to change the playback speed, turn on
subtitles or listen to the audio when
using other apps.

»Image credits: Apple Inc, Skillshare Inc

Inspiration Starts Here

) e e e
Find a course
Browse through the Watch tab,

checking out staff picks, suggestions and
new and trending courses. You can see
how many lessons a course consists of
and its overall length. You can also
bookmark any you like the look of.

Get Inspired

5 Be inspired

Not sure what to go for? Each day,
the Inspiration tab shows a different set
of trending student projects which you
can like or share. As well as seeing details
of a project, you can tap through to the
relevant course.

My Classes
Downloads 5
1 class
[] Al Saved Classes 3
m All Saved Learning Paths >

Complete a class

To continue a course, tap Save -
so it's easy to pick up where you left off
in the My Classes tab. To engage, tap
‘Start a Discussion’ and start or continue
a chat. Your projects can be uploaded via
Projects > ‘Submit a Project’.

< IMustration 3
12,514 results = Filters
3{'-,17 The Business of Drawing: From
25 ., Hand to Screen
l_;;f L’ : Samantha Dion Baker
@ 3m « S, 283

!}.m" ‘% Hand Lettering for Beginners:

Use search terms

To widen your scope, tap the Search
button and either choose a popular
course topic or enter keywords. When
you see the results, you can tap Filters
and sort them by relevance, number of
students or the newest classes.

Lessons Project Di
6 Start learning
See a course you like the look of?

Select it and learn more by reading a
synopsis of what's involved, checking
out the teacher’s profile and looking
through the lesson titles. Resources
and key tasks are under Projects.

Netifications

[umon

You're all set! You'll get personalized updates and class

recommendations.
Manage

Personalized Notifications

Learning Reminders

Set aside time every week for learning.

Find another class

You can manually look for another
class, allow suggestion notifications via
My Classes > Settings or embark on a
learning path - sets of curated classes
that build knowledge (discover
recommendations on the dashboard).
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- Nter

Overcast

Perfect your podcast listening with this app

IT WILL TAKE
> 5 minutes

YOU WILL LEARN
>How to love podcasts
again with Overcast

nodcast
naradise with

actually a better way to consume your
favourite shows - with Overcast. This brilliant
little app is chock-full of clever controls that

If you enjoy listening to
podcasts, chances are that
you use Apple's eponymous
Podcasts app. But there's

Overcast

Playlists

MNew Playlist Downloaded In Progress

Current

Podcasts

J A Death In Cryptoland

YOU'LL NEED
> Overcast (Free, offers
IAPs), i0OS 17 or later

are tailor-made to enhance your listening

sessions far beyond what Apple’s rival can

offer. Once you use it, you'll wonder how
you ever managed without it.

The Adventure Zone

American Vigilante

As you'll soon see, one of Overcast's “’LI"“TE CROWDNETWORK

key strengths is its customisation options.
You don't have to settle for the developer's
way of doing things - you can adjust audio
playback controls, tweak notification settings
on a per-show basis, and even redesign the
app’'s home screen to your own taste.

Here, we'll show you how to use Overcast,

to going in-depth with its extensive
personalisation tweaks. So, let's revamp
our podcast experience and see what all
the fuss is about. Alex Blake

from mastering its intuitive playback controls

HOW TO Start listening »

No Such Thing As A Fish

‘I Add podcasts

Tap the magnifying glass in the top-
right corner to add some podcasts to
your library. You can enter a podcast
name or use the categories to browse.
When you've found one you like, tap
its name, then tap Add Podcast.
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Episodes Current All

545: No Such Thing As Lightning At Sea

2 AUG 2024 « 6466

2 Start listening

Added podcasts live on Overcast's
main page. Tap one to view its episode
list; Current shows new episodes, All lists
everything. Tap an episode to share, star,
delete it and more. Tap the Play button
to start listening.

Control playback

On the Now Playing screen, you'll
see play progress; you can skip forward
or back. The Stopwatch button sets a
sleep timer, while the Waveform button
adjusts playback speed and enables
extra features (see next page).

» Image credits: Apple Inc, Overcast Radio LLC
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HOW TO Manage playlists >

Edit Playlist

Title: Comedy shows

lcon o

‘I Create a custom playlist
At the top of Overcast's home page,
you'll find a Playlists section. Swipe all
the way to the right here and tap the '+,
then tap Custom Playlist to add a new
playlist. Give it a name, icon and colour
to get started.

High-Priority Podcasts

SELECTED PODCASTS

© &5 Nosuch Thing As AFish

AVAILABLE PODCASTS

o . A Death In Cryptoland

Use smart controls

Now, you can set rules, exclude
or add specific podcasts and episodes,
and more. Playlists can also be marked
as high or low priority, so that they
automatically get ranked higher or
lower in your playlist.

HOW TO Customise Overcast »

Episode: > Add To...

®
> Move To... (=

758: Appl

O 18 AUG S
Star b

Apple Intell
®

and Stephe

Download

Add to playlist

On a show's episode list, tap an
episode to show its options. Tap the
More button ('..."), then select Add To.
You'll see a list of playlists it can be
added to. Or pick Move To and it will
be moved rather than copied across.

T+ i o+ + Ix 4+ 3x
Smart Speed —TL: \
NATURALLY SHORTER SILENCES -
Vioice Boost ;-'-li" ™
CLEAR, CONSISTENT VOLUME f'-‘-'\.,_ —

‘I Try Smart Speed

On a show's Now Playing screen, tap
the Waveform button to enable Smart
Speed and Voice Boost. Smart Speed
shortens silences for a better listening
experience. Voice Boost equalises all
speakers' voices to the same level.

Downloads

FAILED

The Greatest Scam Ever

& DOWNLOAD FAILED

S4E11: Who Do You Think -~
“ They Were? w y

& DOWNLOAD FAILED

»Image credits: Apple Inc, Overcast Radio LLC

Written | 4. The Swiss
Swindlers -

Settings

m Announcements

B Sync Profile
a Motifications

2 Change settings

On Overcast's home page, tap the
gear icon. Here, you can change forward
and rewind button strength or entirely

redesign the home screen. There are per-
show notifications and download options,

new themes to try, and more.

Nitpicky Details

Stop After Each Episode

Smart Resume "._;_L‘

Sort nitpicky details

In settings, tap Nitpicky Details for
in-depth customisation. There are extra
playback controls, options for which
episodes play next after your current
episode ends, plus gesture controls
for headphones and cars.

Managing downloads and more
Get new episodes and stash old ones »

Tap the downward arrow at the top of Overcast to see episode downloads. You'll
see any that have failed - you can delete them or retry the download here - and
gueue up episodes to download next. When you've finished an episode, tap its
name in the episode list, then tap the tick. This marks it as completed and hides
it from the Current tab for a cleaner view. You can still find the episode in the
All tab - tap its name, then tap the tick again to mark it as unlistened to and

move it back to the Current tab.
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Improve your
Sleep routine

Tackle the urge to use your iPhone in the
dead of night by building healthy sleep habits

IT WILL TAKE

»Many nights

YOU WILL LEARN
»>How to getintoa
reqgular sleep schedule
by gamifying your
night time routine

YOU'LL NEED

> SleepTown app
(£1.99), i0S/iPad0OS
1 or later

43

Y

Genius tip
>Regqister a free account
for maximum benefits
including a daily coin
rewards, a ticket for
seven successful days
and cloud backup

of your data.

4 3 7l

Change username

Change password

10: 20

07:00.-

‘Wake-up Time Goal

@ We've all been there. It's 3am,

your eyes have begun to open
" and your mind begins to whir.

M' Then your hand reaches out
from beneath the duvet, grabs your iPhone
and, an hour later, you're still awake having
spent an hour mindlessly scrolling with no
real chance of getting any more kip. 05:11 am
It's annoying and counterproductive yet
the problem could be resolved by installing
the SleepTown app. It lets you set healthy
sleep goals.a.nd routines by buHang a cutgsy ek v s i v 98 s
town containing more than 70 different kinds
of cartoony buildings while serving up
numerous surprises while you sleep. Touch
your iPhone during the night, however,
and constructions can turn to dust.
Aside from effectively turning your sleep
into a game, complete with holiday themes,
the app also doubles as a smarter alarm clock,
offers ambient sound during sleep and allows
you to store your data in Apple Health. You can
also export your data. Sleep well. David Crookes

HOW TO Set a sleep routine »

22 20

‘I Set a sleep time

When setting up SleepTown, you'll be asked
to indicate the time you'd like to go to bed. It's
not going to be set in stone. You'll be able to
change it later on the app’s home screen by
simply tapping Bedtime Goal.
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SETTINGS

Reset bedtime & wake up time goal

Strict Mode ;__,;
Bedtime reminder 15 mins
Alarm clock 06:10 am
Appearance Auto switch

Create a reminder

To use the app effectively, you may
want to set a bedtime reminder. Click OK
when prompted. Later, you can dive into the
app's settings to choose how many minutes’
warning you need prior to your bedtime.

» Image credits: Apple Inc, Seekrtech Co Ltd
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CONTINUED... Set a sleep routine »

Friday

Saturday v

Going to bed late on the day before your day off or
waking up late and causing your construction to fail on
your.day off won't break your consecutive days
progress.

[ Back | | Next |

Set a wake-up time

You also need to indicate when you want
to wake up. Again, you can alter this later by
tapping Wake-Up Time Goal on the app’s home
screen. You can take up to two days off,
allowing for later nights and lie-ins.

e

00 hr 22 min from bedtime goal

Get ready for bed

The idea is you hit the pillow before your
bedtime goal and stir before your wake-up
goal. When you're ready for bed, either tap
Sleep or leave the app open and it'll go into
sleep mode at your designated sleep time.

7 Check your reward

While you sleep, the app constructs a
building. You should be able to view it when
you wake. The building will have collapsed if
you slept in or used your iPhone and left the
SleepTown app during your sleep hours.

»Image credits: Apple Inc, Seekrtech Co Ltd

09:58 pm

07:00

Q Alarm On

Turn on the alarm

SleepTown wants you to stir before your
wake-up goal so it offers an alarm to prevent
you going over your time. Tap Alarm Off to
activate and it will sound if you haven't already
started using your iPhone that morning.

M

05:10 am

Wake up in 01 hrs 50 mins

Wake up

Keep the app open when you go to bed
but don't worry if the iPhone locks. Now resist
the temptation to use your iPhone. When you
stir, and assuming you're within two hours of
your wake-up time, tap the ‘Wake up’ button.

Keep going

The aim is to create a town full of
buildings. You'll earn coins along the way which
can be spent on unlocking new buildings and
there are many other rewards to be had for
enjoying consecutive days of successful sleep.

Strict Mode

Sedtime remindsr Hmins
Alarm clock 0810 am
Appearance Busto switch
Shaking challenge ot
24-hour time format

Sound Effect [ @

Jargon buster
> The app has a Strict
Mode which you can
access in its settings.
Turning it off means
leaving the app at night
won't cause buildings
to collapse.

43

Genius tip
>Having an account
also enables you to
form a circle with
friends and create
‘wonders’. Give the
circle a name, set goals
then invite members.

Plarra e pirce

Dave And The Sleep Monsters
Bedtime Gaal 10:30 P4
‘Wake-up Tima Goal B0 AM
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Master accessibility
on Apple Watch

Your Apple Watch is packed with
features to make everything easier

Accessibility

VoiceQver

IT WILL TAKE
»10 minutes

YOU WILL LEARN
> How your Apple
Watch can be
more accessible
YOU'LL NEED

> Apple Watch
Series 4 or later

One of the things we love about
i Apple devices is how accessible
you can make them, and your
Apple Watch is no exception:
Apple has put a lot of effort into making its
smallest device usable by as many people as
possible, including those of us with sight, hearing
or mobility issues. Whether you find it hard to
see certain colours, need a bit more time
adjusting your connected AirPods, or would like a
friendly voice to guide you through the on-screen
options, you'll find lots of really useful features
and settings under Settings > Accessibility.
In this tutorial, we're going to concentrate on
the specific features underneath the Accessibility

section, but there are other Apple Watch things
made with inclusivity in mind; for example, the
X-Large watch face was made for maximum
readability, and the Taptic Engine delivers
feedback you can feel.

Let's find out how you can make your Apple
Watch even more accessible. Carrie Marshall

Zoom

Grayscale

Bold Text

Reduce Motion

Reduce Transparency

On/Off Labels

Side Button Click Speed

HOW TO Improve Apple Watch accessibility »

L
@ Accessibility
& Siri

%1 Sounds & Haptics

‘I Swoop into Settings

All the accessibility features in your
Apple Watch are organised in the same
place, under Settings > Accessibility. You
can also access and adjust them from the
Watch app on your iPhone; there, you'll
find them under My Watch > Accessibility.
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£Loom

On/Off Labels

2 Start with sight

All of the features you need are
here, organised by categories ranging
from vision helpers to features for
wheelchair users. The vision features are
up top, and you can scroll through them
by swiping or by using the Digital Crown.

Hear, don't see

If you have low or poor vision, try
VoiceOver. Switch it on and tap what's on
screen to have Apple Watch tell you what
it is, whether it's a weather complication
or a system control. With the latter, it'll
also tell you what the control is set to.

» Image credit: Apple Inc



Accessibility on Watch APPLE SKILLS

CONTINUED... Improve Apple Watch accessibility »

Colour Filters '

Greyscale

Red/Green Filter

Go faster or slower

If VoiceOver is too fast or slow,
adjust the speed with this slider - more
tortoise makes it slower; the hare makes
it faster. The difference between the
fastest and slowest rates is dramatic so
there's lots of room to get it just right.

Bold Text

Reduce Motion

Get rid of the motion

Some people find animated
interface elements difficult to process,
and that's why you'll find a Reduce
Motion toggle just underneath the text
options here. This also makes Grid View
icons the same size for easier viewing.

> Forwards
<€ Backwards

W Tap

‘I Transform your taps

You don't have to stick with the
default controls. You can change what
each gesture does by selecting it, then
choosing what function it should serve.
For example, you can change a Double
Tap to do a Digital Crown activity.

»Image credit: Apple Inc

5 Make it bigger

The Apple Watch's screen can be
hard to read sometimes, but the zoom
option solves that; once you've turned it
on, double-tap with two fingers to zoom
in or drag with two fingers to pan. You
can use the Digital Crown if you prefer.

Use Assistive Touch

If you have difficulty touching the
screen or pressing the buttons, Assistive
Touch uses built-in sensors to carry out
key tasks such as answering calls,
controlling an on-screen pointer and
launching an action menu.

15:57

Touch
Accommodations a

Hold Duration .

‘I‘I Get more touchy

Under Touch Accommodations, you
can change how the touchscreen works
to assist with mobility issues. You can get
it to ignore multiple taps, wait before
recognising a tap, and choose to use the
start or end location of a touch as input.

Filter the colours

If you find it hard to see certain
colours, you can use the Colour Filters
option to change the display colours
to make them easier to read. You can
choose between greyscale and a red/
green filter.

Hand Gestures 0

Tap

Double Tap

Get gesture controls

Gesture controls are so useful that
Apple made one of them, bringing two
fingers together to tap, part of the main
Watch interface. By enabling this feature,
you can use a variety of gestures to
control your Apple Watch.

Default

Slowest

‘I Accessible accessories

You can also adjust the settings of
your AirPods, AirPods Pro or AirPods
Max by adjusting the sensitivity of their
touch controls, for example by slowing
down the amount of time they require
for a touch or swipe.
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Ray tracing can create
highly realistic lighting
effects, including reflections
and shadows in games.

Mesh shaders & ray tracing

The key technologies for the future of games on Apple devices

YOU WILL LEARN

> About mesh shaders
and ray tracing, and
their use in games and
computer graphics

Key fact

> Most PCs designed for
playing games have a
main computer chip,
known as the CPU
(central processing unit),
and a separate graphics
card or GPU (graphics
processing unit) that
handles demanding
graphics work. In
contrast, Apple’s
M-series of processors
use a design known as
SoC - System on a Chip
- that combines multiple
CPU and GPU cores in

a single piece of silicon.

pple’s recent investment in gaming
has surprised many people,

including old timers like yours
truly who have been disappointed by Apple's
historic lack of interest in games. Cynics
might suggest that this sudden enthusiasm for
gaming has arrived just as Apple is looking for
ways to boost sales of its expensive Vision Pro
headset, but whatever the reason we should
probably just make the most of it and hope
that we can look forward to seeing more
triple-A games arriving on the Mac at last.

In fact, it's partly due to the success of
games on the iPhone - and later the iPad -
that the Mac is finally starting to play catch-up
here. When the mobile gaming scene took off
around a decade ago, Apple was forced to
develop more powerful processors that could
handle demanding 3D graphics so that the

You can see how well your Apple devices handle ray
tracing using the 3DMark app for Mac and i0S.
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iPhone and iPad could compete with Android
smartphones and tablets in that rapidly
growing - and very lucrative - market. And
when Apple announced in 2020 that the Mac
would ditch Intel processors and switch to
homegrown Apple silicon, it was able to use
that experience with the iPhone and iPad to
produce the new M-series of chips, which
combine both CPU cores (central processing
unit) and GPU cores (graphical processing
unit) within a single chip. The result was vastly
improved graphical performance for the Mac,
which took another step forward last year
when the M3 processor introduced support
for two important new graphics technologies.

Ray of light

Ray tracing is a technigue that simulates the
realistic appearance of light and shadows,
both in computer games and in computer-
generated imagery (CGl) effects in Hollywood
movies. It's been used in computer games for
a few years now, but it was only introduced
to the Mac with the arrival of Apple's M3
processor in 2023 (and the A17 Pro chip

used in the iPhone 15 Pro and Max).

As the name suggests, ray tracing
calculates the path of rays of light as they
move around within a 3D scene, following the
light as it is reflected off various surfaces, or
creating shadows if the light is blocked by an
object. This can create amazingly realistic and
dramatic effects, especially in creepy games
like Alan Wake 2 (only available on PC,

»Image credits: Electronic Arts Inc, UL LLC



Metal guru

Apple's M3 and M4 processors both
support ray tracing and mesh shading,
but that doesn't mean that games
written for Windows PCs will
automatically be able to run on the
Mac. The graphics cardina PC, or an
M3/M4 processor in a Mac, still needs

to be controlled by the software that is
running on your computer. On a PC, this
is generally a piece of software called
DirectX, which is part of the Windows
operating system, while the macOS
includes similar graphics software called
Metal. Developers therefore have to find

unfortunately), where the hero wanders
around in the dark using a ray-traced torch
to scatter light and shadow all around. It's

a very demanding technique, though, so the
graphics gurus at Nvidia - who make some
of the most powerful graphics cards for
Windows PCs - introduced an entirely new
range of graphics cards, called RTX, in 2018
to encourage the adoption of this new
technology. Clearly, Apple is still playing
catch-up here, as ray tracing is now widely
used in PC games, but the fact that all future
Macs will be able to handle ray tracing -
without the need to buy a big, expensive

graphics card - is good news for Mac gamers.

Making a mesh

The other leading-edge graphics technology
introduced to the Mac with the M3 is called
‘mesh shaders’, or ‘'mesh shading’. This is a
spectacularly complex technology, full of
jargon and techno-babble, but the bottom
line is that mesh shaders provide a more
efficient method of creating 3D graphics
that display wide open spaces with lots of

different objects moving around within them.

Early computer games like Doom kept
things simple by mostly taking place within
enclosed spaces - lots of narrow corridors,
and a bunch of monsters conveniently lined
up in front of you so that you could mow
them all down with your rocket launcher.
Modern games are much more complex and

Supporting technologies such as
ray tracing and mesh shading

IS an important first step

»Image credits: Microsoft/Blizzard Entertainment Inc, NVIDIA Corp

Computer graphics APPLE SKILLS

a way of converting their games that
were written for DirectX and Windows
so that they can run on the macOS using
Metal to control all those fancy graphics.
At last year's Worldwide Developers
Conference (WWDC), Apple launched its
Game Porting Toolkit (GPT), which was
designed specifically to help developers
with that process (known as ‘porting’).
The recently updated GPT 2.0 includes
features that focus on ray tracing and
mesh shaders so developers can ‘port’
their latest games on to the Mac without
the long delays we've seen in the past.

Apple's Game Porting Toolkit helps developers
to ‘port’ games with state-of-the-art graphics
so that they run on the Mac.

broader in scope - the
narrow corridors have gone,
and we've stepped out into
wide open worlds with rolling
landscapes, trees and grass
wafting in the breeze (and the
occasional dragon flying
overhead). And, of course, there
are monsters and bad guys all
over the place, each with their own
appearance, costumes and weapons, adding
even more to the complexity of the scene.
That graphical complexity puts a real
strain on even the most powerful graphics
cards, and mesh shading is still relatively rare
even in the latest games for Windows PCs. It
was first demonstrated by Nvidia in 2018, but
it was only in 2021 that mesh shading was
used in a Chinese PC game called Justice,
and it didn't really make a splash in the
Western games industry until Alan Wake 2
in 2023. Even now, mesh shading is still
something of a rarity in PC games, and
we're not currently aware of any games
that use the technology on Macs right now.
So Apple still has some work to do in
order to convince developers that they
should spend the time and money required
to bring their PC games to the Mac. However,
supporting technologies such as ray tracing
and mesh shading is an important first step
as it proves that Macs really can handle the
latest games with the most demanding 3D
graphics. And, with new tools like
Apple's Game Porting Toolkit also
available, let's hope that games
developers start to take the Mac
seriously at last. Cliff Joseph

Windows PCs need an expensive
graphics card to handle ray
tracing and mesh shaders, but
these technologies are built into
Apple's M3 and M4 chips.

Key fact

> Ray tracing and mesh
shaders only arrived on
the Mac with Apple's M3
processor. However,
many games do allow
you to turn ray tracing
off, so that you can still
play the game on older
Macs or PCs that doesn’t
support it. Mesh shaders
are more complex,
though, and games like
Alan Wake 2 will only run
on PCs with graphics
cards that specifically
support that technology.
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Sequoia
for the
notarised

evelopers were
asked to notarise
their apps six

years ago, so they'd be
more secure when
distributed outside the
App Store. Until macOS
Sequoia there was no
pressure for them to do so,
as you can always launch a
new app that isn't notarised
using the Finder's Open
command.

Sequoia changes that:
any app downloaded from
outside the App Store that
isn't notarised now requires
a trip to System > Privacy &
Security to authorise it
individually. This only applies
to apps you've downloaded
ready-built; any you build
yourself can still be signed
locally, although moving
them via AirDrop puts them
into quarantine the same as
if they'd been downloaded.

What might seem
another added nuisance
brings better protection
against malware, as macOS
checks notarised apps more
robustly before they're run.

EXPERT
ADVICE

Our resident genius
solves your Mac and
iOS problems

Contact us

—

Email your queries and
your questions to
genius@macformat.com

Restore archives to a new drive

The old USB hard drive with my

archives on it is failing. How can

I recover the contents of its last
backup to a new disk when the Time Machine
app is playing up?
by GEOFF MOORE

Some prefer the Time Machine app’'s
whizzy interface, but when you need
to restore large backups to a different
location it's too inflexible and can disappoint.
You're better off using the Finder, if necessary
copying from your backup in stages.
Format the new drive ready to store your
archives. Browse the backups on their storage
in the Finder, and locate the most recent, from

i Date

8-28-191151
2024-08-30-145000

which to restore the files. In older backups
on HFS+ volumes, and their new-style
replacements on APFS, backup names
include the date stamp of creation.

Inside that you'll find a complete image
of your original archive volume, ready to drag
and drop its contents straight into their place
on your new drive. Try this first with each of its
top-level folders. If any of those stutter or fail,
drop down a level to smaller folders within
those. Although this takes time and a bit more
effort, it should result in a complete restore
without error. The only worrying sign is if your
Mac has a kernel panic while restoring, as
that's a likely indication of a hardware
problem with one of the drives.

Restoring from a Time Machine backup is most flexible in the Finder, as you can copy to a different volume.
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Image credit: Apple Inc
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10S software

s Swipe away your touchscreen troubles and

S J rekindle your love of Apple's mobile devices

Quick-Hfire
questions

Both meet the same
standard of IP68, for
resistance to ingress of
water when immersed
six metres deep in water
for 30 minutes, soin
practice there's little or
no difference. As the
Lightning port is slightly
thinner, it may prove less
likely to accumulate dust
or debris inside it.

As both wired and
MagSafe charging can
be performed using a
20W power adaptor,
they should be similar

in speed. However,
MagSafe isn't quite as a
efficient, and will only
reach15W at most on
older iPhones. MagSafe
on iPhone 16 can charge
faster, with up to 25W of
charging possible.

Image credit: Apple Inc, Belkin

How long will my
pattery last?

How long should | expect my
iPhone's battery to last before
it needs to be replaced?

by PHIL JUKES

The lifespan of a Lithium-ion

battery is normally measured

in charge cycles, where each
full cycle represents discharge of 100%
of the battery capacity and a full
recharge. If your iPhone normally
discharges to about 50% over two days
use, and you then recharge it to 100%,
it completes a charge cycle every four
days. Apple expects iPhone 14 and
earlier models to be able to complete
500 charge cycles and still retain at
least 80% of their original capacity.
For iPhone 15 and later (and all iPad,
Apple Watch and Mac notebook models),
that should extend to 1,000 cycles.

Newer iPhones display their current
Cycle Count in Settings > Battery >
Battery Health. Keep a monthly record
of that to estimate how many years
it will take for your iPhone's charge
cycles to reach 500 or 1,000, when it's
likely to need battery replacement. With
four-day cycles, that should take five or
ten years, by which time you'll probably
want to upgrade your iPhone anyway.
Being kinder to the battery by

avoiding leaving it charged above
80% for too long can usefully extend its
lifespan, but reducing its rate of discharge
is probably the more important. Settings >
Battery shows which apps and activities draw
most power, and limiting the worst offenders
there should extend the time it takes to

< Battery

Battery Health

Battery Health

About Battery

Maximum Capacity

Cycle Count

ipacity. Learn more...

Manufacture Date

First Use

Recent iPhones may display charge cycle count
in Settings > Battery, or you can keep a manual
record of charge levels.

complete each charge cycle, so extending
the battery lifespan significantly. The trade-
off, though, is how important those power-
hungry apps are to you.
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o S

Quick-Hfire
questions

This display runs a
stripped-down, modified
version of iOS that's
updated infrequently
using Software Update.
Ensure it's connected

to a Mac with its
Thunderbolt 3 cable,
start the update in those
settings and follow the
instructions. Don't
disconnect the display
until the update has
fully completed.

This feature detects
when you connect a new
peripheral, other than a
charger, to your Apple
silicon Mac, and checks
with you whether it's
safe to allow it. This can
prevent malicious attack
using specially crafted
devices. However, it's
only available on Apple
silicon notebook models,
and not on desktop
Macs like the Mac mini.

[ Remete Duskion

Thinking inside the box to refresh
the parts other tips can't reach

Keep your SSD in Trim

Should | buy an external SSD with
SATA or NVMe for use with my
© M2 MacBook Pro?
by KEITH MULLINS

An SSD's internal and external

interfaces determine its three key

features of speed, Trim and SMART
health indicator support. A SATA internal
interface is slowest of all, unlikely to deliver
more than about 500MB/sec read or write
speeds, with no inherent support for Trim
or SMART indicators. An NVMe interface
should be able to reach the physical limit
of 1,000MB/sec over a USB 3.2 Gen 2
connection, has Trim support, but not
SMART unless it's connected by Thunderbolt,
or by USB 4 to an Apple silicon Mac.

Trimming is an important feature that

ensures storage blocks in the SSD that are

WRITE

no longer required by the file system are
reported to the SSD's firmware so they can be
marked as unused. They can then be erased
and returned ready to use again. If Trimming
isn't performed as usual by APFS when it
mounts the volumes on that SSD, those
storage blocks should normally be reclaimed
during the SSD's routine housekeeping, but
that may be delayed or unreliable. If those
blocks aren't released, write speed falls
noticeably, and in the worst case blocks need
to be erased immediately before writing.
Although it might be possible to use
the trimforce command to enable Trim for
external SSDs, NVMe SSDs should avoid this
completely, and get trimmed when they're
mounted by APFS (or HFS+). With their better
speed, they should always be preferred over
SATA, particularly when used with a fast
Apple silicon Mac.

The uppermost dials show NVMe at >900MB/sec; those below are from a SATA drive needing Trimming at <300MB/sec.
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Set Up Biuetooth Trackpad... 7

If your trackpad loses Force click, go to System Settings > Trackpad and toggle the controls there, in case they restore it.

A clickless Magic Trackpad

My six year-old Magic Trackpad 2
has lost its Force click and won't
last more than a couple of days
without recharging. Does it need a
replacement battery?
by HARRY OFFORD

Force click is a distinctive haptic

effect generated by software,

although it requires the upper surface
of the trackpad to be able to move downwards
towards its base. This can be obstructed
mechanically by grit in the fine groove running
around the side of the trackpad, and you can

»Image credits: Apple Inc, eclecticlight.co

clean that out using the edge of a sheet
of paper. If you haven't done so already,
it's worth toggling the controls in Trackpad
settings, which could turn Force click back on.
More commonly it results from the
rechargeable battery inside becoming
swollen with age, and that's implied by a
short interval between recharging. As yours
is now six years old, that's the most likely
cause. Although you can, with care, dismantle
a trackpad, genuine replacement batteries
appear to be unavailable. The best solution
is to replace it with a new one, and send the
old trackpad for recycling.

ene TaM2_2024-08-30_15_22_21

Check thefast | 4813 hours  Check Time Mechine S
List all errees Check scheduling

¥ Thinning 2 backups using age-based thinning, expected fres space: 1.6 TB actusl free space: 1.6 T trigger 5@ ¢@
thin §3.33 GB detes: |
el

1
Created & new snapshers, and deletad 7 old snapshats.

OF & volume backups:
@ wers full first backups,
& were doep scans,
4 used FSEvents,
# usad snapshat diffs,
8 usad consistancy scans,
& used cached events.

Backup Tesults:
Finished copying from volume “Data®
8113 Total Items Added (1: 719.5 MB p: 778.7 ME)
8677 Total Ttoms Propagated {shallow! (1: Zaro XB p: Zero XEl

798951 Total Ttems Propagated {recursivel [1: 143.7 GB p: 158.5 GBI

Speed Brawse log

Can a MacBook Pro
M3 14-inch drive two
displays?

> A MacBook Pro 14-inch
model with a basic M3
chip can support two

5K resolution external
displays over USB-C

or Thunderbolt 3 if it's
running macOS Sonoma
14.6 or later. However, the
second display only works
when the lid is closed, in
clamshell mode.

Should | use
Thunderbolt 3
or 4 cables?
> Although you can use
either for USB 4 and
Thunderbolt peripherals,
Thunderbolt 4 should
be preferred because
E o it supports full
_ | speed data
} transfer over
lengths of up to
two metres, and
works best with
USB 4 as well.

Back up now.
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GENIUS TIPS macOS

- mMacOs:

\ Shine a spotlight on the solutions to
'- Jyour most irritating Mac problems

Quick-fire
questions

Disk Utility

—

Running First Ald on “Container disk8”
gf First Ald process is completa: Click Dong 10 continus,
Hide Datails
Checking the sbiect map,
Chacking volume fdevrdiskBst.
Checking the APFS volume suparbiock,
Thies violisme SamsungEE0pns:
and last madified by spfs_ke
Checking the sbject map.
Ehacking the snapshet metadata tree.
Checking the snapshot metadats,
Chacking the fssaat tras
Checking the extent ref tras. e
Veritying volume stject map space.
The volume [dewrdisk8s] with ULID DDEE3BAT-F262-46D6-BEGE iaks
DBI08109HB0G Appears to be DK
Verifying alioaated space,
The containes [devdiskdsZ appears 1o be OK.
Starage system cheek exlt codu s 0.

For most Intel models,
firmware updates are
provided for a period of
8-10 years after its
release, althoughina
few cases that has been
shorter. It may change
in those models with T2

matted by etoragekitd (2236.901.7)

APFS Containm

dinkd=2

chips, as they all use the
same firmware, as do all
Apple silicon Macs.

In the days of System
Preferences, the Users
& Groups pane offered

advanced options to
change a user's UUID.
Apple has now removed
that feature, as
changing it is almost
certain to cause
complete chaos. If
you know what you're
doing, you can still
use Directory Utility
to change almost
anything about a user.

Operation succossful.

Disk Utility’s First Aid reports APFS version numbers so you can identify any disparity that might lead to problems.

Mix multiple APFS versions safely

- My Mac normally starts up in
Sonoma on an external SSD, but has
Mojave installed on its internal drive.
Why | do see warnings about the external
drive being incompatible? Would reformatting
and reinstalling them help?
by KEVIN OLSON

These arise because those two
versions of macOS use very different
versions of the APFS file system.
Although that supplied with Sonoma (APFS
2235 and 2236) understands the version in
Mojave (APFS 945), the reverse isn't true, as
Mojave can't understand the boot volume
group and Signed System Volume in Sonoma.
So every time you start your Mac up from
its internal drive, if the external SSD is
connected, you can expect it to warn
you that it's incompatible.
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Those are only warning messages,
but there is the potential for disaster here,
something you've got to be careful to avoid:
running Disk Utility's First Aid or its command
tool equivalent fsck_apfs from Mojave on
your Sonoma disk. Although First Aid will
inform you of the conflicting APFS versions, if
it were to attempt to make a repair, it could
cause damage to the newer file system.

One way to work around this is to eject
and disconnect your external SSD when your
Mac is running Mojave. It gets more difficult,
though, if you need to perform a repair in
recovery mode, when you must be diligent
to ensure it's booted from the correct version
before using Disk Utility.

Provided that you're aware and careful,
though, there's no reason that the two
different versions of APFS can't run
alongside one another.

Image credit: Apple Inc
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Why are macOS
updates so large on
Apple silicon?

> The size of macOS
updates has fallen
steadily from Big Sur,
and in Sonoma the
minimum was about

400MB for Intel Macs,
and 820MB for Apple
silicon. That largely
reflects the size of
their firmware and the
software required
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Mose.,,

When you first run a notarised app downloaded | SESEE—-——— n ) ) to update it.
from outside the App Store, you'll be informed | With Apparency installed, app thumbnails
it has been checked by Apple. show a summary of signature and

notarisation status. Does macOS

support FAT32

Has that app been notarised? partitions of 2787

> Yes, it always has done.

How can | tell whether an app giving permission in Privacy & Security This restriction only
has been properly notarised? settings. It's more difficult to discover once an existed in Windows,
by MIKE ROBERTSON app has gone through that process, and the where size was
best way is then to inspect it using the free arbitrarily limited to
If you've just downloaded it, double- app Apparency from bit.ly/mac410apparency. 32GB by Microsoft.
A click to launch it. If it's notarised, Once installed, select the app’siconina You may find exFAT
you'll then see the standard dialog Finder window, and its Quick Look thumbnail better as it can store
informing you it has been checked for tells you whether it's sandboxed, hardened, files greater than 4GB
malware. Sequoia is more awkward, and only notarised, and offers to open it using the in size, unlike FAT32.
lets you run apps that haven't been notarised Apparency app, where you can see full details
or delivered through the App Store after including its entitlements and more.
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iPadOS 18§

tips, tricks & secrets

iPadOS 18 makes your iPad smarter, smoother
and even more you. Here’s what’s new

written by Carrie Marshall

hought iPadOS 17 was
pretty great? Then
you're going to love what
happens next. iPadOS 18
takes the power and personalisation of
iPadOS 17 much further, enabling you
to make your iPad truly yours - and if
your iPad could handle iPadOS 17 then
it'll work with iPadOS 18 too.
iPadOS 18 comes with a host of new
features that will turbo-charge your
texting, power up your photos, make
your gaming experiences even more

Which
devices will

work with
iPadOS 18?

iPad Pro (all models)

iPad Air (3rd generation or later)
iPad (7th generation or later)
iPad mini (5th generation or later)
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awesome and make your smart home
more helpful. Again and again you'll
discover - in ways big and small - that
iPadOS 18 takes everything you like
about using your iPad and makes it
even better.

There are actually two iPadOSes.
The initial iPadOS 18 release in
September 2024 didn't include Apple
Intelligence, which is coming to the UK
in December as a work-in-progress beta
in iPadOS 18.2. Unfortunately, if you're in
the EU you'll need to wait a little longer.

Apple Intelligence is Apple's take
on artificial intelligence and it makes
Siri smarter, adds cool new tools and
makes iPadOS even more fun. You'll
be able to get Apple Intelligence to
summarise Messages and Mail, to
create illustrations and even help
your writing in apps such as Pages.

In this tutorial, we'll focus on
the finished features in iPadOS 18:
the useful improvements, the really
handy new features, the more powerful
personalisation and the improved
accessibility. Let's discover what
iPadOS 18 can do for you.

5:0‘! Thu 19 Sep
=

iPad0S 18 brings new ways to
customise the Home Screen
and Control Centre.

»Image credit: Apple Inc
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Finish photo editing
Get frames for exhibition
Buy Orkun's birthday gift

Plan dinner party
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The smart stuff

iPadOS 18 is the cleverest, most customisable iPadOS yet

pple Intelligence is Apple's take
A on the artificial intelligence (Al)

advances that are currently
dominating the tech world. When it arrives
it will deliver impressive new features: writing
tools in Pages, summarisation tools in Mail,
image creation in Messages, and a much
smarter Siri that's more knowledgeable and
capable of handling more kinds of requests.

Apple Intelligence isn't the same thing as
ChatGPT, although access to that is also coming
to iPadOS 18. Apple is clearly wary of giving
people unfettered access to the full generative
Al features that have led to faked photos and all
kinds of copyright infringement. So, for example,
the picture generation in the forthcoming Image
Playground app won't let you generate anything
dodgy. However, you will be able to use ChatGPT
to create and illustrate on your behalf, for
example by helping you write a letter or
story or illustrating an idea.

Scheduled for release with iPad0S 18.2, in
December 2024, Apple Intelligence won't work
on iPads with Apple's A-series processors. The
hefty hardware demands of Apple Intelligence
require an M1, M2, M3 or M4 processor.

While we wait for Apple Intelligence-
enhanced Siri, there are still plenty of
customisation options on offer. One of the most

HOW TO Personalise the Control Centre >

Apple Intelligence’s smart summaries, image generation
and other useful features are coming in iPad0S 18.2.

useful ones for shared iPads is the ability to lock
and/or hide apps. The former means they can't
be opened without Face ID or Touch ID, and the
latter hides them from your Home Screen, from
search results and from your notifications.

Controls and customisation

The Control Centre has had a massive upgrade
that will be particularly welcome if you have a lot
of HomeKit devices, and it's more customisable.
The Home Screen now enables you to organise
your apps and widgets with more flexibility,
including the ability to leave free space
wherever you want it, and you can add

coloured tints to your app icons too.

@

Control Centre

> You can reorganise the
Control Centre layout,
remove controls or drag
new controls across
from the Gallery. Icons
and widgets work just
like Home Screen ones.

More pages

> You can now have
more than one Control
Centre page, so you can
customise the controls
for the media playback
page, the smart home
page, or your own
custom page.

&

Available controls
> When you tap on ‘Add
a Control’, you now
have a cornucopia of
controls to choose from,
including app launchers
and hardware controls.

Customisable
controls

»Some icons are widgets
that you can customise.
So, for example, we can
get this widget to control
a particular room or
smart home device.

1 Bring it down

Bring down the Control Centre by
swiping down from the top right of the
screen. In iPadOS 18, this whole section
is customisable; simply press and hold
on any empty bit of it or tap the ‘+'in its
top-left corner to go into editing mode.
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Move it around

Rearranging the layout works just
like it does with your Home Screen icons;
tap and drag to move icons around and
the other controls will move out of the
way. You can exit this mode by tapping
at the top or bottom of the screen.

3 Make it bigger
One handy new feature appears as a
curve in the bottom-right corner of some
controls, allowing you to make it bigger
or smaller by dragging it. Options depend
on the particular control but most offer
one, two, or four icon options.

»Image credit: Apple Inc



EXPLAINED... Controls gallery >

4 Add more options

Tap ‘Add a Control and you can add
new controls to any of the Control Centre
pages by dragging them from the Gallery
over the appropriate part of Control
Centre. You can also resize controls,
such as the music player control.

»Image credit: Apple Inc

Scene or ACCessary

Home

Tidy your home

We like the option for one or more
smart home control screens - the Home
controls in the previous Control Centre
design felt a little cluttered. The redesign
means you can get a much clearer and
set-up for your smart stuff.

Customise it more

The final Control Centre page is
a blank slate for you to add whatever
controls you wish. Apple has opened up
Control Centre to third-party apps too
- so you'll be able to add controls for
other apps, not just Apple ones.
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Everyday essentials

Useful upgrades that make every day easier

ome of our favourite new
S features in iPadOS 18 aren't

necessarily headline-grabbing
ones - but they're improvements that
make every day better.

For example, with iPadOS 18, Apple
has finally brought the Calendar and
Reminders apps together, turning them
into a powerful productivity tool whether
you're herding kids or managing
projects. Being able to see your day

Smarter sums>

The Calculator app
g introduces a new

feature called Maths
Notes, and it's at its best on
iPad. That's because it enables
you to use the Apple Pencil. Simply
draw your equation on screen and
your iPad will solve it, whether
that's a simple sum or something
considerably more complex. The
same feature is also available via
the Notes app. Calculator now also
does unit conversions for weight,
distance and volume.

Like magic: write sums with your finger or
Apple Pencil and Calculator completes them.

Easier reading>

and to-dos in a single app rather than
needing two is a big time-saver.

Notes is hugely improved too. You
can now add a voice memo to your notes
and get your iPad to transcribe it and
turn it into editable text, and the
improved handwriting support can
transcribe your handwritten text just
as easily. There are new formatting
features with new highlight colours and
more importantly, collapsible lists. That
makes it much easier to organise lots
of different things without making
it intimidating, and in conjunction with
the existing tagging and linking in Notes
the new features make it an even more
useful app for organising everything.

Visual improvements

If you're more of a visual person, the
Freeform app has been updated with
improved diagramming tools and a new
feature called Scenes that enables you
to add shortcuts to specific sections,
which is really useful for shared boards

tery iPhone 16 model
if RAM inside - matchi

vand Pro Max

The redesigned Safari makes it a lot easier to access
key features and to enable or turn off extensions.

More
messaging >

The Messages app in

' | iPadOS 18 supports
w RCS messaging via
your iPhone, which means better
communication with Android
users. RCS is the successor to the
SMS we've long used for texting,
and it adds key features including
read receipts, file attachments,
photo messaging without extra
costs, better emoji responses...
There are also new Text Effects
which you can access with a tap
and hold in your message.

B I u 5
Bi g Small
Shake Ned

Ripple
Eloom Jitter
?ha!'s greala

New text effects in Messages enable you to
add a bit of pizzazz to even the plainest text.

where you've got lots of things
to organise or communicate.

Another big visual upgrade is
in Messages, which has added new
text effects and animations as well
as support for the RCS (Rich
Communication Services) messaging
standard to make plain texts (green
bubbles) behave more like iMessages
(blue bubbles). There's a new Send Later
feature for scheduling your messages
- useful for those late-night ideas you
don't want to wake friends or colleagues
up with - and Mail gets Gmail-style tabs
to sort messages by category, such as
shopping, promotions and the most
important messages. Apple Intelligence

\ Safari in iPadOS 18 makes the
=] web better! Thanks to Apple
Intelligence, the Highlights feature

best feature is Distraction Control, which
can remove elements of web pages. It's not
an ad blocker - you'll need Safari extensions
for those - and it can't get rid of parts of
pages that constantly change. But you can
use it to block cookie banners, ‘'subscribe to o
our newsletter’ messages and many other
things that get in the way.

Macintosh 126K

will help you quickly find and jump to key
info, such as a shop or venue's opening
hours, and the revised Reader makes it
easier to find specific parts of an article
via a table of contents. But perhaps the

Distraction Control enables you to
remove annoying bits of web pages.
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Reader, as well as Distraction

Control and a Highlights feature.

promises to automate that when it's the ... at the bottom you'll get access is useful if your iPad is shared with
added to iPadOsS, and it will also be able to the full toolkit, which now includes | younger family members.
to automatically create automatic options that were previously tucked Last but not least, Apple has finally
summaries and replies. away in Safari's Share menu. Reader delivered on its promise that it would
You'll notice that Safari looks a little has been redesigned to make it clearer bring Calculator to the iPad - it's only
different. The address bar has been and there are new features to reduce taken 14 years. But the new app is very
redesigned to provide faster access to on-screen clutter and highlight key info. smart and makes particularly good use
the most commonly used tools such as And Safari is one of the apps you can of the Apple Pencil with its new Maths
Reader and Translate, and if you tap on lock behind Face ID or Touch ID, which Notes feature (see below).

HOW TO Get nicer Notes >

All iCloud What's new in iPadOS 18 Notes Rename 7

P"":= b o Add Transcript to Note =
* i  Copy Transcript &
wo:ar.mhwtem Find in Transcript &
s Save Audia to Flles B
RTONY ST ,;! e FRANETR RS share audio ()
i ! s >
Set structures 2 Use your voice 3 See what you said
The new collapsible sections are Tap on the paperclip icon and you Once recorded, you'll see a preview
subtle but superb. Just organise your can add a voice note to your current in the note, including the first few words.
notes using the formatting tools to create note. You can also get your iPad to Tap on it to see the whole transcript.
headings, subtitles and so on, and those automatically transcribe your voice Tapping on a word plays the audio from
subtitles then get a little drop-down note - just tap on the speech icon, the that point onwards; the usual copy text,
arrow to show or hide them. first of the two icons at the top right. look-up and share tools work here.
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Everything else

iPadOS isn’t just more customisable...

longside the app upgrades,
you'll find two important
security improvements: the

new Passwords app and the ability to
lock apps behind Touch ID and Face ID.
That latter is useful for shared iPads in
particular; you can use it to keep the kids
from ordering in your shopping apps.

One-stop Passwords app
Before iPadOS 18 Apple's password and
login management was getting pretty
messy. It also differed from mobile to
Mac, so for example website passwords
had their own spot in the iPadOS

Settings app but lived in
Safari's settings on Mac.

Now there's the one app for
everything - and it's not just
for passwords but for Wi-Fi
logins, temporary verification
codes and for passkeys, an
alternative to passwords that
use your face or finger as
your login. You can also use
the app to share passwords or
passkeys, for example if you're giving
a group access to a shared building.

As before, you can save time by using

AutoFill to automatically fill in website

Require Face 1D for
“Amazon"?
This app will reguire Facs 10 or your
passcode to open or show content in
‘other Dps. AR cantant will not

appaar in notification previews or
Spatlight

Require Face ID

Hide and Require Face 1D

Cancel

Press and hold on an app icon to choose to require Face ID or Touch
ID to openiit. You can also hide the app from your Home Screen.

and app passwords, and you should
check the Security section frequently
to make sure you're not re-using
passwords or using passwords that
have been leaked.

Take your pics>

“a4 | The Photos app has had
g ‘ the biggest redesign in
/ its entire history and
now organises your library not
just by date and album but by
topics such as Recent Days, and
People & Pets. You can also pin
collections for quick access to your
favourites. One of our favourite
features is the new Wallpapers
section, which scans your Photos
library for suitably scenic shots
that it thinks would make great
wallpapers for your Home Screen
or Lock Screen.

Photos has been extensively designed with much
more customisation and better organisation features.
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Some Maps features aren't available in the UK

yet, but improvements include multi-stop routes.

Make your
Maps >

i.\‘h One of the biggest

. improvements to Maps
50 in recent years was
the addition of ultra-detailed
topographic maps for walkers and
hikers. That feature came to the
Apple Watch last year and it's now
coming to the Maps app on other
devices too, with one important
caveat: for now it's only coming to
US and Japanese users. However,
the new Custom Routes feature

is coming to everybody everywhere.

It enables you to plan your trips in
advance with multiple points to
travel to, and you can then save it
for later and/or share it with others.

You've got
game>

iPads, and recent iPads
particularly, are very powerful
gaming devices. Apple's taking
that further with iPadOS 18, which
introduces a new Game Mode. That
does two important things. First of
all, it cracks down on any apps that
are running in the background that
might reduce the smoothness and
speed of your game. And it also
reduces latency, the slight delay
that affects wireless devices such as
Bluetooth controllers and AirPods.
Game Mode fixes that to keep your
sound in sync and your controller
responses smooth.

! Brawl Stars

@ Game Mode

When game mode is ckground activity is
reduced to optimise rformance of this game.

Game Mode detects when you're playing a game and
reduces background activities for smoother gaming.

»Image credit: Apple Inc
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 Carrie Marshall
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ﬂm Family

Airplane Mode

Wi-Fi
B Blustooth

< Back

Eye Tracking

Eye Tracking

Snap to ltem

Zoom on Keyboard Keys

Accessibility improvements >

iPadOS 18's Eye Tracking

uses the front-facing

camera to watch your eye
movements and activate elements
that your eyes pause on, enabling
you to replicate physical button
taps, swipes and other gestures.

Shake for Siri >

m, | Game Mode isn't the only
: ; | new feature that Apple is
4w pringing to your AirPods.
iPadOS 18 also introduces hands-
free Siri interactions for the AirPods
Pro 2 and AirPods 4, which enable
you to simply nod or shake your
head to accept or refuse incoming
calls or reject notifications whenit's
not a good time for you to speak.
AirPods Pro 2 also get better
voice isolation in calls and in in-game
chats, and Personalised Spatial
Audio now works in games as well as
in music, in TV shows and in movies.

Lt

CazPods Pro

Personafied Spatial Audio

New gesture controls for AirPods Pro 2 and AirPods 4
mean you can reject calls with a shake of your head.

»Image credit: Apple Inc

There's also a new Vocal Shortcuts

feature, which enables you to record

custom voice shortcuts, and ‘Listen for

Atypical Speech’, which is designed to
assist people who have progressive
conditions that affect their speech.
That latter feature uses on-device

iSight can tell you who's on screen and what
other Apple TV+ shows and movies you can
see them appear in.

Get iSight on
Apple TV >

The new inSight feature
in Apple's updated TV

app, exclusive to Apple
TV+ subscribers, adds a fun new
feature to TV and movie browsing,
albeit only for Apple Originals.

It enables you to find out more
about the actors on-screen, and to
bring up information about the
soundtrack so that you can add the
tracks to your Apple Music playlists.

The TV app also gets smarter
subtitling, more speaker
compatibility for Enhance Dialogue
- which was previously only for
2nd-generation HomePods - and
support for 21:9 projectors.

' The new eye tracking features enable yJu tc-)ﬁ
- control your iPad by moving and resting your eyes.

machine learning to learn your
specific speech patterns in order

to understand you more accurately.
And if you sometimes find using your
iPad as a passenger makes you travel
sick, the new Vehicle Motion Cues can
help reduce that.

A more helpful
Home >

The Home app now has
guest access so that you
can offer hands-free
unlocking for compatible smart
locks; this feature requires you
to have a HomePod or Apple TV
as your smart home hub.

Later this year, the Home app
will also gain support for robot
vacuum cleaners for easier control.
You can now set a preferred Home
hub if you have multiple HomePods,
which should solve connectivity
issues if your iPad's trying to
connect to a HomePod you don't
want it to, and there are many more
Control Centre controls for your
various HomekKit devices too.

[===. Re== Joor Ja==sis]
'__3 X

215° 0 I = 0
[+ 0c )

Home has more nuanced controls and support
for robot vacuum cleaners is coming soon.
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RISE
OF THE

Apple robots are set to revolutionise the smart home

hile the shuttering
of Apple's self-
driving car project
earlier this year was
disappointing, the lessons learnt
during its development may well
prove useful on a smaller scale -
in robotic devices for the home.
The first Apple robot is expected
to be a tabletop assistant arriving in
2026 or 2027, to be followed later by
a more sophisticated mobile droid.
So could Apple reshape the smart
home in the same way that it
revolutionised smartphones, tablets,
and wearables? The company’s move
into robotics, combined with the
power of its artificial intelligence (Al)
ecosystem, Apple Intelligence, could
transform not only the types of
devices we have at home but also
how we interact with them.
First up, the planned tabletop
robot - codenamed J595 - is likely
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WRITTEN BY PHIL KING >

to serve as an Apple Intelligence-
powered assistant that integrates into
your smart home. Its likely design will
feature an iPad-like screen on a robotic
arm that, with the use of a camera and
facial recognition, can swivel to follow
your gaze. This feature could prove
useful for applications such as video
conferencing, always keeping your
face in the frame, and home cooking,
enabling you to keep tabs on a recipe
as you move around the kitchen.

A fully mobile Apple robot is
an even more appealing prospect.
Imagine a device that not only
answers questions and controls your
smart home appliances, but also
moves autonomously around the
home to assist you. We can envisage
it having a similar form factor to the
Amazon Astro, a wheeled robot
equipped with a screen, sensors and
camera, enabling it double as a home
security device when you're out.

Integrating Apple Intelligence into
such a robot could lead to capabilities
far beyond what we see in today's
home robots. Apple is known for its
ability to take emerging technologies
and elevate them into the mainstream.
Could the Apple robot be the next leap
forward? Will it lead to a future where
intelligent robots are as common in
our homes as smartphones, tablets,
and smart speakers?

Let's take a look at the history
of domestic robots so far, speculate
on the future, and examine how Apple
and Apple Intelligence could shape
this exciting new frontier.

Early beginnings

The concept of an automaton to aid
humans dates back as far as ancient
Greece, long before the term robot
(from the Czech word for ‘slave’) was
coined, in 1922, and robots became

a mainstay of science fiction. ©
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Rise of the robots

© The first practical robots were industrial z?)-’
devices in the early 20th century, before
the dawn of the computer age; jointed arms
that could replicate a set of movements
demonstrated by a human worker, the
precursors of the robots still used in car ;
factories today. It's only more recently that <7
domestic robotics have begun to gain traction
in the tech world, thanks to the efforts of
companies like Sony and Honda.
Interestingly, one of the first robots designed
specifically for the home was not a humanoid
but a robotic dog. Introduced in 1999, Sony's
Aibo (Artificial Intelligence RoBOt) was more of a
novelty than a practical household assistant, but
it did at least show that people were interested in
bringing robots into their homes. Further Aibo
iterations were developed before the range was

discontinued in 2006. Sony revived it in 2018, ( -3;"3
however, with the launch on the upgraded !
ERS-1000 model, which can recognise up to 100 LS ,—_:j
faces and respond to over 50 voice commands. bl
Having experimented with the creation of \J, \ : “)"
humanoid robots from 1986 to 1997, Honda - ]
unveiled ASIMO (Advanced Step in Innovative :‘; C.
Mobility) in 2000. This bipedal bot could walk, Worried about the rise of the robots?
run, and even climb stairs, all while maintaining But Sony's Aibo robopup is so cute!

Hyperphantasua
The Vivid Imagination

Do you easily conjure up mental imagery? You may
be a hyperphant, a person who can evoke detailed
visuals in their mind. This condition can influence
one’s creativity, memory, and even career. The ways
that symptoms manifest are astonishing.

Apple Intelllgence

Billed as "'Al for the rest of us”, i while also enabling fun new ways

Apple Intelligence is the company's to get creative with Writing Tools
new artificial intelligence platform. and the new Image Playground
Announced at WWDC in June, it's feature. There's also an emphasis
currently in beta testing, withafull | on user privacy, with the cloud
launch planned for 2025. . model based on a Private Cloud
Available on supported iPhone, Compute platform with end-to-
iPad and Mac models, Apple end encryption.
Intelligence comprises both We expect Apple Intelligence
on-device and cloud-based Al to be embedded into Apple models,
models running on Apple silicon. giving Siri a physical form and -
With ChatGPT integrated the case of the mobile robot - the
seamlessly into Siri, it promises to ability to converse with you while
make communication more natural | following you around the home
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Honda's ASIMO could walk,
run and even climb stairs. ——

its balance. While it was primarily used for
research and demonstration purposes, with its
development discontinued in 2018, it set the
stage for future robots designed to interact
with humans in more meaningful ways.

Other companies have continued to develop
humanoid robots, such as Toyota with its T-HR3,
whose advanced manual dexterity includes the
ability to pick up coins and twist the lids off jars.

Domestic helpers

On a more practical level, Toyota has developed
the HSR (Human Support Robot), which can help
out around the house, performing practical tasks
with its extendable arm, as it moves around on
omnidirectional wheels. In a country with an
ageing population, Japanese firms have been
developing robots to help care for older people
for over two decades. Performing tasks such as
lifting people up out of a chair, these robots tend
to be expensive to buy or lease, so are more
commonly found in residential care facilities.

So far, the creation of more affordable
robots for the home has focused on automated
versions of devices to do specific jobs, such
as mowing lawns and cleaning carpets. Most
famously, in 2002 iRobot introduced the
Roomba, a robotic vacuum cleaner that -
now in its tenth generation - remains a popular
product. Early models relied on bumper sensors

»Image credits: Apple In onda Motor Co Ltd, Sony Group Corp



While primarily for demo
purposes, the realisation
e of ASIMO has helped Honda
o to revise its approach to
future robotic innovations.
-

3 7

to detect and avoid obstacles, which meant
they could sometimes get stuck under furniture.
Newer editions are equipped with a camera and
use advanced onboard mapping and navigation
software to help guide them around the home.

The ultimate dream would be a fully mobile,
dexterous robotic servant that could perform
all sorts of chores around the house, including
laundry and the dreaded ironing! There's still
quite some way to go to reach that goal,
however. Challenges for domestic robots
include mobility. Wheeled robots can trundle
around flat areas and may be able to avoid most
obstacles, but most can't handle stairs - arare
exception is the MOBINN delivery bot, whose
flexible wheels enable it to climb steps.

Reliable navigation around the home is
another major hurdle. While companies often
showcase their domestic robots in large
open-plan, clutter-free apartments, that's not
the reality in most homes. People often leave
things lying around, and shut doors that were
previously open, which could confuse less
intelligent robots. Solutions include waypoints,
sensors, computer vision using cameras, and
LiDAR to aid navigation in the dark.

Another challenge is giving robots enough
dexterity to perform the kinds of practical tasks
a human can do. For this, a sense of touch may
be required to avoid them crushing objects.
Robots will also need to be able to operate safely
in the home - especially around children and
pets, whose behaviour can be unpredictable.

Getting smarter

Apple’s history of creating intuitive, user-
friendly products makes the possibility ©

¥Image credits: Apple Inc, Samsung, Amazon.com Inc, Ogmen Robotics Inc, Roborock, Yarbo

Rise of the robots

Top 5
robots >

While anticipation is high for the
first Apple robot models, they'll
have plenty of rivals when they
arrive. The concept of domestic
robots has become a growing area
of interest for many tech firms.
The arrival of artificial intelligence
has spurred a new wave of
innovation in the field, resulting in
smarter robots, often with smart
home integration. Here are a few
of the most interesting examples...

Samsung Ballie

» £TBC » samsung.com

> Resembling an oversize tennis ball,
and moving around on tiny wheels,
the new edition of Ballie has been
upgraded with Al while its standout
feature is an HD projector to beam
video onto any flat surface.

A
Amazon Astro ORo
» $1,600 > amazon.com » $799 » orobuddy.com

> Currently available to purchase by
invitation only, Amazon'’s home robot
features an Amazon Echo-like display
that rolls around on a wheeled base.
Equipped with a camera, it doubles
as a security guard.

» This wheeled robot is designed

to be a buddy for your pet, able to
dispense food and throw a ball. Al
helps it to learn the animal’s behaviour
and you can chat remotely to Rover/
Kitty via the screen.

-

Roborock S8

MaxV Ultra

» $1,900 » global.roborock.com

> The latest Roborock vacuum cleaner
is the most advanced yet, featuring a
camera to aid Al/LiDAR obstacle
detection, along with a built-in voice
assistant and video calling to check in.

Yarbo Core

> From £4,799 » yarbo.com

> If you need help tidying up the garden
or yard, Yarbo's modular robot range
is an option. The Core robot can be
equipped with accessories including

a lawnmower, edger, trimmer, snow
plough, and blower.
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Rise of the robots

Samsung's Ballie bot can connect to your home appliances and manage them for you.

® of an Apple robot particularly intriguing, as
it's unlikely to be just another gadget. Apple’s
approach will probably focus on seamless
integration with its ecosystem - particularly
its smart home products like the HomePod,
Apple TV 4K, and Apple Watch.

One of the key questions surrounding the
Apple robot, and domestic robots in general,
is whether artificial intelligence will truly spur
a new wave of innovation. Al, particularly
machine learning and natural language
processing, is already making strides
in many fields, and robotics is no exception.

In the context of domestic robots, Al could
dramatically improve their capabilities and help
solve some of the challenges that have plagued
previous efforts. For example, the latest
Roborock vacuum cleaner robot uses artificial
intelligence to create a detailed map of your
home, helping it to avoid obstacles and even
identify specific rooms. While the new version
of Samsung’s spherical Ballie robot features the
integration of Al alongside a 4K projector that
can beam video onto a flat surface - something
we'd love to see in an Apple robot.

LG is also getting in on the act with its smart
home Al Agent, a cute little robot with expressive

Apple’s approach to robots will
probably focus on seamless
integration with its ecosystem

eyes (on a screen) and advanced Al language
skills to help it understand and communicate
with people as it rolls around on wheeled little
legs. As well acting as a mobile home hub, it can

Room mapping

As well as packing sensors to
detect obstacles on the fly, most
domestic robots - such as vacuum
cleaners - come with software that
enables them to map the layout of
rooms. Once learnt, this helps them
to navigate around the home more
quickly and efficiently while still
looking out for new obstacles.
Typically, you'll use a mobile
app to get your new robot to start
mapping. It will then begin exploring
its surroundings, sensing walls and
other obstructions as it tries to find
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the perimeter. It's often a good

idea to follow it around to see if it
encounters any trouble spots. Once
finished, the generated floor plan will
appear in the app for you peruse
and, in some cases, edit.

We can expect Apple’s first
mobile robot to pack similar mapping
features, enabling it to learn the
layout of your home so it can find its
way around. It could even offer the
mapping of multiple levels, although
we doubt the first mobile robot
model will be able to manage stairs.

Robot vacuums use room mapping to navigate your home.

»Image credits: Samsung, Wyze Labs Inc



Powering up

One vital factor to consider for

any mobile robot is how it will be
powered. Naturally, it can't be tethered
by a wire to a mains socket, so will need

some form of portable power supply.
Typically, this will incorporate a
rechargeable battery that enables the
robot to operate for several hours at
a time before automatically heading
back to its charging station when the
battery is running low.

How long it takes to charge
depends on the battery capacity and
charger specifications. For instance,

: Rise of the robots

the Amazon Astro robot features a
4,300mAnh Lithium-ion battery with a
full recharge time of 45 to 60 minutes;
when fully active, and not in ‘night

ode', it lasts around three hours.

The Apple robot dock is likely to

use MagSafe 25W wireless inductive
charging, but will still need to be within
range of a mains socket. The ideal
place to put itis in a low-traffic area
that's never closed off. You'll also need
to ensure that nobody leaves an item
right in front of the charging station,
blocking access.

While an Apple robot will
need to be within range
of a mains socket, it's
likely that it will use the
company's wireless
MagSafe charging.

learn from analysing environmental data
gathered by various on-board sensors.

As you might expect, Google DeepMind is
deeply involved in developing advanced Al for
use in robots. Building upon previous work, its
RT-2 Al model can perform multi-stage semantic
reasoning, such as deciding which object could
be used as an improvised hammer.

The great advances in speech understanding
and image labelling enabled by deep learning
will enhance robots' interactions with people in
their homes. Future iterations of home robots,

Apple's new robots, combined with its Apple
Intelligence ecosystem, could push this further.

Apple has historically been successful in creating

artificial intelligence that feels human-like, such

as Siri, and integrating this level of sophistication

into a home robot could result in a far more
intuitive experience than we've seen so far.

Apple innovation
Another area where the Apple robot could shine
is in its integration with smart home devices.
A robot equipped with Apple Intelligence and

connected to HomeKit could act as the ultimate
smart home manager, automating tasks and
making your home more efficient and
comfortable. For instance, it could detect the
sun setting and adjust the home's lighting and
temperature accordingly, or track your location
to ensure the house is prepared when you arrive.
If domestic robots are ever to become
ubiquitous, and not remain niche novelty
products, they need to prove genuinely useful
in the home. Apple’s entry into this burgeoning
market is a major boon. With the firm’s track
record of innovation, there's every reason to be
optimistic. Combining Apple Intelligence with
robotics has the potential to bring science fiction
a step closer to reality, offering not just
convenience but also new forms of interaction
with our smart homes. The key challenge will
be making robots affordable, practical, and
multifunctional. If Apple can do that, it might
not just change the types of devices we have at
home - it could change the way we live. For now,
all we can do is speculate, but if anyone can
—_ deliver it's Apple. Get ready: your next big smart

powered by more advanced Al, should be able
to perform increasingly complex tasks.

You can cue Amazon's Astro with custom routines, such as reminding you to feed your pet. = home upgrade might just have wheels.
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APPLE CHOICE Hardware

iPhone 16 Pro

Bigger and better in almost every way - and with power to spare

>From £999 > FROM apple.com/uk > FEATURES 6.3-inch Super Retina XDR Display (2622x1206 pixels), A18 Pro chip,
128/256/512/1TB of storage, Wi-Fi 7 (802.11be), Bluetooth 5.3, 5G, USB-C port, up to 27 hours (video playback)

There’s a
learning curve
to Camera
Control, but
we're glad that
it’s an option

The iPhone 16 Pro is available in Black Titanium, Natural Titanium, White Titanium and new Desert Titanium.

etween the iPhone 16 Pro and
E iPhone 16 Pro Max, the latter seems

like a bigger deal because of its
enormous 6.9-inch screen. But the iPhone 16
Pro should not be overlooked. We've been using
both of these new iPhone Pro models, and we
think the iPhone 16 Pro is better value. For
£999, you get a bigger display than last year
(6.3 vs 6.1inches), the more powerful 5x zoom
that used to be a Pro Max exclusive and an
impressive battery life boost.

The iPhone 16 Pro has many of the same
features as the 16 Pro Max, including the
powerful A18 Pro chip, upgraded 48MP Ultra
Wide camera and impressive video features
like 4K 120fps slo-mo videos and Audio Mix for
zapping background noise. Apple Intelligence
features like Writing Tools and improved Siri
are promising based on early testing of the
iOS 18.1 developer beta, but that won't
officially arrive until October.

The iPhone 16 Pro is still compact, but
there's a trade-off with getting a larger display.
It's now more mid-size - measuring 149.6x71.5x
8.25mm and weighing 199q, compared to
146.6x70.6x8.25mm and 187q for the iPhone
15 Pro, so the 16 Pro is taller and wider and
just as thin, but there's more heft toit.

The handset is still easy to use with one
hand, as Apple has made the bezels thinner.
The design should be more durable, too, as
Apple says the Ceramic Shield display is 50%
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tougher. Plus, the band is still made of titanium,
which is more durable than aluminium.

The iPhone 16 Pro colours aren't very flashy
compared to the regular iPhone 16. There's
Black Titanium, Natural Titanium, White
Titanium and the new Desert Titanium,
which looks like a soft rose gold.

In terms of the Super Retina XDR display
OLED screen, the only real news beyond the
size increase to 6.3 inches is that it can get
dimmer. The minimum is now just 1 nit (down
from 2 nits on the iPhone 15 Pro). We put the
two phones side by side in a dark room, and we
noticed the difference immediately. So you can
use your phone in bed without disturbing your
partner, and if you're using StandBy mode, the
iPhone 16 Pro won't be as bright when you're
using it overnight as an alarm clock.

Otherwise, you get the same 120Hz refresh
rate on this ProMotion display, and the same
max brightness. Apple claims a peak brightness
of 2,000 nits outdoors and 1,600 nits for High
Dynamic Range content.

Camera

Apple has added a new button, though it's
not technically a button. Camera Control is a
recessed capacitive switch that provides haptic
feedback. Press it once to launch the Camera
app, then press it again to snap a photo. We
found it easy to use in both portrait and
landscape, and we like that you can press and
hold it to record a video, though if you take
your finger off the button the video stops.
We wish you could customise that.

The Camera Control has a lot of tricks,
including the ability to zoom in and out by
sliding your finger left and right on the button.
And a soft double press launches a mini menu
you can scroll through to tweak things like
exposure, depth and choose Photographic
Styles. There's a learning curve to Camera
Control, but we're glad that it's an option. Plus,
this frees up the Action button on the left side
of the iPhone 16 Pro for other shortcuts.

The iPhone 16 Pro’s camera system has a
few key upgrades that we appreciated during @

»Image credit: Apple Inc
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APPLE CHOICE Hardware

In low light, the iPhone 16 Pro
packed in lots of detail, although
some highlights were blown out.

BENCHMARKS Our analysis explained >

iPhone 16 Pro 4.04GHz A18 Pro 2024

iPhone 16 Pro Max 4.04GHz A18 Pro 2024

iPhone 15 Pro 3.78GHz A17 Pro 2023

iPhone 16 Pro 4.04GHz A18 Pro 2024
28.6 FPS
iPhone 16 Pro Max 4.04GHz A18 Pro 2024
28.1 FPS

iPhone 15 Pro 3.78GHz A17 Pro 2023
23.3TFPS

iPhone 16 Pro 4.04GHz A18 Pro 2024

iPhone 16 Pro Max 4.04GHz A18 Pro 2024

iPhone 15 Pro 3.77GHz AT7 Pro 2023
10h 53m

0 I 10.00 I ZOIOO . 30.00 I 40.00 . 50I00 . 60.00
Index score (higher is better)
GEEKBENCH 6
SINGLE-CORE TEST

> We use this cross-platform
benchmarking tool to measure a
device's performance, with a single-
core processor baseline of 1,000.

0 W 2 W 0 50 &
Frames per second (higher is better)
3DMARK SOLAR BAY

> This cross-platform benchmarking
test measures a device's graphics
performance, with support for Metal
API based ray tracing on i0S devices.
The test has three different sections.

0o 5 0 B 2 B
Time (longer is better)

BATTERY LIFE

> In our battery test we continuously
surfed the web with the iPhone’s
display set to 150 nits brightness,
measuring how long it took for the
battery to become depleted.

The Ultra Wide camera takes
natural-looking photos without
over-saturation or distortion.

© our testing: there's a sharper 48MP Ultra Wide
camera, a faster 48MP main Fusion Camera with
‘zero shutter lag’ and the 5x tetraprism Telephoto
borrowed from the Pro Max series.

In addition, Photographic Styles are
integrated directly into the Camera and Photos
apps, so you can change Skin Undertones and
the Mood effect of your photo on the fly. Plus,
you can tweak it after the fact. Video on the
iPhone 16 Pro gets a boost as you can now
record at 4K and 120fps (up from 60fps). So
video will not only look smoother on the 120Hz
display, you can adjust the playback speed on
the fly to get dramatic-looking slow-mo videos.

The new Audio Mix video editing tool lets
you remix audio as one might in a studio for a

It also delivered plenty of detail
in our ‘peppers’ shot, even if the
image was a little unsaturated.

Apple Intelligence

Apple Intelligence isn't officially coming
to the iPhone 16 series until October, but
we were able to try out some of the
features ahead of its official launch.

Writing Tools can be fairly helpful. We
used it to summarise a long note in the Apple
Notes app and it came up with a useful
summary. We also had fun with Writing Tools
trying to rewrite an email we purposely wrote
in a brusque tone, choosing the Professional
option. And the result was indeed closer to
what we would usually send.

In the Photos app, our favourite Apple
Intelligence feature was Memory Movie. You
can give the Photos app a prompt like ‘Beach
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memories through the years with an upbeat
soundtrack’ and you'll see the artificial
intelligence go to work sifting through photos
and videos. And the end result was pretty
satisfying, fittingly ending with a sunset pic.

While overdue, we appreciate that the
iPhone 16 Pro has a Clean Up button. It's
smart enough to identify objects or subjects
you might want to remove and works quickly.
But it struggled in some cases to completely
erase what we didn't want in the frame.

Siri gets the biggest upgrade with Apple e Faeriha Galt Shani "
Intelligence. It's more conversational and
forgiving of mistakes as you speak. And it's
also better at answering follow-up questions.

much clearer result. There are a few options:
Standard, In-Frame, Studio, and Cinematic.
Standard is just your original recorded audio;
In-Frame focuses the audio on what's in the
camera frame; Studio cuts out background
noises and reverb; Cinematic, meanwhile,
pushes voices to the foreground track and
leaves environmental noises in the surround,
more like audio in movies.

Performance
The iPhone 16 Pro packs Apple's new A18 Pro
chip built on second-gen 3-nanometre (nm)
process, as well as 8GB of RAM.

When we played Resident Evil Village, we
were scared (in a good way) as we made our

Advica from Manuel
Hey team,

gpoke w Manuel yesterday to pressure test
timeline/budget

Vinformative and exhaustingly thorough,
Manuel is 2 mega nerd when it comes to
compliance

Big takeaway was timeline is realistic, we can
commit with confidence, woo!

M's firm specializes in community consultation,
we need heip here, should consiaetlengaging

Writing Tools *

New Writing Tools make it easier to
compose messages with a suitable tone.

»Image credit: Apple Inc



Camera Control adds a new way to access the iPhone’s photography features - and it works well, even if it does take some getting used to.

way down a snowy path. The graphics are
console-grade. We also got to play the Infinity
Nikki game, which was in beta, and the lighting
and water effects were very impressive.

In Geekbench, which measures overall
performance, the iPhone 16 Pro scored 3,400
compared to the iPhone 15 Pro’s 2,890.

To test video-editing performance we used
Adobe Premiere Rush and timed how long it
took to transcode a 4K clip to 1080p. The
iPhone 16 Pro took a mere 21 seconds.

When it comes to graphics performance,
the iPhone 16 Pro has a 6-core GPU, compared
to five cores for the regular iPhone 16 and
Apple says you should get 20% faster
performance than the iPhone 15 Pro. On the
3DMark Solar Bay test, which has support for
ray tracing, the iPhone 16 Pro was 22% faster
than the iPhone 15 Pro, and actually slightly
ahead of the iPhone 16 Pro Max.

The iPhone 16 Pro has an improved camera system with a
48MP Fusion camera, a 48MP Ultra Wide camera and a 5x
Telephoto camera, taken from last year's 15 Pro Max.

»Image credit: Apple Inc

The iPhone 16 Pro Max features a new
internal design with a graphite-clad aluminium
substructure that's supposed to result in 20%
better sustained performance. To test this, we
ran the 3DMark Wildlife Life Stress Test for 20
minutes. The iPhone 16 Pro turned in a stability
score of 66%. It hit a higher overall loop score
than the 16 Pro Max but had a bigger drop-off.

Battery

The iPhone 16 Pro gets a big battery life

boost, thanks to a larger battery and other
efficiencies. In our battery life test, which
involves continuous web surfing at 150 nits of
screen brightness, the new iPhone 16 Pro lasted
14 hours and 7 minutes - a big jump from the

10 hrs 53mins of the iPhone 15 Pro.

Sadly, the iPhone 16 Pro has the same
20W charging speeds as before, so it wasn't
a surprise to see it get to 56% capacity in 30
minutes. Despite reports that the iPhone 16 Pro
supports 45W charging, we did not see any
difference in our tests. However, MagSafe
wireless charging jumps from 15W to 25W,
if you're using a 30W adaptor.

Overall, the iPhone 16 Pro is arguably the
best flagship phone for under £1,000. You get
the same excellent cameras as the iPhone 16
Pro Max for £200 less and we think the screen
is big enough at 6.3 inches. We also liked the
improved battery life, Camera Control and
compelling Audio Mix feature for videos

Should you upgrade to the iPhone 16 Pro? If
you have an iPhone 13 Pro or earlier, yes. But if
you own a newer phone, maybe wait to see how
Apple Intelligence develops. Mark Spoonauer

Mac

FORMAT

VERDICT

> The iPhone 16 Pro
gets a bigger display,
5x tetraprism zoom,
and longer battery
life. Plus, promising
Apple Intelligence
features and smarter
Siri are on the way.

1.0.2.0.9. ¢

© Bigger display

© Better battery life
© Camera Control

@ Apple Intelligence
is a work in progress
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AirPods 4 with ANC

A new design and Active Noise Cancellation make these a must-have

> £179 > FROM apple.com/uk » FEATURES H2 headphone chip, Active Noise Cancellation (ANC), dust, sweat and water resistant to
IP54, charging case with USB-C and wireless charging, up to 5 hours battery life (AirPods)/30 hours (Charging Case) with ANC off

BN
TI'y them on :uletAppI: a::ed n.e\;v. hej\r.ln: :ealth

R eatures to the existing AirPods

a packed train Pro 2 at its ‘Glowtime’ event in P ‘

or plane and S?ptember, it was the f:ompany’s cheaper - :
. AirPods that got the biggest overhaul. Still ’
the difference /] .
~9

only available in de rigeur white, the new
they make AirPods 4 are available in two different guises:
1S amazing

reqgular AirPods 4 for £129 and AirPods 4 with
Active Noise Cancellation (ANC) for £179. It's
the latter we're looking at here.

While it looks familiar, the design of the
AirPods 4 is all-new. Apple has tweaked the
AirPods' contours, shape and size to make
them more comfortable to wear for longer
periods, and they've now been fitted it with
Apple's next-gen headphone chip, the H2,

promising improved sound quality with better
sound separation, deeper bass and clearer
highs. You can see whether that holds true
later on in this review.

The biggest change, of course, is that these
new AirPods are available with Active Noise
Cancellation (ANC), which is real game-changer
when it comes to your listening enjoyment.
Previously only available on the pricier AirPods
2 Pro and AirPods Max, ANC helps drastically

The design may look familiar, but the AirPods 4 with ANC
are all-new, both inside and out.

cut down the amount of background noise, not
only giving you a better audio environment to
listen to your favourite music and podcasts,
but also enabling you to listen at lower volume
- the AirPods 4 may not have the AirPods Pro
2's hearing health's bells and whistles, but
listening at lower volumes certainly helps.

Turn on, tune in, customise!

NOISE CONTROL

@ 0 v+
e & £ @
Off Transpar- Adaptive MNoise
ency Cancellation
PRESS AND HOLD AIRPODS
Left Neise Control
Right Noise Control
L]
Noise controls

There are two ways to control noise
levels in the AirPods 4 with ANC. You
can go Settings > AirPods, then choose
from Off, Transparency, Adaptive or
Noise Cancellation. Or you can press and
hold the stems on either of the earbuds.
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Noise Control v

Siri

s Off

! Transparency J
Customisation

You don't have to stick with the default
control options. Under ‘Press and Hold
AirPods', tap either Left or Right to
change what the controls on each
earbud do. You can change the default

ANC option, for example. Or invoke Siri.

&

Personalisation

Scroll down in Settings > AirPods, then
tap Personalised Spatial Audio. Follow
the prompts and your iPhone will
perform a Face ID-like check that helps
customise the sounds from the AirPods
to suit the shape of your ears.

»Image credit: Apple, Inc



AirPods 4 with ANC APPLE CHOICE

The built-in Force sensor on
the stem makes it easy to
switch listening modes.

As with the AirPods 2 Pro, ANC on the
AirPods 4 can also be adjusted: Transparency
mode lets in most background sounds;
Adaptive Audio applies a level of noise
cancellation but lets some sounds (people
talking, loud sounds, etc) through; and Noise
Cancellation cuts out ambient noise almost
entirely - try them on a packed plane or train
and the difference they make is amazing.

While you can easily control the AirPods 4
from your iPhone, you can also do so using
their Force sensor stems, pressing and holding
them to switch Noise Control modes or invoke
Siri; and pressing them one, two or three times
to play/pause the currently playing track, skip
to the next track or skip to the previous track.
You can also use the AirPods' Force sensor to
answer, mute or end calls. And new in i0OS 18,
you can simply shake or nod your head to
accept or decline an incoming call.

Sound sensation

While the open-ear design means you don't
get the sound-isolating ear tips of the AirPods
Pro 2, in practice we didn't miss them much

- indeed, some people may find the AirPods 4
preferable; silicone ear tips can make your ears
feel itchy after a while, after all.

»Image credit: Apple Inc

Fire up your favourite sounds with ANC
active and the world around you mostly fades
away, making it easy to lose yourself in your
favourite podcasts and music, whether
it's savouring the atmos in Billy Eilish's
Wildflower in Spatial Audio or soaking up
the syncopated synths of The Weeknd's
Dancing In The Flames. Narrators in podcasts
sound suitably involving too - you really feel
like the presenters in Apple TV+'s The Pirate
of Prague are right there with you, the timbre
of their voices being easily discernible from
one another.

As you'd expect, battery life is good -
the AirPods 4 earbuds will last for up to four
hours between recharges with ANC on (or
five with it off), while the Charging Case lasts
for up to 20 hours with ANC on, or 30 hours
with it off. Charging the case is easy - not
only does it comes with a USB-C port (as well
as Find My), but you can also charge it along
with the AirPods using either an Apple Watch
charger or a Qi charger. However, none of
these are included in the box that the AirPods
4 with ANC come in, so you'll need your own.

Overall then, the AirPods 4 with ANC are
great. Let's get listening!

Rob Mead-Green

FORMAT

e e Aok
EDITOR'S
CHOICE

Mac

FORMAT

VERDICT

> They may not be
quite as capable as the
AirPods Pro 2, but the
AirPods 4 with ANC
are brilliant earbuds
in their own right and
they’re easy to wear
and use too.

1.0.2.9.0. ¢

@ Good sound isolation
© Comfortable fit

© Delightful to listen to
© Lack some features
found in AirPods Pro 2
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You can use the AOC 16T3EA
display in landscape or
portrait orientation.

AOC16T3EA

A second screen on the go for less than you think

> £149.99 > FROM aoc.com/uk » FEATURES 15.6-inch screen, 1920x1080, IPS panel, 60Hz refresh rate, 1x USB-C 3.2,1.8m cable

The monitor is
plug and play
— just connect

it and it’s
ready to use

Mac

FORMAT

VERDICT

> One or two
compromises, but
overall, an excellent
budget portable
display.

Kk Kk

© Good price

© Very portable

© Portrait or landscape
© Imperfect colours

ortable monitors are great for on
E the road productivity. Slip it into

your bag with your notebook and
you can enjoy two screens when on a work
trip, just like you might do at home.

The AOC16T3EA has a 15.6in screen (corner
to corner), with a16:9 aspect ratio, and comes
with a carry case. The unit as a whole is barely
larger than the screen - it's a mere 12.5mm
thick and weighs only 830g, so it sits neatly
in your laptop bag, along with your MacBook.
The fold-out stand lets you use it in landscape
or portrait, and if you want to wall mount it, a
VESA bracket is supplied. While not adjustable,
the stand is sturdy enough and enables you to
position the screen at a good viewing angle.

The monitor is a plug-and-play affair. Just
connect it to your MacBook's USB-C port and
it's ready to use, with no need to download
drivers. The USB-C port is used for both power
and video, and is the device's only connectivity
port. Annoying, but it keeps the price down.

We're impressed by the display’s brightness
and contrast. Being an in-plane switching (IPS)
screen, the viewing angles are excellent. When
looking at our PhotoDisc test image, fine details
were clearly reproduced and skin tones were
accurate and vivid. Colour reproduction was
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not quite as good. The gradient ramps were
smooth and well realised, but the reds tended
to look a little orange. This isn't a screen for
design work where colour accuracy is essential,
but if you work on layouts on your MacBook
and use the monitor for menus and tool
windows, it's fine. It's evenly lit, though there
was a slightly darker patch in the bottom left.

Space to offload

It also passed our text test, though maybe not
with flying colours. Although bold and readable,
the letters aren't as smooth and crisp as you
get on the Mac's Retina display. To be fair, you
wouldn't expect that sort of quality on a
sub-£150 portable monitor, and the 1920x1080
HD resolution does a decent enough job. Finally,
put on a movie or other such video and it plays
smoothly and clearly, with no ghosting.

The AOC16T3EA isn't perfect, but it offers
good value for money. If you absolutely must
have impeccable colour reproduction and
ultra-high resolution, spend more money and
get one of the increasingly capable 4K portable
monitors available. For most people, who just
need space to offload Finder windows, tools
and so on while they work on their Mac
notebook’s screen, it's ideal. lan Osborne

»Image credit: AOC



Hardware APPLE CHOICE

Belkin Auto -Trackmg
Stand Pro

Get your iPhone to follow your every move!

> £169.99 > FROM belkin.com/uk > FEATURES 360° movement tracking, 90° auto
tilt, 1I5SW MagSafe wireless charging with 30W power supply, NFC pairing

The stand
rotates the
iPhone
through 360°
to follow you
while you walk
and talk

Mac

FORMAT

VERDICT

> The Belkin Stand
Pro frees you to walk
and talk during video
calls and ensures
your iPhone is

fully charged.

Kk kK k

@ Pans 360°

© Tilts through 90°

© Charges your iPhone
@ Bit slow to follow
sudden moves

»Image credit: Belkin

hen using FaceTime we tend to hold
.‘N} our iPhone for the duration of the
call. This limits our options to do

other things while we talk to friends and family,
or make a work call with a colleague. By
attaching your iPhone to the Belkin Stand Pro's
MagSafe compatible pad, you can chat
hands-free. The Belkin Stand Pro rotates the
attached iPhone through 360° to follow you
while you walk and talk. It will also tilt up or
down (90°) to keep you in the frame at all
times, even when you crouch down. This
freedom to move around without having to hold
your iPhone means that you can video-chat in
the kitchen while preparing a meal for example.

The beauty of the Belkin Stand Pro is that
it doesn't require a third-party app. It tracks
while you're recording video in Apple’s native
Camera app or when talking over FaceTime.
It's easy to set up. Simply tap and hold your
iPhone on the base of the stand and it will use
Bluetooth NFC (Near-Field Communication) to
pair your iPhone with the stand. Then simply
stick the iPhone to the MagSafe pad, fire up a
DockKit-compatible video app such as Apple’s
Camera app, and let auto-tracking commence!

Smooth and silent

The Belkin Stand Pro should also appeal to
vloggers and YouTubers who want to enhance
their ‘talking to camera’ presentations. As you
walk and talk, the Belkin Stand Pro will pan and
tilt like a camera operator so that you're always
in shot. This camera movement makes your
usually static presentations look more
interesting and engaging.

The auto pans are smooth - the stand can
take half a second or so to start panning if you
suddenly move quickly, but it soon catches up.
As you come to a stop, the pan slows smoothly
to a halt rather than stopping sharply -
mimicking the moves of a pro camera operator.
The movement is also silent, so it doesn't
interfere with a presentation’s audio recording.

Stay in shot - whatever moves
you make - thanks to this
auto-tracking marvel.

There's more to the Belkin Stand Pro than
auto-tracking. It also charges your iPhone while
it is attached to the MagSafe pad. With the
iPhone on the pad, it's easy to manually swivel
it from portrait to landscape orientation. This
activates the iPhone's StandBy mode so you
can turn the iPhone into a bedside clock during
the night and your iPhone will be fully charged
by morning. While attached to the mains, the
stand's internal batteries are also charged so
you can use the stand cordlessly for up to five
hours, so YouTubers can present to camera in
an outdoor location and the Belkin Stand Pro
will keep them in the frame without requiring
an external power source. George Cairns
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APPLE CHOICE Hardware

reMarkable 2, Marker

Plus & Type Folio

A tablet that gives a note-paper experience

>reMarkable 2 with Marker Plus £429; Type Folio £179 > FROM remarkable.com
» FEATURES 10.3inch monochrome digital paper display, 1872x1404 resolution
(226 DPI), 1.2GHz dual core ARM, 1GB LPDDR3 SDRAM, 8GB memory (around
100,000 pages), Wi-Fi 2.4GHz and 5GHz, USB-C, 3,000mAh battery

You really
see what
reMarkable
can do when

you simply
write on it

Mac

FORMAT

ok Aok
EDITOR'S
CHOICE

Mac

FORMAT

VERDICT

> An excellent note-
taking tablet that’s
getting better and
better with each new
software update.

10,000 ¢

© Genuine paper-like
writing experience

© Excellent

tool selection

© Solid interface

@ Needs more
drawing tools

he problem with using a stylus
on a tablet, including an iPad and

Apple Pencil, is the lack of tactile
feedback. For those used to writing and
drawing with a pencil and paper, it feels, well...
wrong. Not so with reMarkable 2. This next-
generation reMarkable tablet promises a
paper-like experience, and it actually delivers.

reMarkable 2 has a10.3-inch e-ink screen.

It's available with either a Marker (white) or a
more expensive Marker Plus (black, reviewed
here) which adds an eraser to the top of the
stylus. Both connect to the tablet magnetically,
and neither need charging. Also available is the
Type Folio keyboard case (black or brown). It's
great for typing, and unlike Apple’s Magic
Keyboard for iPad, it folds away neatly when
you're using the tablet for handwriting.

The device's interface is a joy to use. You
can create and store individual notepads in
user-defined folders, so you have all your notes
with you without having to lug around a huge
pile of dog-eared paper pads. There's a huge
range of templates to choose from, including a
blank page, various types of lined and squared
paper, planners, checklists, music options and
more. Having chosen, you can add more pages
to your notebook at will and use different
templates within a notebook. You can even
make individual pages as long as you like.
When you get the to the bottom, simply swipe
upwards for more space. You can't do that
with a spiral-bound reporter’s jotter. And if
you want to mark up a document, import
it to your tablet in PDF or ePub format.

Hidden colours

A range of writing tools are at your disposal,
chosen from a retractable toolbar on the side
of the screen. For your pen, you can choose
between ballpoint, marker, fine liner, pencil,

86 | MACFORMAT | NOVEMBER 2024

e —
—

(2]

/15100 9025

e I_‘I'N'u@LVE I»’:—/—

NEXT STEPS:

v PETATL MILESTONES
» TEAM MEETIHE
+ PEEFARE BYARD PRECHS

The Marker 2 stylus is capable of very fine drawing

and writing, and there's a built-in eraser at the top.
mechanical pencil, paintbrush, highlighter or
calligraphy pen. Thin, medium and thick strokes
are catered for, and there are limited colours on
offer, depending on which pen you're using.
These don't show up on the tablet's black and
white screen, of course, but if you export your
documents to your Mac, iPad or iPhone using
their reMarkable apps, or share your screen

SO you can use your notes in real-time
presentations, they appear in full colour.
Handwriting can be converted to text too.

You really see what reMarkable can do
when you simply write on it. You get just
enough tactile feedback from the screen that
it feels like writing on paper. There's almost no
lag, and the typing experience on the keyboard
is excellent too. We wish it had better drawing
tools, and a word/character count for text
would be welcome, but its developer has
a strong update policy, so we might well see
them soon. Whatever the future has in store for
reMarkable 2, we can't wait for it. lan Osborne

»Image credit: reMarkable



Hardware APPLE CHOICE

QDOS SnapStand 3-in-1

Charge three devices in one plug socket

» £79.99 » FROM qgdossound.com » FEATURES Output capability -

iPhone 15W Qi/

Apple Watch 2.5W Qi/AirPods 5W Qi; USB-C (cable included); 60% recycled materials

Mac
FORMAT
VERDICT
> An excellent 3-in-1

charger that’s perfect
for home and travel.

Kk kk

© Quick-charge
three devices at once
© Robust build quality

his handy travelling
gadget saves space

on your bedside
table when you need to
charge your iPhone, Apple
Watch and AirPods. It also
saves cables and plug sockets.

When not in use, the

SnapStand folds down to fit
nicely into your notebook bag,
or even your pocket. When
opened, your MagSafe iPhone
snaps onto a 15W Qi charger
that can power up an iPhone
15 Pro Max from flat to 100%
in just three hours, 30
minutes. You can position it
in portrait, or landscape mode
if you want to use StandBy.

Around the back, another
Qi wireless charger holds your
Apple Watch. This has a 2.5W
output, which can charge a
Series 9 watch in three hours.
The watch is held facing
upwards, so you can't use it
in Nightstand Mode while it's
charging. The base of the unit
is a SW Qi charger for your
earbuds. Charging Apple
AirPods is advertised, but any
earbuds that support wireless
charging should work fine.

Naturally, this is
dependent on using a plug
that can output this much
power, and thereisn't onein
the box; go for a USB-C

STM 65W Three Port

Universal Power Adapter

Power performance for travellers

> £49.95 > FROM stmgoods.com » FEATURES GaN charger;

US, UK, Euro and Aus plug adaptors; 2x USB-C outlets, 1x USB-A outlet

Mac

FORMAT

VERDICT

> An excellent charger,
and the ideal accessory
for your notebook bag.

Kk Kk

© Versatile
© Fast charging

¥Image credits: Reso Ltd, STM Products sr

ou're going on
Y holiday or on a
business trip, and

you're taking stock of the
tech you need while away.
There's your iPhone,
notebook, Apple Watch,

and maybe a few non-Apple
devices such as an ebook
reader or a handheld games
console. But what chargers do
you need? What cables? What
international plug adaptors?
And with all that in your
luggage, will you have enough
room for your clothes?

STM's 65W Three Port
Universal Power Adapter
addresses these questions.

It has two USB-C charging
ports, which can carry up to
65W of power between them,
which is plenty enough for
your notebook. There's also
a single USB-A socket, giving
you three charging options.
The cables aren't included, so
pick the ones you need from
your cables box and take
them with you.

Being a GaN (Gallium
Nitride) charger, it's more

For travel, the stand folds almost flat.

charge plug of at least 25W,
to go with the USB-C cable.

If you charge on your
nightstand, you'll be glad that
a fairly dim LED indicates it's
active. It's unobtrusive, and
easily covered if even a low
light disturbs your sleep. Even
so, we wish it turned off after
a little while. lan Osborne

stm
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Y RRIN
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i !

A powerful three-port travel charger.

efficient than a reqgular silicon
one. This allows it to be
smaller and faster at
charging. The palm-sized
device has a US plug built

in, with adaptors for the

UK, Europe and Australia
included. Unfortunately, there
isn't a drawstring bag to put
them allin, but unless you're
going on a world tour, you
probably only need one at a
time anyway. lan Osborne
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MacBook
powerbanks

Serious power for working on the move

REVIEWED BY HOLLIN JONES >

hen Apple created the M-series

processors that now power all

its Macs and some iPads, it set
a new standard for power efficiency. And
the battery life of recent MacBooks is far
better than older models.

Yet as we travel or work on the move
more and more, we still need to keep our
batteries topped up. Laptops require much
more juice than an iPhone or iPad, so you
need a high-capacity and fast powerbank
for those times you're running low but
you're away from a power point. Smaller
powerbanks will be drained dry by a laptop
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very quickly while only giving you a

few per cent more battery. But a new
generation of higher-powered models

is emerging as the technology evolves.
Still very portable, they provide
connectivity for several devices while
crucially having enough punch to provide
a serious amount of power to your
notebook when you need it. And, thanks to
the prevalence of the USB-C charging
format now, you don't need to carry
around lots of cables, just one rated to
carry plenty of power for charging the
laptop and recharging the powerbank.

How we tested

> Charging times are subject to a
huge number of variables. MacBook
Air and Pro models of different ages
and sizes have different sized
batteries with different capacities.
Using your Mac or charging other
devices at the same time will affect
the amount of power drain.

We used a baseline of charging a
2023 16-inch MacBook Pro (M2 Pro)
from empty, with no other devices
connected to the powerbank.
Smaller notebooks draw less power.

»Image credit: ZAGG Inc



Anker

MacBook powerbanks APPLE CHOICE

Prime 27,650mAh

Power Bank (250W)

» £179.99 > FROM anker.com/uk

1 This can-sized
powerbank comes
with a high capacity USB-C
cable and can supply 140W
through either of its USB-C
ports, or 65W through
USB-A. It's very slick, with
a detailed real-time display
for charging stats, as well
as a companion app for
monitoring over Bluetooth.
Its capacity of 27,650mAh
is impressive for its size, and
provides 1.3 full charges of
a MacBook Air, or 0.7 of our
16-inch MacBook Pro.
Remarkably, the
powerbank can recharge
itself at 170W if you connect
two high-powered chargers
to the USB-C ports, which is
very handy if you're in a bit

of a rush. Power Delivery (PD)
3.1 protocol means it can fast
charge, getting the MacBook
Pro to 50% from empty in
a shade under half an hour.
The powerbank is
attractively designed and
portable, and its 250W rating
means that even with three
devices connected, you can
still get 140W/92W/18W
across the USB ports,
although this will drain it
quickly. An all-round bank
that's easy to slip in a bag.

VERDICT

© Slick and portable

© 140W to a single port

© Recharges itself quickly

© MacBook Pro drains it fast
Yk ko

Things to consider...

Goal Zero

2 Goal Zero's
powerbank is the
most high-tech looking on
test, with a compact but
rugged build. It has a solar
panel input option, in
addition to its dual USB-C
ports with PD that can accept
60W input for charging; the
second allowing up to 100W
output while the first tops
out at 60W. The two USB-A
ports offer up to 12W max
and the unit can recharge in
two hours from a wall socket.
It refilled our MacBook Pro
battery up to 70% and has
a capacity of 25,600mAnh.
Switches on the rear let
you set the USB-C ports
to accept input/output, or
auto detect the optimal

Sherpa 100AC

» £299.99 > FROM goalzero.co.uk

function, and there's a

small screen that provides
important visual info about
what's charging, and times
remaining. The unit also has
a wireless charging pad on
its top surface that can
charge a compatible
smartphone at up to 15W.
It's a really handy addition
since we all have to charge
our phones so often. It's
arguably a bit too pricey
considering its capacity, but
it's a good, sturdy option.

VERDICT

© Very rugged

© Wireless charger
@ Expensive

@ Tops out at 100W
Yook ok

zero to full. But a smaller MacBook Air
could get up to one and a half charges.
Consider which model suits your Mac.

Portability vs capacity

With batteries, larger means more
life. If space is at a premium you might
consider a small and light unit at the cost
of overall capacity.

typically output slightly less, say 90W
peak, due to inefficiencies in cables and
components. A MacBook battery will
draw lots of power when it's low but slow
down the drain as it gets closer to full. Extra features

Larger powerbanks can have
extras like car chargers or wall-sized
power plug sockets, making them more
flexible at the cost of being less portable.

Real world results
Charging times/speeds aren't an
exact science. A100W powerbank might

3 Mac batteries vary
A smaller bank won't charge the
biggest 16-inch MacBook battery from
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APPLE CHOICE Group test

Jackery Explorer
300 Plus

> £319 > FROM uk jackery.com

3 Jackery's powerbank
is hefty and better

suited to heavyweight than
casual use. Think on-set
photographer or hardcore
camper, rather than a person
writing emails on a train.
Charging from a wall socket in
two hours, or over high-speed
USB-C in four, it can also be
charged by the company's
optional solar panels. It has
a full-sized AC output for
larger appliances, and two
USB-C PD outputs at up to
100W each, as well as USB-A
and a car charger.

It's much bigger and
heavier than the other banks
on test but has a rating of
300W, as well as a capacity

of 288Wh, meaning it can
charge our 16-inch MBP fully
twice with a little to spare.
Charging other devices at
the same time impacts it less
since it has more headroom,
and there's even an app for
monitoring its charging.

As mentioned, this is
more for photographers or
videographers, or people who
take several devices camping
or on long commutes. In these
instances, it's a great choice.

VERDICT

© High capacity

© Lots of connections

© Bigger and heavier

© Overkill for notebooks
2. 2.0.8.¢
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Mophie Powerstation

Pro XL 25K

» £209.95 > FROM uk.zagg.com

4 Mophie's Powerstation
Pro XL is slender and
modern in its design which is
one reason it's sold by Apple
in its online store. It has three
USB-C ports, each with Power
Delivery and a total power
output of 120W. This breaks
down as 100W to the first port
and 20W to a second, or 45W
and 20W respectively to ports
two and three. Though no
precise breakdown is provided,
Mophie says that using all
three ports divides the total
120W using ‘up to’ 100W,
30W and 20W respectively.
The 25,000mAh capacity

was enough to put 67%
charge into our 16-inch
MacBook Pro and, as noted,

this would be more with a
smaller 14-inch model or Air.
This powerbank doesn't really
have any bells or whistles - just
charge it then charge your
devices - save for a small LED
power indicator display on
one edge. It's not the highest
capacity on test, thoughiit is
definitely the sleekest, most
unobtrusive and Apple-like,
and Mophie has many years
of experience with charging.

VERDICT

© Beautiful, lightweight
design

© All three ports have PD
© 100W max over one port
© Limited visual feedback
2. 2.2.0.¢

»Image credit: Jackery Inc, ZAGG Inc



MacBook powerbanks APPLE CHOICE |

Anker Prime o)
27.650mAh Power
Bank (250W)

The best balance of price and performance

oal Zero's model has amore | makes up for it elsewhere. It's the only
. industrial feel if you're after model on test that can deliver 140W

something reassuringly down a single port, enough for the latest
robust, and the wireless pad is an large notebooks. It can be recharged
excellent addition, though it is quite quickly, offers excellent visual feedback,
pricey. Jackery's powerbank is also a and has a sleek and portable design.
more heavyweight proposition, with a While our tests were with the
bunch of outdoor-centric features that biggest MacBook Pro, many users will
will be great for some people but overkill have 13- or 14-inch models, a MacBook
for others. Mophie's model is the Air, or even just an iPad and iPhone. In
sleekest of the bunch, though it’s also these cases, the Anker’s performance
a little expensive considering it has is even better, allowing around 1.3 full
fewer features than the others. charges of a MacBook Air (M2), for

While it might not have the highest example. Overall it's the perfect

capacity on test, Anker's powerbank balance of features.

>How

do they
compare?

Specs Anker Prime 27,650mAh Goal Zero Jackery Explorer Mophie Powerstation

Power Bank (250W) Sherpa 100AC 300 Plus Pro XL 25K

Price | E1999 £299.99 | £319 £209.95
Website | anker.com/uk goalzero.co.uk uk.jackery.com | uk.za-qq.com
Capacity ~ 21650mAh |5600mA0 | T7800mAh 25000mAh
Max one-port output | 140w | 100w 100w 100w
Max total output 250W 100w  300W 1o0W
Companion app Yes No :.Yes ”No
Number of ports |3 4 [ 5 3
Wireless charger No Yes o No No

Overall * * % * *

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.

»Image credit: Fantasia Tradin
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APPLE CHOICE Software

Death Stranding

Director’s Cut

An outstanding horror tale

»>£34.99 > FROM 505games.com > NEEDS macOS 13.3 or later; Mac with an Apple M1 chip or later

It’s a marvel
how much
thought went
into the game’s
construction
and mechanics

Mac

FORMAT

VERDICT

> An exceptionally
well-made horror title
from Hideo Kojima,
Death Stranding is a
gaming masterpiece.

* kK kK

© Cinematic storytelling
and atmospheric
soundtrack

© Beautifully detailed

@ Cooperative elements
@ Can lag on some Macs

eath Stranding Director's Cut
m has finally arrived on the Mac,

and Hideo Kojima's opus does
not disappoint. It's truly a masterpiece
of unsettling world building and patient,
multi-layered gameplay.

The game is set in a supernatural future
where the Death Stranding has blurred the
boundaries between the worlds of the living
and the dead. Unless properly incinerated,
dead bodies become BTs (Beached Things).
These ghostly monsters consume the living,
triggering a void-out blast that can flatten
cities. Your character, Sam, can detect BTs
with the help of a scanner called an Odradek.
As a porter, your task is to deliver supplies
to remote outposts of civilisation, a job that
gradually morphs into the grand project of
rebuilding America itself.

Death Stranding's lore is one of its most
fascinating aspects. Toxic rain called Timefall
heralds the presence of BTs, and anything it
touches rapidly ages in a matter of seconds.
Your Odradek connects to a Bridge Baby (BB),
a foetus that was removed from the body of a
brain-dead ‘stillmother’, allowing it to bridge
the gap between life and death and thus sense
BTs. The world of Death Stranding is weird,
unsettling and deeply engrossing. It'll grab
you from the moment you start.

Terrifying territory

Death Stranding's gameplay seems simple:
deliver cargo to locations across the game
world. At first, you start on foot, slowly
traversing the strikingly bleak landscape,
with only a hauntingly beautiful soundtrack
occasionally puncturing the quiet.

You can't just sprint to your objective and
call it a day. Load too many boxes on one side
of your body and you'll topple over. Don't look
out for rocks and you'll trip and fall. Making it
to your goal is a literal balancing act as you
carefully navigate the safest path - which may
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Death Stranding has an absorbing cinematic quality.

not always be the quickest. This forces you
to slow down and take in your stark but
stunning surroundings instead of charging
through and missing something.

Encounters with Beached Things are
genuinely unnerving, with their other-worldly
appearance and the terrifying ramifications
of meeting them instilling a healthy fear of
getting too close. Stay in BT territory too long
and the stress shuts down your Bridge Baby
- and with it your Odradek, your only means
of detecting the BTs. You must be patient to
get past them, utilising stealth and forethought
to ensure you survive.

Other times you'll need to fight back,
whether that's against aggressive bandit
camps or against the BTs themselves, and you
gradually start to unlock weapons, vehicles
and tools to deal with your encounters. Bandit
combat is intense and enjoyable, but finding
a BTs infestation is always stressful.

Fortunately, help from other players
is often at hand, and Death Stranding has
a strong social vein running through it.
Structures you create, from ladders and
postboxes to bridges and roads, can be used
by other players, making traversal significantly
less taxing. Leave a parcel in a postbox and
someone else might deliver it for you, giving

» Image credit: 505 Games SpA



you both a share of the reward. It's a
thoughtful addition that frequently
lightens the load of your tasks.

Details, details

Large portions of the game are broken up by
extended cutscenes. Although this limits your
active participation, its gives Death Stranding
a cinematic feel that adds to the immensity
of the story and setting. It almost feels like it
would work better as a movie than as a game,
such is its dramatic quality.

It's full of small details, too, like Timefall
rain moving up your screen instead of down
and flowers rapidly growing and dying as the
drops hit the ground. Wading through deep
water depletes an endurance meter, while
wind can buffet you off balance. It's a marvel
how much thought went into the game'’s
construction and mechanics.

Not everything is smooth sailing. Death
Stranding is a demanding game, and while we
hit just under 50fps on default settings with
an M1 Pro chip, our MacBook Pro often got
warm to the touch, leading to lag and stutter.
We'd recommend a beefier Mac chip. It's also
best played in bursts, lest the long delivery
slogs become wearisome.

But none of that takes away from Death
Stranding’s overall standout quality. Mac
gaming has come a long way in recent years,
and if you want to experience one of the best
titles on Apple's platforms, this game should
be on your list. Alex Blake

¥ Image credit: 505 Games SpA

Death Stranding's world
is bleak and beautiful.

Beached Things are the
game's pre-eminent danger.
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> Advanced Options

v Process Zero

Apple Processed (%)

Apple ProRAW

You can remove Al from the photo
pipeline by tapping Process Zero.

o ()

Halide Mark I1 (2.15)

The ideal app for photographers looking for more manual control

> £59.99 > FROM lux.camera > NEEDS i0S 16 or later

Mac

FORMAT

VERDICT

> If you want more
creative input as a
photographer, Halide
Mark II lets you take
back control from
those AI algorithms!

1.0.0. 8¢

© Manual exposure
© Focus peaking

© Portrait mode

on older iPhones

© Smaller image sizes

hanks to Smart HDR and Deep
Fusion, your iPhone can snap

consecutive exposures and create
a single composite image that has colour
and detail in both the shadows and
highlights. This artificial intelligence-assisted
photography means you can shoot and share
a shot without much (if any) editing.

Halide Mark Il (version 2.15) is a camera app
that's designed to give iPhone photographers
more manual control over camera settings,
such as ISO speed (sensitivity to light) and
shutter speed (to add motion blur or freeze
action). This latest version boasts Process
Zero - aresponse to the encroachment
of Al into the art of photography.

Take back control

Photography used to be more challenging, and
therefore more creatively rewarding. When
faced with a hig-contrast scene, a traditional
‘analogue’ photographer had to manually set
the aperture, ISO, and shutter speed to capture
detail in either the bright highlights or dark
shadows. Halide's new Process Zero setting
bypasses Apple's Al-assisted algorithms so that
you can decide which areas to set the exposure
for - just like a traditional DSLR photographer
would. Process Zero creates a Raw DNG (digital
negative) file that you'll need to edit in a
third-party app (such as Apple Photos or
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Adobe Photoshop) to reveal the colour and
tone. In our example image, we set the camera
to capture the shadow detail and edited the
Process Zero DNG file in Photoshop to claw
back detail in the bright highlights. This
enables you to shoot and edit like a traditional
photographer - it even adds picture noise that
Apple's algorithms do their best to smooth out.

Halide Mark Il enables you to quickly switch
between using Process Zero to an Apple-
processed HEIC file or an Apple ProRAW file -
S0 you can enjoy the benefits of Al-assisted
photography whenever you need it. Process
Zero limits you to a 12MP Raw photo, whereas
Apple ProRAW can capture a much larger
48MP file, so your options to produce larger
prints are limited.

As well as Process Zero, Halide Mark Il is
packed full of features that enable you to take
more control when capturing a photo than you
can in Apple's native Camera app. Green focus
peaking lines appear over areas that are in
sharp focus and you can change the focus
point by swiping a slider. You can also see
which areas are going to be over- or under-
exposed thanks to ‘zebra’ warnings. A handy
histogram can be summoned to show the
spread of shadows, midtones and highlights so
that you can adjust accordingly. If you miss the
manual controls of a DSLR, Halide Mark Il is
well worth a free trial run. George Cairns

»Image credit: Lux Optics Inc



Software APPLE CHOICE

Hidden Kingdoms

Panic relief for the nervous traveller

> Free > FROM hiddenkingdoms.org
> NEEDS i0S 14.7 or later, visionOS 1.0 or later

The app’s
overall
effectiveness
depends on the
user; it works
for some better
than others

Mac

FORMAT

VERDICT

> Well presented,
accessible and a
decent attempt at
solving a debilitating
problem.

Kk Kk

© Completely free

© Very well presented
© Easy to use

@ Might not be right
for everyone

¥Image credit: Birmingham Open Media

ravel anxiety can ruin a good trip.
Many of us gets stressed when we
have to travel far, or in extreme
cases, even make a short journey. For those
people - especially vulnerable young adults
or people with hidden disabilities - Hidden
Kingdoms could be the answer.
Developed by the artist collective at BOM

(Birmingham Open Media), Hidden Kingdoms is

a new experience to help people with anxiety
on their travels. Built on game engine
technology, the app makes the journey
with you, supporting you as you go.

As you start your journey, you can plan
ahead and identify potential stress points.
You input your starting location and your

destination, and how you're going to travel (car,

train, walking, and so on). When you're done,
you can review your journey plan and input
your initial mood (happy, average or sad).
Then it's time to begin.

Creature comforts

Custom visual content and spatialised audio
(music and nature sounds) are offered across
the entire journey. The sounds are especially
welcome, including Space, Forest and Desert
soundscapes. If you feel extra nervous, try a
meditation such as Patterns, Natural Breath,
Affirmations and more, offered in a male or
female voice. The app checks in on you during
your journey to check you're OK. At the end,
creatures are unlocked, giving the traveller
something to focus on beyond the actual trip.

Breath 6-7 mins

Practicing a gently controlled breath

Listen Sitting down or standing still

Gratitude 5-6 mins

Taking time to think about and reflect
upon things that we are grateful for

@ Listen Anywhere

. Hidden Gems 3-4 mins |

Mindfulness activities are available to help distract you
from any anxiety you may be feeling about your trip.

17:10 ¥ il '-?-

Journey

The collectables you accrue are endearingly well realised.

The app is excellently presented and very
easy to use. The pictures of the creatures you
capture are great, and the soundscapes used
in the meditations are relaxing and easy on the
ears. The voiceovers are of a high quality too.
There's a slight trace of a Brummie accent
occasionally, but it's certainly not strong
enough to distract from the content.

But does the app work? It certainly made
us more chilled on long journeys. We didn't get
a chance to try it out on a plane, but we think it
could be especially useful for the nervous flyer.
The app’s overall effectiveness depends on the
user; it works for some better than others.
Some people might find it a useful crutch to
lean on during stressful journeys, while others
might find it gimmicky and irrelevant. It's free,
though, with no in-app purchases, so you've
nothing to lose by giving it a go. lan Osborne
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6 apps for...

Learning a new language

Say bonjour to a handy new skill

menu  cold see

windy

Duolingo -
Language Lessons

> Free (IAPs) > FROM duolingo.com
>NEEDS iOS 15 or later

y Duolingo is popular for a
@ @ reason;its short, snappy

" lessons let you dip in and out
of learning in your own time, allowing
you to continue for as long as you
want. There's a great variety of tutorials,
from listening exercises to timed tests,
and the app helps you tune your skills by
focusing on correcting mistakes. It also
has a competitive edge, challenging you
to work your way up a series of leagues
and contests to claim the top prize.
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Spanish [Latin America) n

Rosetta Stone Course

Ed
e with real psople in
ew language Explore >

INTRO LESSON

Get Started)

Work and School

Rosetta Stone:
Learn Languages

> Free (IAPs) > FROM uk/rosettastone.com
> NEEDS iOS 16 or later

you have a well-rounded

understanding of any language
you learn, and that means practising
reading, writing and speaking. It pairs
words and images together to give each
word context, and its quick-fire lessons
recreate real-life situations to give you
the tools you'll actually need to succeed.
And with top-notch speech-recognition
tech at your disposal, you'll be talking like
a native speaker in next to no time.

\ Rosetta Stone aims to ensure
2

no muy bien

not very well

not very well

Memrise: Speak
a new language

> Free (IAPs) > FROM memrise.com
>NEEDS iOS 15 or later

Often, the trouble with
E-ESE learning a new language is
L nailing the accent - without

it, you can stick out like a sore thumb
when conversing abroad. Memrise aims
to fix that by recording locals saying
phrases, adding a dose of practicality
that takes language out of the classroom
and into the real world. You can pick the
conversations you want to learn too,
enabling you to be laser-focused on
mastering the phrases that matter.

»Image credits: Duolingo Inc, Rosetta Stone Ltd, Memrise



eing able to speak another
E language is a great skill to

have, whether you love foreign
holidays or are actively looking to move
abroad. It can help you gain a new
appreciation of other countries and
cultures, settle into a new land, or just

Lesson 1

Learn Languages
with Pimsleur

> Free (IAPs) > FROM pimsleur.com

> NEEDS iOS 14 or later
& to read a lanqguage, Pimsleur

is all about speaking. Exercises

are centred on learning practical

conversations that have everyday

utility, breaking down words into their

component parts so you know exactly

how to say them. One of its best features

is the hands-free learning sessions, which

let you learn to speak your chosen

language while you're driving along

or doing the housework.

Rather than simply learning

-

Learn a language APPLE CHOICE

provide a fun new challenge to undertake.

With so many superb apps to choose
from, now is the perfect time to start
learning on iOS - and these six apps are

our pick of the lot. Start using them today

and you'll be well on your way to talking
a new tongue like a local. Alex Blake

You're learning
{) French

French for Business

French for Travel

French Pronunciation

Complete French

Busuu: Language
[ ]

Learning

> Free (IAPs) » FROM busuu.com

> NEEDS i0S 16.4 or later

What do you do when trying to
D learn a new lanquage but hit a
roadblock? Instead of bashing
your head against a wall, try Busuu. This
app connects you with native speakers
who can offer knowledge and support.
But there's more to Busuu than that -
it offers video flashcards, cultural tips,
study plans and pronunciation help
so you get a really comprehensive
understanding of whatever language
it is that you want to learn.

»Image credits: Simon & Schuster LLC, Busuu Ltd, Drops PlanB Labs OU

Your Progress

Today's Stats

Spotlight Term

4. bonjour

ABOUTTHISTERM

\ |
Drops: Language
Learning Games

> Free (IAPs) > FROM languagedrops.com
> NEEDS i0S 12.4 or later

Drops aims to transform
learning a language from a
tedious chore into something

fun. It does this by turning lessons into
games - join up letters to spell words,
for example, or swipe flash cards in the
correct direction. It does this while
teaching you practical conversational
skills that will help you progress in the
real world, all while learning at your own
pace. If you want to go from beginner

to expert, it's a great place to start.
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STORE GUIDE

Your guide to the best Apple hardware and third-party accessories

IMac /& . e

> In October 2023, Apple updated its

only iMac, the 24in model, so that it now
benefits from Apple's M3 chip. You can now
choose between an 8-core CPU/8-core GPU
at the entry-level, or an 8-core CPU/10-core
GPU on the mid-range and top-tier versions.
You still get a 4.5K (4480x2520) Retina
display, and all models come with 8GB

of memory as standard, but this is now
upgradeable to 24GB throughout. The solid-
state drive (SSD) storage ranges from 256GB
on entry-level and mid-range versions to
512GB on the top tier, although you can add
up to 1TB on the entry-level and up to 2TB

on mid-range and top-tier models.

The entry level version is available in Blue,
Green, Pink and Silver, but the mid- and top-
tier models are also available in Yellow,
Orange and Purple. Each M3 iMac also comes
with a 1080p FaceTime camera, and a six-
speaker sound system with support for spatial
audio. You'll also find two Thunderbolt/USB 4
ports on each model, with mid-range and top-
tier options offering two additional USB 3
(USB-C) ports. Rather surprisingly - and
pleasingly - the starting price remains
unchanged at £1,399.

iMac 24in £1,399 iMac 24in £1,599 iMac 24in £1,799

(Entry level) (Mid-range) (Ultimate)

Display: 23.5in 4.5K Retina (4480x2520) with True Tone Display: 23.5in 4.5K Retina (4480x2520) with True Tone Display: 23.5in 4.5K Retina (4480x2520) with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores, Chip: Apple M3 with 8-core CPU (4 performance cores, Chip: Apple M3 with 8-core CPU (4 performance cores,

4 efficiency cores), 8-core GPU, 16-core Neural Engine 4 efficiency cores), 10-core GPU, 16-core Neural Engine 4 efficiency cores), 10-core GPU, 16-core Neural Engine

Memory: 8GB (upgradeable to 24GB) Memory: 8GB (upgradeable to 24GB) Memory: 8GB (upgradeable to 16GB)

Storage: 25668 (upgradeable to 512GB or 1TB) Storage: 25668 (upgradeable to 512GB, 1TB or 2TB) Storage: 512GB (upgradeable to 1TB or 2TB)

Ports: 2x Thunderbolt/USB 4, 1x Gb Ethernet (option) Ports: 2x Thunderbolt/USB 4, 2x USB 3, 1x Gb Ethernet Ports: 2x Thunderbolt/USB 4, 2x USB 3, 1x Gb Ethernet

..-. === ==== Apple Magic Apple Magic
nrnepnnnmnn gmmm Mouse Trackpad
ErUCoEDENREREES 1] > From £79 > From £129
- ... —— > Design quirks aside > This Multi Touch glass
Apple Magic Keyboard with (we're looking at you, trackpad is a thing of
Touch ID and Numeric Keypad Lightning Port), the Magic beauty, giving you lots
> From £179 Mouse is a great pointing of control over macOS,
> This extended keyboard is a great upgrade device, thanks to its Multi and it's rechargeable
option for any Mac and comes with Touch ID for Touch support. The black too. The black version
faster Mac logins. The black version costs £199. | version costs £99. costs £149,
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EXPECTED — —
MAR 2025

> Apple's most affordable laptop was
given an upgrade in March 2024, with
both the 13-inch and 15-inch models
now sporting Apple silicon M3 chips,
although an M2-equipped version of
the 13-inch remains available.

The laptop boasts a silent, fanless
design, a six-speaker sound system
(the 13in has four speakers) and spatial
audio. The 13in M3 features an 8-core
CPU, offering 1.6x faster performance
than the M1, along with either an 8- or
a10-core GPU, giving it a 5.8% boost
in graphics performance. The M3 also
benefits from 100GB/sec memory
bandwidth. Both M3 MacBook Air models
come with 8GB of memory as standard,
configurable to 16 or 24GB, and both can
be configured with up to 2TB of storage.

MacBook Air 13in £1,099
(Entry level)

Display: 13.6in Liquid Retina with True Tone

Chip: Apple M3 with 8-core CPU (4 performance cores,
4 efficiency cores), 8-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)

Storage: 256GB (upgradeable to 512GB, 1TB or 2TB)
Ports: 2x Thunderbolt/USB 4, 3.5mm headphone jack

&1V 4K

> From £149

> Apple’s third-gen
little black box with
A15 Bionic chip now
adds HDR10+ to the
mix. Prices now start at just
£149 (Wi-Fi only); the standard version now
comes with 64GB of storage, while paying £20
extra gets you 128GB, Ethernet and Thread.

»Image credit: Apple Inc

Apple kit STORE GUIDE

EXPECTED
OCT 2024

> From
£1,099

The 15in MacBook Air is the thinnest
15in laptop available - 40% thinner than
comparable PC laptops; it's just 11.5mm
thin and weighs 1.51kg. The 13in Air is
11.3mm thin and weighs 1.24kg. The
Liquid Retina display in the 15in MacBook
Air has a resolution of 2880x1864 pixels,
while the 13in has 2560x1664. Both
support up to one billion colours.

Both M3 MacBook Air models come
with 1080p FaceTime HD cameras,
MagSafe 3, two Thunderbolt/USB 4
ports and a headphone jack and
Bluetooth 5.3, and they now support
Wi-Fi 6E. You also get up to 18 hours
of battery life when viewing video or
15 when web surfing.

Prices for the 13in model start at
£1,099, while the 15in starts at £1,299.

MacBook Air 15in £1,699
(Ultimate)

Display: 15.3in Liquid Retina with True Tone

Chip: Apple M3 with 8-core CPU (4 performance cores,
4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 16GB (upgradeable to 24GB)

Storage: 512GB (upgradeable to 1TB or 2TB)

Ports: 2x Thunderbolt/USB 4, 3.5mm headphone jack

Apple HomePod/
HomePod mini

> £99/£299

> Apple’s Siri-powered
speakers sound great,

you can link two for

stereo sound, and use them
as smart home hubs. The mini comes in five
colours; the 2nd-gen Midnight/White HomePod
(£299), offers higher spec and spatial audio.

@ Watch
Series 10,
Ultra 2, SE
> From £219

> The Series 10 and
SE are water resistant to
50m, but the Ultra 2 is water resistant to 100m. The
Ultra 2 runs on an S9 SiP. while the new Series 10
has an S10; both have an Always-On Retina display.
All three offer Emergency SOS and Crash Detection.

> From
£649

> Apple's most affordable desktop
may not come with a mouse, a
trackpad or keyboard, but it's also
great value starting at even less
than the last model at £649.
Despite the reduction in price, the
Mac mini now boasts Apple’'s M2 chip,
plus an 8-core CPU, 10-core GPU and
16-core Neural Engine. The 8GB
of memory can now be boosted up
to 24GB, while SSD storage options
range from 256GB all the way up to
2TB. There is now also an M2 Pro
version with a 10-core CPU/16-core
GPU (configurable to 12-core CPU/
19-core GPU), with 16 to 32GB memory
and 512GB to 8TB SSD storage.
Entry-level and mid-range M2 Mac
mini models continue to come with
two Thunderbolt/USB 4 ports, but
the M2 Pro model has now has four.

Mac mini £649
(Entry level)

Chip: Apple M2, 8-core CPU (4 performance cores,

4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)

Storage: 256GB (upgradeable to 512GB, 1TB or 2TB)

Ports: 2x Thunderbolt/USB 4, 2x USB-A, 1x HDMI 2.0,

3.5mm headphone jack, Gb Ethernet (10Gb Ethernet option)

Mac mini £1,399
(Ultimate)

Chip: Apple M2 Pro with 10-core CPU (4 performance cores,
4 efficiency cores), 16-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 16GB)

Storage: 5126B (upgradeable to 1TB or 2TB)

Ports: 4x Thunderbolt/USB 4, 2x USB-A, 1x HDMI 2.0,

3.5mm headphone jack, Gb Ethernet (10Gb Ethernet option)
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MacBook Pro

> From £1,699

> October 2023 saw the introduction
of the M3 chip family to the MacBook
Pro. The new 14-inch M3 model is
available with an 8-core CPU/10-core
GPU. But if you step up to the M3 Pro
option, you can opt for either an 11-core
CPU/14-core GPU or a12-core CPU/
18-core GPU, or the M3 Max which

has a 14-core CPU/30-core GPU.

The 16in options start with the M3 Pro
chip with a 12-core CPU/18-core GPU and
either 18GB or 36GB of unified memory.
Or you can opt for the M3 Max chip with

(Entry level)

Display: 14.2in Liquid Retina XDR (3024x1964) with True Tone
Chip: Apple M3 with 8-core CPU (4 performance cores,

4 efficiency cores), 10-core GPU, 16-core Neural Engine
Memory: 8GB (upgradeable to 24GB)

Storage: 5126B (upgradeable to 1TB, 2TB)

Ports: 2x Thunderbolt/USB 4, HDMI port, SDXC card slot

Mac Studio =

> The Mac Studio finally received a
long-hoped-for update in June 2023
with the latest model sporting Apple
silicon M2 Max and M2 Ultra chips.
The Mac Studio is up to six times faster
than the most powerful Intel-based
27-inch iMac and up to three times faster
than the M1 Ultra Studio that preceded it.
The Studio’s aluminium body is very
compact for a desktop Mac, measuring
197x197x95mm, but it's what's inside that
counts. The M2 Max chip has a 12-core
CPU, a 30-core GPU (upgradeable to
38-core), and 32GB of memory
(configurable to 96GB). The M2 Ultra
comes with a 24-core CPU, 60-core GPU
(upgradeable to 76-core), and 64GB of

| MacBook Pro 14in £1,699

Mac Studio £2,099
(Entry level)

Chip: M2 Max with 12-core CPU (8 performance cores,
4 efficiency cores), 30-core GPU, 16-core Neural Engine
Memory: 32GB (upgradeable to 96GB)

Storage: 5126B (upgradeable to 1TB, 2TB, 4TB, 8TB)
Ports: 4x Thunderbolt 4, 2x USB-C, 2x USB-A, HDMI 2.0,
3.5mm headphone jack, 10Gb Ethernet, SDXC card slot
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EXPECTED
OCT 2024

either a 14-core CPU/30-core GPU or
16-core CPU/40-core GPU. The unified
memory can be upgraded to a max of
128GB on the M3 Max models, while SSD

MacBook Pro 16in £2,599
(Mid-range)

Display: 16.2in Liquid Retina XDR (3456x2234) with True Tone
Chip: Apple M3 Pro with 12-core CPU (6 performance cores,

6 efficiency cores), 18-core GPU, 16-core Neural Engine
Memory:18GB (upgradeable to 36GB)

Storage: 5126B (upgradeable to 1TB, 2TB, 4TB)

Ports: 3x Thunderbolt/USB 4, HDMI port, SDXC card slot

EXPECTED
JUNE 2025

The Mac Studio is Apple’s most powerful

desktop Mac to date - it's pricy though.

unified memory (upgradeable to 192GB).

Storage options on both scale up to 8TB.
The Mac Studio M2 Max starts at

£2,099, and the M2 Ultra starts at

£4,199, so these machines are not for

everyone. But both offer an incredible

array of connectivity options and

| support for the more pro user.

Mac Studio £4,199
(Ultimate)

Chip: M2 Ultra with 24-core CPU (16 performance cores,
8 efficiency cores), 60-core GPU, 32-core Neural Engine
Memory: 64GB (upgradeable to 192GB)

Storage: 1TB (upgradeable to 2T8B, 4TB, 8TB)

Ports: 4x Thunderbolt 4, 2x USB-C, 2x USB-A, HDMI 2.0,
3.5mm headphone jack, 10Gb Ethernet, SDXC card slot

storage can be upgraded to a max of
8TB on M3 Max models. The 14in M3
and 16in M3 Pro and M3 Max models
now offer up to 22 hours of battery life.

MacBook Pro 16in £4,099

(Ultimate)

Display: 16.2in Liquid Retina XDR (3456x2234) and True Tone
Chip: Apple M3 Max with 16-core CPU (12 performance cores,
4 efficiency cores), 40-core GPU, 16-core Neural Engine
Memory: 48GB (upgradeable to 128GB)

Storage: 1TB (upgradeable to 2TB, 4TB or 8TB)

Ports: 3x Thunderbolt/USB 4, HDMI port, SDXC card slot

Studio Di5|_jlay

>From £1,499

> Launched alongside the original
Mac Studio in March 2022, the
Studio Display is a great addition
to any Mac setup.

Powered by Apple's A13 Bionic
and running iOS, it features a
27-inch Retina display with 5K
resolution (5120x2880 pixels)
and True Tone, a 12MP Ultra Wide
camera with Centre Stage, and
a six-speaker sound system with
support for spatial audio. A range
of stand options are available, and
you can choose nano-texture glass
for £250 more.



EXPECTED
OCT 2024

iPad/mini

> iPad (10th gen) From £349
»iPad mini From £499

> Apple's entry-level iPad got a
welcome price drop in May 2024,
with prices now starting at £349.
Its specs remain the same, though,
with the iPad (10th gen) sporting a
10.9in display, powered by an Al4
Bionic chip. Plus you get an Ultra Wide
12MP front and 12MP back camera.
The iPad also comes with a USB-C
port and is available in four colours.
The iPad mini is a neat little tablet,
with an 8.3in Liguid Retina display.
The cheapest £499 model has 64GB
of storage (a 256GB model is also
available for £649) and comes with
a 12MP Wide camera, Apple Pencil
support and USB-C charging.

iPad iPad mini
Display: 10.9in Display: 8.3in

Chip: A14 Bionic Chip: A15 Bionic
Storage: 64GB, 256GB Storage: 64GB, 256GB
Ports: USB-C Ports: USB-C

Unlocking: Touch ID Unlocking: Touch ID

Apple Smart Folio
> From £59

> Available in a range of stylish colours, these

wrap-around magnetic cases will keep your iPad,
iPad mini, iPad Air and iPad Pro looking good for
years, and they double as handy stands.

EXPECTED

MAY 2025

> From
£599

iPad Air
> In May 2024, Apple announced
a redesigned 11-inch and all-new
13-inch iPad Air. Inside, you'll now
find an Apple silicon M2 chip. Storage
options now range from 128GB or 1TB,
and there's Wi-Fi 6E and Bluetooth 5.3.
The two new models support the
newly released Apple Pencil Pro, and
can be teamed with Apple's Magic
Keyboard for powerhouse productivity
on the go. As before, augmented
reality fans will love the LiDAR-
equipped 12MP Wide camera and
Centre Stage. The Liquid Retina
display resolution remains at
2360x1640 on the 1in, but the 13in
boasts a resolution of 2732x2048.
Prices start at a respectable £599
for the 11in and £799 for the 13in.

iPad Air

Display: 1in or 13in

Chip: Apple M2

Storage: 128GB, 256, 512GB, 1TB
Ports: USB-C

Unlocking: Touch ID

Apple Pencil/Apple Pencil Pro
> From £79

> There are now four variations of
Pencil. The Ist- and 2nd-gen models are
still available; Apple released a USB-C
version in November 2023, and in May
2024, Apple unveiled the Apple Penclil
Pro (£129), which contains a barrel
sensor that can feel a user's squeeze
and a gyroscope for incredible control.

» Image credit: Apple Inc
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EXPECTED
MAY 2025

> From
£999

iPad Pro
> Alongside the new iPad Air in
May, Apple showed off its newly
designed ‘thinpossible’ iPad Pro
11in and 13in. The iPad Pro models
have now jumped to M4 Apple silicon
to provide incredible performance
and powerful Al capabilities.

Despite the Ultra Retina XDR
display boasting new Tandem OLED
tech, the new iPad Pro is tber thin,
with the 13-inch model measuring
just 5.Imm thick! (There's also a
nano-texture glass option on the 1TB
and 2TB models.) The front camera
is now a Landscape 12MP Ultra Wide
on the iPad's longest side. Plus, the
Pro supports the new Apple Pencil
Pro, and revamped Magic Keyboard.

iPad Pro

Display: 1in or 13in
Chip: Apple M4
Storage: 2566B-2TB
Ports: Thunderbolt 4
Unlocking: Face ID

Apple Magic
Keyboard
> From £299

> Team your Pad with |

one of these and you'll
feel like you're using a
touchscreen Mac. The
new iPad Pro version
even has a trackpad
with haptic feedback.
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EXPECTED
MAR 2025

iPhone SE

>From £429

> The most affordable iPhone
became even better value when
Apple reduced the price by £20. As
with the iPhone 14 range, the SE
works on an A15 Bionic chip. The
iPhone SE offers plenty of the things
people love about iPhone, including
i0S's phenomenal ease of use.
There's only a single 12MP Wide main
camera and no Night mode, but you
do get True Tone, a Photonic engine,
and 4K recording.

Battery life is decent too with the
iPhone SE lasting for up to 15 hours
between recharges (with Qi wireless
charging onboard too). The main
thing the iPhone SE misses out on
is Face ID unlocking, making do with
Touch ID on the Home button instead.

iPhone SE

Display: 4.7in

Chip: A15 Bionic
Storage: 646B-256GB
Connectivity: 56, Wi-Fi
Unlocking: Touch ID

Apple Vision Pro
> £3,499

» Marking the start of what
Apple hopes is a new era of
spatial computing, the Vision
Pro is now available in the UK.
Equipped with a custom 23 million
pixel microOLED display, the twin
lenses inside the Vision Pro boasts
better than 4K resolution and it
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has spatial audio onboard too.
Driving the whole thing are Apple
silicon M2 and R1 chips, upon which
sit its own dedicated visionOS.

EXPECTED
SEPT 2025

iPhone 16/
Plus

> iPhone 16 From £799
> iPhone 16 Plus From £899

> In September 2024, Apple
launched the iPhone 16 and 16 Plus.
Both handsets are still aluminium,
and screen sizes have remained the
same at 6.1in and 6.7in respectively.
Inside, however, a new A18 chip helps
to power Apple Intelligence.

The 48MP Main and 12MP Ultra
Wide dual-camera system now allows
for spatial photos and videos, and
macro, and benefits from a new
physical Camera Control feature. The
iPhone 16 now lasts for up to 22 hours
when playing video playback; the Plus
up to 27. Pricing remains the same as
the iPhone 15 models.

iPhone 16 iPhone 16 Plus
Display: 6.1in Display: 6.7in
Chip: A18 Chip: A18

Storage: 1286B-5126B
Connectivity: 56, Wi-Fi
Unlocking: Face ID

Storage: 128GB-512GB
Connectivity: 56, Wi-Fi
Unlocking: Face ID

.P_hone6

,  Apple AirPods Max/
| AirPods Pro 2/AirPods
| > £499/£229/From £129

> The AirPods Max boast Transparency
made, Active Noise Cancellation and

now offer USB-C charging. The AirPods
Pro 2 boast Adaptive Audio. The AirPods 4
are more comfortable, boast dynamic head N >

tracking, and come with an ANC option. Al RS
offer Personalised Spatial Audio.

EXPECTED
SEPT 2025

Pro/Pro Max

»iPhone 16 Pro From £999
»iPhone 16 Pro Max From £1,199

> Alongside the base handsets,
Apple released the iPhone 16 Pro
and Pro Max with titanium shells
with textured matt glass backs.
The Super Retina XDR displays are
larger again at 6.3- and 6.9-inch,
and feature thinner borders.

An A18 Pro chip focuses on Apple
Intelligence capabilities. You now get
a 48MP Fusion camera alongside
the 48MP Ultra Wide and 12MP
Telephoto, plus the new physical
Camera Control feature. Video
playback is now 27 hours on the
Pro; 33 hours on the Pro Max.

iPhone 16 Pro | iPhone 16 Pro Max
Display: 6.3in Display: 6.9in
Chip: A18 Pro Chip: A18 Pro

Storage: 128GB-1TB Storage: 256GB-1TB
Connectivity: 56, Wi-Fi

Unlocking: Face ID

Connectivity: 56, Wi-Fi
| Unlocking: Face ID

»Image credit: Apple Inc



BEST BUYS...

» EXTERNAL DISPLAY

Philips 27B1U7903

£999, philips.co.uk

> An excellent monitor that
satisfies on every level. It's

expensive, but you do get a

lot of quality for your money.

Yok xxk MF392

»OURTOP3
MESH NETWORK DEVICES

ASUS ZenWiFi XD5
| >£209.99 > MF398
>asus.com/uk
. TP-Link Deco X55
>£219.99 > MF398
> tp-link.com/uk/
Devolo Magic 2
WiFi 6 Starter Kit
| >£219.99>MF398
> devolo.co.uk

»BLUETOOTH SPEAKER

Marshall Middleton

£270,
marshallheadphones.com

> Meaty, beaty, big and
bouncy, the Middleton
knows how to rock.
**kxk MF391

»OURTOP3
PORTABLE SSDS

Crucial X8
>£212>MF388

> uk.crucial.com
SanDisk Extreme
>£100 > MF388

> westerndigital.com
OWC Envoy Pro SX
>£285>MF388
>owc.com

Third-party kit STORE GUIDE

> NAS DRIVE

Asustor Lockerstor 2
Gen2 AS6702T

£469, asustor.com

» Excellent and versatile
mid-range network
storage.

Yk kkx MF390

»OURTOP3
SUPERFAST CHARGERS
Satechi 200W
V USB-C 6-Port PD GaN
~  £160>MF392
L =4 >satechi.net

Anker 737 Charger
GaNPrime 120W
. £70>MF392
L. . >anker.com/uk
Ugreen Nexode

= "= 200W USB-C Desktop
£130 > MF394

- > uk.ugreen.com

BEST BUYS... Third-party Mac apps >

> E’HOTO EDITOR
Pixelmator Pro

£49.99 pixelmator.com

> Easily improve your
photos with this brilliant
and affordable Mac app. Al
smarts add to its prowess.
Yk xk*x MF406

>OURTOP 3
VIDEO EDITORS

Wondershare Filmora
> £17.49/month > MF387
>wondershare.com

: HitFilm (Creator)
V >£7.99/month > MF387
>fxhome.com

Lightworks Create

>£9.99/month > MF387
>lwks.com

»Image credits: Koninklijke Philips NV, Mars

Bloop, Luma Touch LLC, Ginger Labs, The Grizzly LaLs Serif

»PRODUCTIVITY TIMER

Vitamin-R 4.18

$49.95 (about £38)
publicspace.net

> Break your working day
up into short bursts of
distraction-free activity.
*xk*k MF384

>OURTOP3
NOTE TAKING APPS

Agenda
A >Free (IAPs)> MF389
5 >agenda.com
Bear
q >Free (IAPs) > MF389
>bear.app

Simplenote

o >Free > MF389

>simplenote.com

> WRITING APPS

Scrivener

£55
literatureandlatte.com

> A genuinely outstanding
app that has almost
everything you could ever
need. xx*x*x MF385

»OURTOP3
EMAIL

Spark

>Free (IAPs > MF375
>sparkmailapp.com
Edison Mail

6 >Free (IAPs) >MF375
>mail.edison.tech

- Airmail Pro
@ >£5.99/month > MF375
>airmailapp.com

hall Arr ph ication PLC, Asustor Inc, Skylum, pubhu)mcrd Literature & Latte
Ltd, Wondershare, Artlist UK Ltd, LWKS.com, Momenta BV, ShinyFrog, Automattic Inc, Spark Mail Ltd, Edison Software,

(Europe) Ltd, Capture One, Silvio Rizzi, inkle Ltd

BEST BUYS...
Third-party iPhone,
iIPad & Watch apps >

» VIDEO EDITOR (i0S/iPADOS)
. LumaFusion 3
£29.99 luma-touch.com
> A powerful and reasonably priced
video-editing suite. Existing users

can upgrade for free.
*xkkk MF372

> NOTE-TAKING (i0S/iPADOS)
@ Notability
£8.99 notability.com
> Notability is a superb note-taking
app with lots of flexibility. It's ideal
for a variety of projects.
* ¥k *k MF360

O

-’

» SCA'NNING/OCR (i0S/iPADOS)
GeniusScan+

£9.99 thegrizzlylabs.com

> Fast, flexible and useful scanning
with good optical character
recognition (OCR).

*Hxkxk MF368

> PAGE LAYOUT (iPADOS)
\\ Affinity Publisher 2
£17.99 affinity.serif.com

Serif's page layout app finally arrives on
iPad and it's great - even if the interface
takes some getting used to.

Jokkkk MF391

» PHOTO EDITOR (iPADOS)

Capture One

£4.49/month captureone.com

> A comprehensive photo editor offering
powerful Raw conversion and desktop-
quality editing tools on the iPad.

Kk xk MF384

> RSS READER (i0S)
* Reeder 5
£4.99 reederapp.com
> Version 5 brings minor, but welcome
improvements to an already great

RSS news-reader app.
*¥kdkk MF361

» GAME (i0S/iPADOS)
=8 Overboard!
. £5.99 inklestudios.com

> A gem. A small, but perfectly formed
and entertaining game about a ship-
based murder mystery.

*dkxk MF372
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1More is THE destination on the web
for everything iPhone, iPad, iPod,
Mac, MacBook and Apple Watch.

1More

imore.com

Apple M3 chip: Release date,
cores, Dynamic Caching, speeds,
and more

By O faslam last updated October 31, 2023

Forget M2, it's time for Apple's M3 chip
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GOODBYE Until next issue...

One more thing

Graham Barlow has stopped wearing his Apple Watch, but
will sleep apnoea detection make him change his mind?

et me tell you a little secret. An
admission if you will. I've actually

stopped wearing my Apple Watch,
and I don’t miss it. It’s a secret because for a
tech journalist, admitting that you've stopped
using a bit of tech, in fact a whole category of
wearable tech, feels like I'm breaking some sort
of secret covenant. I've been wearing an Apple
Watch for two years now, so it’s not like I just
decided to stop wearing it on a whim.

Despite its charms, my Apple Watch
was turning into just one more thing I had to
remember to charge and take with me, and -
along with my smartphone, my AirPods,
MacBook and iPad - it was just one thing too
many. It’s not like I've decided to start wearing
another smartwatch, I've just abandoned the
whole category of wrist-based wearable tech,
leaving my wrist free and unencumbered by a
strap of any kind. It’s refreshing. Kind of like
how our ancestors must have felt. Possibly.

I get that for many people their Apple Watch
is indispensable for listening to music while
running, tracking their steps and heart rate, or
looking at Apple Maps, but I've decided to stop
obsessing about how many steps I take a day
and I’ve not missed it. My phone does the rest.

Of course, as soon as I stopped wearing my
Apple Watch, Apple immediately released a
brand new feature that made me question my
decision. The new watchOS 11 is now FDA-
approved for sleep apnoea detection, on the

Series 9,10 and Ultra 2. Sleep apnoea is the slowing
down or even stopping of your breathing during sleep
and can be caused by either your brain not regulating
your breathing properly or some sort of obstruction.
Sleep apnoea goes largely undiagnosed because it
requires special sleep tests to detect it. Your Apple
Watch picking the problem up as part of its regular
monitoring of sleep patterns seems like a great idea.
And of course, I'd need to upgrade to a new Apple
Watch to use the feature, because mine is too old to
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Possible Sleep Apnea

Over multiple sleep sessions, Apple Watch
has recorded elevated breathing
disturbances that would be classified as
moderate or severe sleep apnea.

August 9 — September 8, 2024

3 Discuss With Your Doctor

Export PDF
Possible Sleep

© About Sleep Apnea Apnea

To detect signs of apnoea, Apple Watch monitors movement
associated with interruptions in respiratory patterns.

run it, so it looks like I'll be staying Watch-free for the
foreseeable future. Incidentally, my teenage son
noticed I wasn’t wearing my Apple Watch

as soon as I abandoned it and instantly
pounced, immediately declaring it as

his. He busied himself syncing it to his

iPhone and setting up the Health app.

And now? Well, one week later, he’s

stopped wearing it too...

12 NOV

Image credit: Apple Inc



BRAIN TUMOURS

| MOVE FAST. W
‘WITH YOUR HELP,

WE CAN Too!

We're working to create a future where brain tumours are curable.
We urgently need your help to accelerate research.

Text DEFEATS to 70507 to donate £5, please help us to find a cure.

thebraintumourcharity.org

(21 d with
® The Brain Tumour Charity 2020. Registered Charity in England and Wales FBGIF\‘JEE;RKESI NG
(1150054) and Scotland (SC045081) REGULATOR
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IF 1 HAD
SOMEWHERE
TO LIVE...

When Abi's mum died, life got tough. She didn't get on with her
dad and the arguments became violent. Abi felt her only choice
was to leave home. With just the clothes on her back, and no
idea where to go, she ended up sleeping on the streets in the
freezing cold.

Right now, you could

> 1 homeless young person like Abi
somewhere to start zl ir future

Abi’s life changed when she was given a room at Centrepoint.
A safe place to sleep and recover. A place to develop the skills
and confidence she needed to rebuild her life - and leave
homelessness behind for good. Now, Abi believes she can

go anywhere.

HELP A HOMELESS YOUN

YES, | WANT TO SPONSOR A ROOM
FOR £12 A MONTH

Please collect my payment on the 1st/15th of every month

To the Manager:
Name and full addre
Bank or Building Society:

g

Name(s) of Account Holder(s)

Instructions t
fl.,'nthn

Signature(s) Date

Banks and Building Societies may not accept

Incredse your donation by 25p for every E1 you donate with Gift Aid ] Fraid i

By ticking this box | confirm | am a UK taxpayer and want Centmgomt to Gift Aid
all donations I've made in the last four years and any donations | make in the
future until | notify you otherwise. | understand that if | pay less income Tax and/
or Capital Gains Tax in any tax year than the amount of Gift Aid claimed on all my
donations it is my responsibility to pay any difference.

Your name and address are needed to identify you as a current UK taxpayer.

Your donation will go towards fund)
T We

rk with to protect their identity:

accommaodation and supp T

Thousands of homeless young people like Abi are desperately
trying to find their place in the world - but first they need a
place to start again. You could help right now by sponsoring
aroom at Centrepoint for just 40p a day.

We know this support changes lives. 88% of the young
people we help move on positively in life. So please, help
someone like Abi today. Thank

Text PLACE to 78866 to donate £3

Call free on 0800 472 5798

Visit centrepoint.org.uk/place

Or complete and return the form below

Full Name: _
Address:

Postcode: Telephone:
Email:

We'd love to show the impact of your support and share how young people
continue to need your help, through newsletters, fundraising appeals and
information about events, Please let us know how best to stay in touch with

Last year our supporters helped us change the lives of over 15,000 homeless

young people. By letting us know we can count on you, we can continue helping

young people with a home and a future

Your privacy is key

We promise never to sell or swap your details, and will always keep them secure.

You can view our Privacy Notice in full at www.centrepoint.org.uk/privacy.

You can opt out of post and change how we communicate with you at any

time. Please call 0800 232320 and speak to one of our friendly team or email
pporter nt : to do this and ask us any questions

Please return this form to: Freepost Plus RTXY-LBEA-UT

Camperdown Street, London E1 8DZ
292411, Housing association no. H186%.

B

Company no. 1.—’.‘f a_-‘l R |_r.r|'l~, no

VAT registration no. 64°

@ REGULATOR

345 018






